Cycle Model Studio
Version 10.0
User Manual
Non-Confidential
Cycle Model Studio
User Manual

Copyright © 2018 Arm Limited (or its affiliates). All rights reserved.

Release Information

The following changes have been made to this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Issue</th>
<th>Confidentiality</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>August 2017</td>
<td>0903-00</td>
<td>Non-Confidential</td>
<td>Update for 9.3</td>
</tr>
<tr>
<td>February 2018</td>
<td>0905-00</td>
<td>Non-Confidential</td>
<td>Update for 9.5</td>
</tr>
<tr>
<td>September 2018</td>
<td>1000-00</td>
<td>Non-Confidential</td>
<td>Release 10.0</td>
</tr>
</tbody>
</table>

Non-Confidential Proprietary Notice

This document is protected by copyright and other related rights and the practice or implementation of the information contained in this document may be protected by one or more patents or pending patent applications. No part of this document may be reproduced in any form by any means without the express prior written permission of Arm. No license, express or implied, by estoppel or otherwise to any intellectual property rights is granted by this document unless specifically stated.

Your access to the information in this document is conditional upon your acceptance that you will not use or permit others to use the information for the purposes of determining whether implementations infringe any patents.

THIS DOCUMENT IS PROVIDED “AS IS”. ARM PROVIDES NO REPRESENTATIONS AND NO WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, SATISFACTORY QUALITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT TO THE DOCUMENT. For the avoidance of doubt, Arm makes no representation with respect to, and has undertaken no analysis to identify or understand the scope and content of, third party patents, copyrights, trade secrets, or other rights.

This document may include technical inaccuracies or typographical errors.

TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT WILL ARM BE LIABLE FOR ANY DAMAGES, INCLUDING WITHOUT LIMITATION ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF ANY USE OF THIS DOCUMENT, EVEN IF ARM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

This document consists solely of commercial items. You shall be responsible for ensuring that any use, duplication or disclosure of this document complies fully with any relevant export laws and regulations to assure that this document or any portion thereof is not exported, directly or indirectly, in violation of such export laws. Use of the word “partner” in reference to Arm’s customers is not intended to create or refer to any partnership relationship with any other company. Arm may make changes to this document at any time and without notice.

If any of the provisions contained in these terms conflict with any of the provisions of any signed written agreement specifically covering this document with Arm, then the signed written agreement prevails over and supersedes the conflicting provisions of these terms. This document may be translated into other languages for convenience, and you agree that if there is any conflict between the English version of this document and any translation, the terms of the English version of the Agreement shall prevail.

The Arm corporate logo and words marked with ® or ™ are registered trademarks or trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere. All rights reserved. Other brands and names mentioned in this document may be the trademarks of their respective owners. Please follow Arm’s trademark usage guidelines at http://www.arm.com/company/policies/trademarks.

Copyright © Arm Limited. All rights reserved.


110 Fulbourn Road, Cambridge, England CB1 9NJ.

In this document, where the term Arm is used to refer to the company it means “Arm or any of its subsidiaries as appropriate”.

101108_1000_00
ID090518
Confidentiality Status

This document is Non-Confidential. The right to use, copy and disclose this document may be subject to license restrictions in accordance with the terms of the agreement entered into by Arm and the party that Arm delivered this document to.

Product Status

The information in this document is final, that is for a developed product.

Web Address

http://www.arm.com
Contents

Preface
Audience ................................................................. 13
About This Guide ..................................................... 13
Conventions .............................................................. 14
Additional Documentation ........................................... 15
Glossary ................................................................. 16

Chapter 1.
Introduction
Virtual Prototype Methodology ........................................ 17
Overview of Cycle Model Studio Functions ............................ 19
Understanding Cycle Model Studio Configuration Options ........... 20
Starting Cycle Model Studio ........................................... 20

Chapter 2.
Understanding the Cycle Model Studio Interface
Reviewing GUI Features and Functions ............................... 22
Using the File Menu .................................................... 23
Creating a New Project ............................................... 23
Opening Projects and Files ......................................... 25
Opening a Recent Project ............................................ 26
Closing a Project ....................................................... 26
Saving All Files ......................................................... 26
Saving the Current File ............................................... 26
Using the Find Option ................................................ 26
Using the Drive Mappings option (Windows Only) ................. 27
Exiting Cycle Model Studio ........................................ 28
Using the Edit Menu .................................................. 29
Setting Preferences .................................................... 29
Using the View Menu .................................................. 31
Using the Build Menu .................................................. 31
Checking for Errors ..................................................... 31
Exploring the Modules and Nets Hierarchy ......................... 31
Compiling ................................................................. 32
Stopping Compilation .................................................. 32
Recompiling .............................................................. 32
Using Batch Build... .................................................... 32
Cleaning Files ........................................................... 32
Using the Project Menu ................................................ 33
Configuring Compiler Settings ....................................... 34
Setting the Verilog variant ............................................ 35
Using the Run Script Option ......................................... 36
Creating New Compile Properties Sets ............................. 36
Adding RTL Sources .................................................... 37
Importing a Command File ............................................ 38
Importing a Wizard File ............................................... 38
Creating a SoC Designer Component ............................... 39
Creating a Platform Architect Component ......................... 39
Creating a SystemC Component ..................................... 39
Using the Window Menu ................................................. 39
Using the Toolbar ........................................................ 40
Using the View Windows ............................................... 41
Using the Project Explorer View ..................................... 41
Using the Main View .................................................... 43
Using the Properties View ............................................. 44
Project Properties ....................................................... 45
Compiler Properties ..................................................... 46
RTL Folder Properties .................................................. 51
RTL File Properties ...................................................... 52
Directives File Properties .............................................. 52
Using the Console View ................................................ 54
Using the Error List View .............................................. 55
Using the Design Hierarchy View .................................... 58
Chapter 3.
Compiling RTL into a Cycle Model

Reviewing Remote Compile Requirements ........................................... 62
Cycle Model Compiler Inputs ............................................................. 64
  Cycle Model Compiler Options ......................................................... 64
  Cycle Model Compiler Directives ...................................................... 64
Compiling RTL with Cycle Model Studio ............................................ 65
  Creating your Project ...................................................................... 65
  Adding RTL Source Files ................................................................ 68
  Defining Compiler Options and Compiling the Cycle Model .................... 70
  Defining Directives and Recompiling the Cycle Model .......................... 71
  Applying Directives to Modules and Nets ........................................... 72
  Embedding Directives in Verilog Source Files .................................... 77

Chapter 4.
Creating Components for Specific Platforms

Understanding the Process .................................................................. 80
Cycle Model Studio Component Generator Overview ............................. 80
  Transactors ...................................................................................... 82
  Component Clocking .......................................................................... 82
  Clock Generation .............................................................................. 83
Starting and Configuring the Project ..................................................... 84
Editing the Component Properties ....................................................... 85
  Naming the component .................................................................... 85
  Specifying Force Update .................................................................. 86
  Enabling Waveform Generation ......................................................... 86
  Setting Compiler and Linker Flags .................................................... 87
Component Editing View ....................................................................... 88
  Ports Tab .......................................................................................... 89
  Registers Tab .................................................................................... 107
  Memories Tab ................................................................................... 111
  Profile Tab ....................................................................................... 119
  Control Expressions ......................................................................... 122
Recompiling the Model ........................................................................ 122
Generated Output Files for the SoC Designer Component ....................... 123
  Configuration Files .......................................................................... 124
  Makefiles ........................................................................................ 124
  Customizing Component Source Files .............................................. 124
  Adding a Component to the SoC Designer Model Library .................... 126
  SoC Designer Component Files ....................................................... 126
SoC Designer-Specific Information ....................................................... 127
Prerequisites for SoC Designer ........................................................... 129
  Transactors ...................................................................................... 130
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Clocking</td>
<td>131</td>
</tr>
<tr>
<td>Clock Generation</td>
<td>131</td>
</tr>
<tr>
<td>Using the Component in SoC Designer</td>
<td>132</td>
</tr>
<tr>
<td>Setting Component Parameters in SoC Designer</td>
<td>132</td>
</tr>
<tr>
<td>Dump Waveforms parameter</td>
<td>133</td>
</tr>
<tr>
<td>Waveform File parameter</td>
<td>133</td>
</tr>
<tr>
<td>Align Waveforms parameter</td>
<td>133</td>
</tr>
<tr>
<td>Waveform Timescale parameter</td>
<td>133</td>
</tr>
<tr>
<td>ARM Cycle Models DB Path parameter</td>
<td>133</td>
</tr>
<tr>
<td>Special Cases</td>
<td>134</td>
</tr>
<tr>
<td>Components with Clock_Input Pseudo-Transactors</td>
<td>134</td>
</tr>
<tr>
<td>Using $display in Windows Environment with SoC Designer</td>
<td>134</td>
</tr>
<tr>
<td>Using Save and Restore in SoC Designer</td>
<td>134</td>
</tr>
<tr>
<td>Using Profiling in SoC Designer</td>
<td>134</td>
</tr>
<tr>
<td>Flow-through Path Support for Signal Ports</td>
<td>134</td>
</tr>
<tr>
<td>Platform Architect-Specific Instructions</td>
<td>135</td>
</tr>
<tr>
<td>SystemC Modeling Language (SCML) Interface Overview</td>
<td>135</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>136</td>
</tr>
<tr>
<td>COWAREIPLIB Implementation Notes</td>
<td>137</td>
</tr>
<tr>
<td>Recompiling the Model</td>
<td>137</td>
</tr>
<tr>
<td>Understanding the Platform Architect Component Output Files</td>
<td>137</td>
</tr>
<tr>
<td>Configuration Files</td>
<td>138</td>
</tr>
<tr>
<td>Source Files</td>
<td>139</td>
</tr>
<tr>
<td>Makefiles</td>
<td>139</td>
</tr>
<tr>
<td>Known Issue</td>
<td>139</td>
</tr>
<tr>
<td>Creating Components for SystemC</td>
<td>140</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>140</td>
</tr>
<tr>
<td>Generating the Component for SystemC</td>
<td>141</td>
</tr>
<tr>
<td>Using the Component Properties View</td>
<td>142</td>
</tr>
<tr>
<td>Using the Ports Window for SystemC</td>
<td>143</td>
</tr>
<tr>
<td>Recompiling the Model</td>
<td>144</td>
</tr>
</tbody>
</table>

**Appendix A.**

**Arm-supplied Transactors for SoC Designer**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pseudo-Transactors</td>
<td>146</td>
</tr>
<tr>
<td>Null Ports</td>
<td>146</td>
</tr>
<tr>
<td>Interrupt Translators</td>
<td>146</td>
</tr>
<tr>
<td>Clock Inputs and Clock Generators</td>
<td>148</td>
</tr>
<tr>
<td>Clock_input</td>
<td>148</td>
</tr>
<tr>
<td>Clock_generator</td>
<td>152</td>
</tr>
<tr>
<td>Clock-related Parameters</td>
<td>155</td>
</tr>
<tr>
<td>Clock_output</td>
<td>156</td>
</tr>
<tr>
<td>Reset Inputs</td>
<td>157</td>
</tr>
</tbody>
</table>
## Appendix B.
### User-Defined Transactors with SoC Designer

- Writing the Transactor XML File ............................................. 211
- Writing the Transactor C++ Code ........................................ 213
- Adding your Transactor to the Component ......................... 215

## Appendix C.
### Arm-Supplied RTL Models

- Overview ................................................................. 217
- DDRx Memory Model Location ........................................ 219
- Using Arm-supplied RTL Models ................................. 219
  - Instantiating the Module ...................................... 219
  - Adding the Arm-supplied Command File .................. 220
- Configuring DDRx Size and Signal Timing .................. 221
- DDRx Mode Registers ............................................. 223
Preface

Audience

This user manual is intended for development engineers who create components for use with *SoC Designer*, *Synopsys Platform Architect*, or *SystemC*. It assumes familiarity with the following technologies:

- Hardware design verification
- C/C++ programming language
- SystemVerilog or Verilog programming language
- The Cycle Model Compiler

About This Guide

This guide provides all the information needed to compile RTL as Cycle Models, generate platform-specific components, and manage interactions between Cycle Models and platforms. The following chapters are included:

- Chapter 1. Introduction
- Chapter 2. Understanding the Cycle Model Studio Interface
- Chapter 3. Compiling RTL into a Cycle Model
- Chapter 4. Creating Components for Specific Platforms
- Appendix A. Arm-supplied Transactors for SoC Designer
- Appendix B. User-Defined Transactors with SoC Designer
- Appendix C. Arm-Supplied RTL Models
# Conventions

This book uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>courier</td>
<td>Commands, functions, variables, routines, and code examples that are set apart from ordinary text.</td>
<td><code>sparseMem_t SparseMemCreateNew();</code></td>
</tr>
<tr>
<td>italic</td>
<td>New or unusual words or phrases appearing for the first time.</td>
<td><em>Transactors</em> provide the entry and exit points for data…</td>
</tr>
<tr>
<td>bold</td>
<td>Action that the user performs.</td>
<td>Click <strong>Close</strong> to close the dialog.</td>
</tr>
<tr>
<td>&lt;text&gt;</td>
<td>Values that you fill in, or that the system automatically supplies.</td>
<td><code>&lt;platform&gt;/</code> represents the name of various platforms.</td>
</tr>
<tr>
<td>[ text ]</td>
<td>Square brackets [ ] indicate optional text.</td>
<td><code>$CARBON_HOME/bin/modelstudio [ &lt;filename&gt; ]</code></td>
</tr>
<tr>
<td>[ text1</td>
<td>text2 ]</td>
<td>The vertical bar</td>
</tr>
</tbody>
</table>

Also note the following references:

- References to C code implicitly apply to C++ as well.
- C side, S side, and test side refer to code or operations written in C or originating in C. Similarly, simulation side refers to code and operations residing within the simulation side of the verification environment.
- File names ending in .cc, .cpp, or .cxx indicate a C++ source file.
Additional Documentation

Arm provides extensive documentation covering the installation of Cycle Models products and the use of the Cycle Model Compiler and APIs:

- Cycle Model Studio Installation Guide (101106)
- Cycle Model Studio SystemC User Manual (101198)
- Cycle Model Compiler User Manual (101050)
- Cycle Model Compiler Verilog and SystemVerilog Language Support Guide (100972)
- Cycle Model Studio RTL Style Guide (DUI 1088)
- Arm Cycle Model API Reference Manual (101067)
- Arm Cycle Model Database API Reference Manual (101068)
- Arm Cycle Model SystemC Wrapper Methods Reference (101070)
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C-side/S-side</td>
<td>Software side. The environment that controls the transactors via interface modules.</td>
</tr>
<tr>
<td>Cycle Model</td>
<td>A software object created by the Cycle Model Studio (or <em>Cycle Model Compiler</em>) from an RTL design. The Cycle Model contains a cycle- and register-accurate model of the hardware design.</td>
</tr>
<tr>
<td>Cycle Model Studio</td>
<td>Tool for the automatic generation of hardware-accurate software models. It creates a Cycle Model, and it also takes a Cycle Model as input and generates a component that can be used in SoC Designer, Platform Architect, or SystemC for simulation. It is a graphical tool, providing a user-friendly method to manipulate ports, registers and memories; add transactors to the Cycle Model; and set up variables for profiling.</td>
</tr>
<tr>
<td>Component</td>
<td>Building blocks used to create simulated systems. Components are connected together with unidirectional transaction-level or signal-level connections.</td>
</tr>
<tr>
<td>ESL</td>
<td>Electronic System Level. A type of design and verification methodology that models the behavior of an entire system using a high-level language such as C or C++.</td>
</tr>
<tr>
<td>HDL</td>
<td>Hardware Description Language. A language for formal description of electronic circuits, for example, Verilog.</td>
</tr>
<tr>
<td>io.db</td>
<td>The <code>io.db</code> is a subset of the full <code>symtab.db</code>. It includes only the design I/Os, clocks, and any nets that were specified in directives.</td>
</tr>
<tr>
<td>RTL</td>
<td>Register Transfer Level. A high-level hardware description language (HDL) for defining digital circuits.</td>
</tr>
<tr>
<td>SOC or SoC</td>
<td>System-on-a-Chip</td>
</tr>
<tr>
<td>SoC Designer</td>
<td>High-performance, cycle accurate simulation framework which is targeted at SOC hardware and software debug as well as architectural exploration.</td>
</tr>
<tr>
<td>S2T</td>
<td>Signal-to-transaction. The component drives the transaction into the SoC Designer or Platform Architect environment.</td>
</tr>
<tr>
<td>symtab.db</td>
<td>A <code>symtab.db</code> file is a database of the entire design.</td>
</tr>
<tr>
<td>T2S</td>
<td>Transaction-to-signal. SoC Designer or Platform Architect drives the transactions into the component.</td>
</tr>
<tr>
<td>Transactor</td>
<td>Transaction adaptors. You add transactors to your component to connect your component directly to transaction level interface ports for your particular platform.</td>
</tr>
</tbody>
</table>
Chapter 1

Introduction

The *Cycle Model Studio* is a graphical tool designed for the generation of hardware-accurate software models. It is designed to simplify the task of compiling an RTL hardware model into a Cycle Model, generate platform-specific components for simulation environments (such as SoC Designer, Platform Architect, and SystemC), and tune Cycle Models for optimal performance during simulations.

1.1 Virtual Prototype Methodology

Figure 1-1 shows how Cycle Model Studio shortens the design flow process by running RTL and software debugging tasks concurrently.
Figure 1-1  Virtual Prototype Benefits

As you can see in the figure, using the Cycle Model Studio enables you to perform software debugging earlier in the cycle so that your final product is available sooner. Also, some additional RTL debug issues may be uncovered during software debug.

The Cycle Model Studio Graphical User Interface (GUI) manages all aspects of the Cycle Model compile and runtime processes.
1.2 Overview of Cycle Model Studio Functions

Figure 1-2 is used throughout this manual. Red borders surrounding a yellow Cycle Model Studio component indicate which Cycle Model Studio function is being described in the chapter.

The overall process is described below:

1. Create a Project in Cycle Model Studio, and then add the Verilog design and library files to the project.
2. Compile the project using the Cycle Model Compiler. This creates the Cycle Model.
3. Generate a component that is compatible with your simulation environment. Cycle Model Studio supports SoC Designer, Platform Architect, and SystemC.
4. Configure the generated component. This enables you to specify the connection interface between your Cycle Model and your simulation environment.
5. Run and tune your simulation using the component.
1.3 Understanding Cycle Model Studio Configuration Options

Cycle Model Studio can be configured to run in either of the following ways:

- Running the compile functions on a Linux server and running the post-compile functions in a Microsoft Windows environment.
- Running both compile and runtime functions on a Linux server.

Refer to the *Cycle Model Studio Installation Guide* (101106) for more information regarding these options.

1.4 Starting Cycle Model Studio

Follow the instructions in the *Cycle Model Studio Installation Guide* (101106) to make sure you have installed all components successfully, and that the appropriate environment variables have been set, before starting Cycle Model Studio.

Follow the steps below to start Cycle Model Studio:

For Linux, from your working directory, enter:

```
${CARBON_HOME}/bin/modelstudio
```

For Windows:

- From the **Start Menu**, select **Programs -> Arm -> Cycle Model Studio**
- or
- From Windows Explorer, go to the location where Cycle Model Studio is installed (the CARBON_HOME), go to the `\Win\bin` directory, and launch `modelstudio.exe`. 
Chapter 2

Understanding the Cycle Model Studio Interface

Cycle Model Studio provides an integrated environment that places system validation in parallel with the hardware development flow. The Cycle Model Compiler within the Cycle Model Studio takes an RTL hardware model and creates a high-performance linkable object, called a Cycle Model, that is both cycle and register accurate. The Cycle Model provides the capability for interfacing with your validation environment.

In addition, Cycle Model Studio can compile models that are compatible for use with specific design platforms, such as SoC Designer, Synopsys Platform Architect, and SystemC.

The Cycle Model Studio supports a variety of Compile and Runtime functions. Compile functions include:

- Loading Projects and Files
- Configuring Compile Settings
- Assigning Directives
- Checking code
- Compiling the Cycle Model

The Cycle Model Studio Runtime functions include:

- Running Cycle Models
2.1 Reviewing GUI Features and Functions

The Cycle Model Studio graphical user interface (GUI), shown in Figure 2-1, includes a Menu bar, Toolbar, and a variety of Views that can be docked or undocked to suit your viewing preferences.

Figure 2-1  Cycle Model Studio Graphical User Interface

The Cycle Model Studio main menu provides access to the main functional areas of the GUI.

- **File** - Open, close, or import projects and files.
- **Edit** - Perform cut, copy, paste, and editing functions. Set Model Studio preferences.
- **View** - Show or hide the different view windows.
- **Build** - Check your code and compile your project into a Cycle Model.
- **Project** - Manage project settings.
- **Window** - Move the focus to open windows.
- **Help** - Open the *Cycle Model Studio User Manual* PDF, or view version information.
2.1.1 Using the File Menu

Use the **File** menu to:

- Create new projects and files
- Open existing projects and files
- Close the current project
- Save the current project or file
- Perform advanced Find operations to find files or strings within files
- Define drive mappings (for Windows users compiling on a Linux machine)
- Exit the Cycle Model Studio

2.1.1.1 Creating a New Project

Selecting **File > New** displays the **New Project** dialog, shown in Figure 2-2.

![New Project dialog](image)

**Figure 2-2** **New Project** dialog

**Note:** **Windows Only:** If you are running CMS on Windows, a **Remote Compilation** panel appears at the top of this dialog to configure compilation of your RTL project on a Linux machine. Select the Mapped Drive to be used to perform remote compilation of the Cycle Model. Click **Map Network Drive...** to map a network drive if no drives have been set up. See **Drive Mappings** on page 27 for more information.

**Note:** **Windows Only:** If the project you are working on does not need to have the RTL compiled using the Cycle Model Compiler on a Linux machine, you can uncheck the “This project will be compiled remotely” box. This enables you to configure and compile components that run exclusively on Windows. The project types that require the Cycle Model Compiler are removed from the list when you uncheck this box.
To create a new project:

1. In the **New Project** dialog, you have the following choices:
   - **Empty Project** - Select this option if you are starting a new project from scratch, and have not previously used the Cycle Model Compiler.
   - **Project from existing Arm Cycle Model Studio Command (.cmd) file** - Select this option if you have an existing command file containing RTL source files and specific compile settings, from a previous Cycle Model compile that you wish to use to start your new project.
   - **Project from existing Arm Cycle Model Studio database (.symtab.db)** - Select this option if you have an existing database file from a previous Cycle Model that you wish to use to initiate a new project.
   - **Project from existing Arm Cycle Model Studio CoWare Wizard (.ccfg)** - Select this option if you have an existing configuration file from Platform Architect (or the old CoWare Wizard product) and you wish to continue customization of the component.
   - **Project from existing Arm Cycle Model Studio SoC Designer Wizard (.ccfg)** - Select this option if you have an existing configuration file from the old SoC Designer Wizard product and you wish to continue customization of the component.
   - **Model to be generated from Arm Cycle Model Studio Model Kit (.model)** - Select this option if you are using an existing .model generated from Cycle Model Studio.

   **Note:** You can import an existing .ccfg file into a project as well, as described on page 38. In that case you will have access to the RTL files to further configure the Cycle Model. The options above still allow customization of Component settings, but will not include RTL source.

2. In the **Name** field, enter the name for your new project.
3. In the **Location** field, browse to the location where you will store your new project.
4. Click **OK**.

   **Note:** Select the checkbox **Create Directory for Project** to automatically create a new directory using the name of the project.
2.1.1.2 Opening Projects and Files

Select **File > Open** to open an existing Cycle Model Studio project or file. Selecting **Open** displays the **Open Project** dialog, shown in Figure 2-3.

1. Select **File > Open > Project** to display the **Open Project** dialog (Figure 2-3), or select **File > Open > File** to display the **Open File** dialog.

Figure 2-3 **Open Project** dialog

2. If you select **Open** and **Project**, browse to an existing project and click the **Open** button to open that project. You can also use the **Open Recent Project** option to open any of the most recently opened projects.

If you select **Open** and **File**, browse to a file of the type listed in the **Files of Type** field, and click the **Open** button to open the selected file in a text editor window.
2.1.1.3 Opening a Recent Project

File > Open Recent Project provides a list of recently-opened projects. Select a project from the list to open that project.

2.1.1.4 Closing a Project

Select File > Close Project to close a project while keeping Cycle Model Studio open.

2.1.1.5 Saving All Files

Select File > Save All to save all files associated with the current project.

2.1.1.6 Saving the Current File

Select File > Save to save the current file.

2.1.1.7 Using the Find Option

Select File > Find in Files... to search for specific strings within the files in your project, or anywhere on your drive. When you select this option, the Search for string in Files dialog appears (Figure 2-4).

![Search for string in Files dialog](image)

**Figure 2-4** Search for String dialog

1. Enter the string you want to find in the Find what field.
2. Define the scope of the area to be searched in the Look in field.
3. Set any additional options you want
4. Click Find All.

The files that contain the search criteria are displayed in the Console window. Click on each entry in the Console window to display the file that contains the string in the Main view area.
2.1.1.8 Using the Drive Mappings option (Windows Only)

The File > Drive Mappings... option enables you to manage the Windows Network drive to Linux directory mappings. This menu option is available only for Windows users who are compiling on a remote Linux system. At least one drive mapping must be set up before you can define a new project. When you select this option, the Network Drive to Unix Directory Mappings dialog appears (Figure 2-5).

![Network Drive to Unix Directory Mappings dialog](image)

Figure 2-5  **Network Drive to Unix Directory Mappings** dialog

You can add new drive mappings or remove existing drive mappings. Click Add to add a new drive mapping; the Map Network Drive to Unix Path dialog appears (Figure 2-6).

![Map Network Drive to Unix Path dialog](image)

Figure 2-6  **Map Network Drive to Unix Path** dialog

1. Select a previously-mapped network drive that links a Windows drive letter to an area on a Linux machine.
2. Enter the Linux path on the machine where the project files will be located.
3. Enter the name of the Linux Server and the Username to be used to log in to the server.

4. After you have entered this information, click the **Verify** button to verify that the mapping is set up correctly. You must enter the password for the remote Linux server before verification can complete.

### 2.1.1.9 Exiting Cycle Model Studio

Selecting **File > Exit** closes all open projects and exits Cycle Model Studio. If any changes have not been saved, you are prompted to save the changes before closing the project.
2.1.2 Using the Edit Menu

Use the **Edit** menu to:

- Set Cycle Model Studio preferences
- Cut, copy, paste, and perform other editing functions

*Note:* The editing functions are available only when an item is open in the Main window, such as a source file.

2.1.2.1 Setting Preferences

Selecting **Edit > Preferences** enables you to set Cycle Model Studio preferences that apply to all created projects:

- **General Preferences** — Set project-wide preferences, such as behavior on startup, log file creation, Visual Studio version, and environment variable value and application.
- **Text Editor Preferences** — Affect how text is displayed in the main window.

Figure 2-7 shows the **General Preferences** dialog.

![Figure 2-7 Cycle Model Studio General Preferences dialog](image)

The dialog includes options for:

- Automatically Load Design Hierarchy
- Automatically load changed files into the Source Code Editor
- Number of logs to save
- Visual Studio Version (used to select nmake.exe)
- Verilog Default mode for new projects
- Startup Home Page (changes will be seen on next start)
- Use the following environment variables to convert filepath(s):
  - Variables are per-Project
  - Variables affect all Projects

The variables include:

- CARBON_ARCH
- CARBON_CONFIGURATION
- CARBON_HOME
- CARBON_OUTPUT
- CARBON_PROJECT
- COLORTERM
- CVSROOT

The current values displayed include Linux64, Linux/MyCompilerConfigs, etc.
Automatically Load Design Hierarchy — Automatically loads the Design Hierarchy view, described in “Using the Design Hierarchy View” on page 58, when you start Cycle Model Studio.

Automatically load changed files into the Source Code Editor — If a window in CMS is open to a source file, and that file is changed outside of the CMS GUI, then if this option is enabled the window is automatically updated with the changed version.

Number of logs to save box — Enables you to specify the maximum number of log files to save for each project. When that number is reached, old files are deleted as new files are written.

Visual Studio Version (used to select nmake.exe) — Applies only to the Windows version of Cycle Model Studio. It allows you to specify which version of Microsoft Visual Studio you are using. Cycle Model Studio uses this setting to determine which version of nmake.exe to use when building Windows SoCD components.

Verilog Default mode for new projects — Allows you to specify the variant of Verilog that you want the Cycle Model Compiler to use by default for new projects. When you open a project created with a previous version of Cycle Model Studio, the current version of Cycle Model Studio detects and retains the compiler variant that was originally set for the project.

Note: You can configure any compilation to use a variant different from the variant set in Preferences. See “Setting the Verilog variant” on page 35 for instructions on setting configuration-specific compilation options.

Startup Home Page — Specifies the content displayed in the main Cycle Model Studio windows up startup. Default displays the Arm developer website (https://developer.arm.com), which has the most up-to-date Arm content. Local displays the Cycle Model Studio introduction page that shipped with your installation.

Use the following environment variables to convert file path(s) — Enables you to select environment variables to be used in place of hard-coded file path values. This can be helpful when multiple users are working on a single project, and when a source control system is being used.

For example, if Verilog files are stored in a source control system under the RTL directory: for example, RTL/CPU/file1.v or RTL/MEM/mem2.v. You could create the RTL_HOME environment variable for each user who needs access to the source files. As you add files to the CMS project, they are written into the Project file as $(RTL_HOME)/CPU/file1.v (instead of /home/cds/tonacki/Projects/RTL/CPU/file1.v). When another user has the same environment variable set to their local work area, for example, /home/cds/bsmith/Projects/RTL, they are able to successfully open the Project file.

You can select whether the environment variables are used for the current project only, or for all projects.

Important: This environment variable must be selected (checked) in the Preferences page before you begin adding source RTL files into the project.
2.1.3 Using the View Menu

The View menu allows you to tailor the Cycle Model Studio user interface (UI) to your needs by adding or removing UI components. To add or remove UI components, click to select or deselect the listed views.

<table>
<thead>
<tr>
<th>View</th>
<th>Ctrl+H, Ctrl+D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Hierarchy</td>
<td>Ctrl+H, Ctrl+D</td>
</tr>
<tr>
<td>Console</td>
<td>Ctrl+H, Ctrl+D</td>
</tr>
<tr>
<td>Error List</td>
<td>Ctrl+H, Ctrl+L</td>
</tr>
<tr>
<td>Project Explorer</td>
<td>Ctrl+H, Ctrl+X</td>
</tr>
<tr>
<td>Properties</td>
<td>Ctrl+H, Ctrl+P</td>
</tr>
</tbody>
</table>

Figure 2-8 Cycle Model Studio View Menu

Note that the Main view window cannot be removed or hidden.

2.1.4 Using the Build Menu

The Build menu provides the functions needed to compile, check, recompile, and clean Cycle Models.

2.1.4.1 Checking for Errors

Use Build > Check to check the project components, such as environment variables and paths, for any errors prior to compiling the Cycle Model. This performs the same functions as the Check button.

2.1.4.2 Exploring the Modules and Nets Hierarchy

Use Build > Explore Hierarchy to display modules and nets in the Design Hierarchy window without having to first perform a compile of your RTL source. This is useful if you know you will be assigning directives to the nets in your design. This option takes less time than performing a Compile in the usual way, then assigning directives to nets, and then having to Compile a second time.
2.1.4.3 Compiling

Use Build > Compile to compile Verilog RTL into a Cycle Model. The compiler uses the currently-selected Configuration (and all defined settings) to perform the compilation. On Windows, you are prompted to configure remote server information — refer to “Reviewing Remote Compile Requirements” on page 62.

See “Configuration Manager” on page 36 for more information on defining configurations. This performs the same functions as the Compile button.

2.1.4.4 Stopping Compilation

Use Build > Stop Compilation to cancel any compile that is underway. This performs the same functions as the Stop button.

2.1.4.5 Recompiling

Use Build > Recompile to clean out previously generated files (using the Clean functionality described below), and then compile the Cycle Model.

2.1.4.6 Using Batch Build...

Use Build > Batch Build... to build all defined configurations. When you select this option, the Batch Build dialog appears (Figure 2-9).

![Batch Build dialog](image)

Figure 2-9 Batch Build dialog

All defined configurations appear in this dialog. Select or deselect the configuration that you want to compile and then click Build. See “Configuration Manager” on page 36 for more information on defining configurations.

2.1.4.7 Cleaning Files

Use Build > Clean to remove all files generated during a compile. This option removes all old files that could possibly be stale. Note that the next compile will take a much longer time than usual, in order to create all the files from scratch again.
2.1.5 Using the Project Menu

The **Project** menu provides access to the compiler settings, component build operations, **Configuration Manager** options, and import options.

<table>
<thead>
<tr>
<th>Project</th>
<th>Model Kits</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compiler Settings...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Run Script...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration Manager...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add RTL Source(s)...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add RTL Library...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Arm Cycle Model Studio Command File</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Arm Cycle Model Studio Wizard File</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create SoC Designer Component...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Platform Architect Component...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create SystemC Component...</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Figure 2-10 Cycle Model Studio Project Menu](image)

*Note:* Some of these options may be unavailable, depending on the type of license you have purchased from Arm.

This section describes:

- Configuring Compiler Settings
- Setting the Verilog variant
- Using the Run Script Option
- Creating New Compile Properties Sets
- Adding RTL Sources
- Importing a Command File
- Importing a Wizard File
- Creating a SoC Designer Component
- Creating a Platform Architect Component
- Creating a SystemC Component
2.1.5.1 Configuring Compiler Settings

`Project > Compiler Settings` enables you to configure the parameters needed to compile Cycle Models.

You can define unique sets of properties that contain different compile settings. Changes you make in the Properties pages are applied to the active configuration (the configuration selected in the Configure: pulldown menu), and used the next time you compile any project using that configuration.

To configure compiler properties:

1. From the `Project` menu, select `Compiler Settings` to display the `Compiler Options` dialog, shown in Figure 2-11.

   ![Configuration Menu]

   ![Property List]

   ![Property Description]

   ![Property Value]

   **Figure 2-11 Compiler Options dialog**

2. From the `Configuration` pulldown menu, select the configuration for which to set Compile Properties. (For instructions on creating new configurations, refer to Creating New Compile Properties Sets).

3. Click and edit each property value field as needed.

4. When you have completed your configuration, click OK to save the settings. These property settings are used the next time you compile any project using the selected Configuration.
2.1.5.2 Setting the Verilog variant

The Compiler Options dialog allows you to specify the variant of Verilog that you want the compiler to use. The Cycle Model Compiler supports Verilog 95, Verilog 2001, and SystemVerilog (1800-2012). By default, the Cycle Model Compiler uses Verilog 95.

To change the variant for the selected configuration, select one of the supported variants from the VerilogMode pulldown menu in the Verilog Options section of the Compiler Options dialog:

![Image of Compiler Options dialog with VerilogMode set to v95]

The default value for VerilogMode is configured in Preferences (see “Setting Preferences” on page 29).
2.1.5.3 Using the Run Script Option

Use Project > Run Script to execute a script. This displays the Execute Script dialog (Figure 2-13).

Cycle Model Studio provides the Execute Script option to support specialized functionality. Consult with Arm Technical Support for more information.

![Figure 2-13 Execute Script dialog](image)

2.1.5.4 Creating New Compile Properties Sets

Use Project > Configuration Manager to create a new Compile properties set. This displays the Edit Configurations dialog (Figure 2-14):

1. Click New to create a new property set. The Create Configuration dialog appears with the default configuration name <New>.

![Figure 2-14 Configuration Manager dialogs](image)
2. Type a new name to replace <New> for your new property set and click OK. You are returned to the **Edit Configurations** dialog.

3. Click **Close** to close the dialog.

4. From the **Project** menu, select **Compiler Settings...** to display the **Compiler Options** dialog.

5. Select the new **Compile Properties Set** you have created, and edit the property parameters as needed (see **Configuring Compiler Settings** for more information).

6. Click the **OK** button to save your settings.

### 2.1.5.5 Adding RTL Sources

Select **Project > Add RTL Sources...** to add RTL source files to your project. When you select this option, the **Select RTL Sources** dialog appears (Figure 2-15).

![Select RTL Sources dialog](image)

**Figure 2-15  Select RTL Sources** dialog

Select the RTL source file you want to add and click **Open**. The source file is added to the source file list in the Project Explorer view. The new file or files are used the next time you compile your project.
2.1.5.6 Importing a Command File

Project > Import Arm Cycle Model Studio Command File enables you to import an existing Command (.cmd) file into the current project. This applies all the command settings that exist in the Command file to the current project. This is useful if you have created a Command file with many custom settings that you want to apply to other Cycle Model Studio projects.

Note that you can create a new project and apply the Command file to the new project as well.

2.1.5.7 Importing a Wizard File

Project > Import Arm Cycle Model Studio Wizard File enables you to import an existing Wizard (.ccfg) file into the current project. This is useful if you had previously generated a component using the SOC-VSP Component Generator for SoC Designer or SOC-VSP Component Generator for Platform Architect.

Typically, this option is used by customers who used one of the older Wizard products (listed above) and who now want to continue the customization of the Component using Cycle Model Studio. In these cases, the initial project should be created using the existing Command file (described on page 24) so that all RTL sources and Cycle Model compile settings are available for further configuration.

Warning: The Cycle Model name in Cycle Model Studio must be the same as the Cycle Model name used when you initially created the .ccfg file using the Wizard. The .ccfg file contains the name of the original Cycle Model and will cause a compilation error if the same name is not used. You can define the name in the Compiler Properties page using the -o option.

When you select this option, the Import Pre-existing Wizard dialog appears (Figure 2-16).

Select whether the file is a SoC Designer or Platform Architect (CoWare) wizard file, browse to the file location, and click OK to import the file into the project.

Note: You can create a new project based only on the .ccfg file, as described on page 24. However, in that case you will not have access to the RTL files to further configure the component.
2.1.5.8 Creating a SoC Designer Component

Use Project > Create SoC Designer Component... to create an SoC Designer-compatible component from the Cycle Model. System engineers use the component in SoC Designer to build a simulatable system and perform validation and debug operations.

See “Starting and Configuring the Project” on page 84 for complete details.

2.1.5.9 Creating a Platform Architect Component

Project > Create Platform Architect Component... creates a Platform Architect-compatible component from the Cycle Model. System engineers use the component in Platform Architect to build a simulatable system and perform validation and debug operations.

See “Platform Architect-Specific Instructions” on page 135 for complete details.

2.1.5.10 Creating a SystemC Component

Project > Create SystemC Component... creates a component that can be linked directly into a SystemC design environment.

See “Creating Components for SystemC” on page 140 for complete details.

2.1.6 Using the Window Menu

The Window menu provides control for the various view windows within the Cycle Model Studio GUI.

<table>
<thead>
<tr>
<th>Close</th>
<th>Ctrl+F4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close All</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tile</th>
<th>Ctrl+Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Next</th>
<th>Ctrl+Shift+Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous</td>
<td></td>
</tr>
<tr>
<td>Reset Windows</td>
<td></td>
</tr>
</tbody>
</table>

Figure 2-17  Cycle Model Studio Window Menu

Close — Closes the particular view or pane that is currently active (the one that is checked in the list).

Close All — Closes all project panes, including the active one.

Tile — Displays multiple components within a view side by side, replacing the tabbed view.

Cascade — Displays multiple components within a view in a cascading format, replacing the tabbed view.

Next — Displays the next element when multiple elements are present in a view.

Previous — Displays the previous element when multiple elements are present in a view.
**Reset Windows** — Resets the windows to their default locations. This is useful if you have undocked some of the view windows and want to move them all back to their default positions.

### 2.2 Using the Toolbar

The Cycle Model Studio toolbar provides access to some of the most frequently-used actions.

![Cycle Model Studio toolbar](image)

**Figure 2-18  Cycle Model Studio toolbar**

*Note: Some buttons may be unavailable depending on the type of license you have purchased from Arm.*

The **Save**, **Delete**, and **New Directive** buttons are context-sensitive and are available only when certain configuration settings are displayed in the main view window.

There are tool tips for the buttons so that a brief button description appears as you float the mouse cursor over each button. The buttons include:

- **Save All** — Saves all open project files.
- **Check** — Checks the design for errors.
- **Compile** — Compiles the project.
- **Stop** — Use this button to stop an in-process compile.
- **Compile Properties Set selection** — This menu enables you to select a specific set of Compile properties to be used for the next compile of the project. You can define multiple compile property sets so that you can create Cycle Models with different attributes. See “Creating New Compile Properties Sets” on page 36 for more information.
- **SoC Designer** — Creates an SoC Designer-compatible component from the Cycle Model. See “Starting and Configuring the Project” on page 84 for complete details.
- **Platform Architect** — Creates a Synopsys Platform Architect-compatible component from the Cycle Model. See “Platform Architect-Specific Instructions” on page 135 for complete details.
- **SystemC** — Creates a component that can be linked directly into a SystemC design environment. See “Creating Components for SystemC” on page 140 for complete details.
2.3 Using the View Windows

The Cycle Model Studio provides many view windows that perform different tasks as you build and compile your projects. The possible views include:

- Project Explorer (Section 2.3.1)
- Main (Section 2.3.2)
- Properties (Section 2.3.3)
- Console (Section 2.3.4)
- Error List (Section 2.3.5)
- Design Hierarchy (Section 2.3.6)

2.3.1 Using the Project Explorer View

Use the Project Explorer view to manage your projects and to compile Cycle Models.

![Figure 2-19 Cycle Model Studio Project Explorer Window](image)

The Project Explorer view displays:

- Projects
- Project-related Verilog RTL source files and models
- Platform-specific (Platform Architect, SoC Designer, or SystemC) components
- Cycle Model Studio-generated files
Use the Project Explorer view to perform a variety of tasks, such as:

- Compiling Cycle Models from RTL
- Configuring Compile properties
- Generating platform-specific models
- Configuring path and platform parameters

*Note:* Some items in the Project Explorer are affected by the order in which they are listed; for example, the list of RTL Source files. You can move the files up or down in the Explorer tree view using the **Move Up** and **Move Down** buttons.

To use the Project Explorer view:

- Click to select any node in Project Explorer view. In many cases, selecting a node displays its configuration information in the Properties view.
- Double-click an item to activate it. When an item is activated (for example, an RTL source file or a directives file), its contents are displayed in the Main view (see Section 2.3.2).
- Right-click an item to display a context-sensitive menu of available actions for that item, and select the action to execute it. This is shown in Figure 2-20.

![Figure 2-20 Project Explorer Context Menus](image)

The same options are also available from the Project menu. See “Using the Project Menu” on page 33 for more details.
2.3.2 Using the Main View

Use the **Main** view to view and configure project settings. When you:

- Click once on a file in the Project Hierarchy — the Properties window displays properties for that file.
- Double-click a file in the Project Hierarchy — the Main view displays the file’s contents. In the Main view, you can edit the file, or values in the configuration window.

As shown in Figure 2-21, the Modules and Nets directives display when you double-click the “Compiler Directives” option. The Directives file appears when you double-click the directives file (if one exists for your project). The Verilog file content displays when you double-click the file in the RTL Folder list.

Figure 2-21  Sample Contents of Main Window

There are many other files that appear in the Main view as you define the settings for your project.

Use the close button (×) to close the active file in the Main view when you no longer want it displayed.

To adjust the font size in these text windows, set the Text Editor **Preferences** from the **Edit** menu. To make temporary changes to the font size, use the key sequence Ctrl+<Number Pad +> to increase the font and Ctrl+<Number Pad - > to decrease the font.
2.3.3 Using the Properties View

Use the **Properties** view to display all properties associated with a selected item, and edit those properties as needed. Editable and read-only fields vary, depending on the item selected in the **Project Explorer** view. Property views (sets) are provided for:

- Projects (Section 2.3.3.1)
- Cycle Model Compiler (Section 2.3.3.2)
- RTL Folders (Section 2.3.3.3)
- RTL Files (Section 2.3.3.4)
- Compiler Directives Files (Section 2.3.3.5)

The Properties view (Figure 2-22) includes three elements:

- Property Type Field
- Property Parameters Window
- Parameter Help Window.

![Property Type Field](image1)

**Property Type Field**

![Property Parameters Window](image2)

**Property Parameters Window**

![Parameter Help Window](image3)

**Parameter Help Window**

**Figure 2-22  Cycle Model Studio Sample Properties Window**

If the Property Type field:

- Displays one item — The parameters displayed in the Properties window apply to that item.
- Is blank — The properties displayed may apply to multiple items.

The Parameter Help Window at the bottom displays additional information about selected items.
2.3.3.1 Project Properties

The Cycle Model Studio Project (.carbon file) contains all the data required to configure the Cycle Model Studio environment and manage Cycle Models, including all the files that are generated during the compile process. The project properties are listed in the Project Properties dialog (Figure 2-23). For descriptions of individual items, select the item and view the information in the Parameter Help window.

![Project Properties dialog](image)

Figure 2-23 Project Properties dialog

Some of the project properties are required to be filled, some are optional, and some are readonly fields.

- Read-only fields are in parentheses; for example, (Project Directory).
- Required fields include Remote CARBON_HOME, Remote Server, Remote Username, and Remote Working Directory. For Windows users, these fields are filled automatically from the values entered in the Drive Mapping dialog, as described in “Drive Mappings” on page 27.

Note that the following environment variables are available whenever Cycle Model Studio launches a program (for example, an Epilogue script):

- CARBON_PROJECT=<project directory>
- CARBON_CONFIGURATION=<platform>/<name>
- CARBON_OUTPUT=$CARBON_PROJECT/$CARBON_CONFIGURATION
- CARBON_MODEL=<design.name>

For example, the following values would be available for scripts:

- CARBON_PROJECT=/home/username/CycleModels/Projects/Project1
- CARBON_CONFIGURATION=Linux/Default
2.3.3.2 Compiler Properties

Use the **Compiler properties** to configure global parameters to be applied when compiling your Cycle Models. These parameters display when **Cycle Model** or **RTL Sources** is highlighted in the **Project Explorer** view.

The **Compiler properties** are saved in a Compiler Settings Property Set. Select the Compiler Property Set from the drop-down menu in the toolbar. After you select a specific Compile Property Set, all changes you make in the Properties pages are applied to that Configuration and used the next time you compile any project using that Compile Property Set.

You can define multiple compile property sets so that you can create Cycle Models with different attributes. See “Configuration Manager” on page 36 for more information.

The **Compiler Properties** are organized into the following categories:

- Basic Options
- General Compile Control
- Input File Control
- Module Control
- Net Control
- Output Control
- Verilog Options

Enter information in the parameter fields in any of the following ways:

- Clicking a drop-down menu and selecting the appropriate value.
- Clicking a **Browse** button and navigating to a file.
- Clicking the field and entering text.

Options you change from their default settings are indicated in bold text.

For descriptions of individual parameters in any of the categories, select the item and view the information in the **Parameter Help** window.
**Basic Options Parameters**

The **Basic Options** parameters are shown in Figure 2-24.

![Basic Options Parameters](image)

**Figure 2-24 Cycle Model Compiler Basic Options Parameters**

The `-o` option defines the default Cycle Model name. This name defaults to `lib<project_name>.lib` when running Cycle Model Studio on Windows, and to `lib<project_name>.a` when running on Linux.

**General Compile Control Parameters**

The **General Compile Control** parameters are shown in Figure 2-25.

![General Compile Control Parameters](image)

**Figure 2-25 Cycle Model Compiler General Control Parameters**

The **Additional Options** parameter enables you to add special compile parameters that are typically not required. See the *Cycle Model Compiler User Manual* (101050) for more information, and consult with Arm Technical Support for guidance.
**Input File Control Parameters**

The **Input File Control** parameters are shown in Figure 2-26.

![Figure 2-26 Cycle Model Compiler Input File Control Parameters](image)

The `-directive` option enables you to specify a directives file to be used during compilation of the Cycle Model. Directives are compiler commands that control how the Cycle Model Compiler interprets and builds a linkable object. See “Directives File Properties” on page 52 for more information.

**Module Control Parameters**

The **Module Control** parameters are shown in Figure 2-27. They control compilation settings that affect modules.

![Figure 2-27 Cycle Model Compiler Module Control Parameters](image)
**Net Control Parameters**

The **Net Control** parameters are shown in Figure 2-28. They control compilation settings that affect nets.

![Net Control Parameters](image)

Figure 2-28  Cycle Model Compiler Net Control Parameters

**Output Control Parameters**

The **Output Control** parameters are shown in Figure 2-29. They control the data that is output from the compile process.

![Output Control Parameters](image)

Figure 2-29  Cycle Model Compiler Output Control Parameters
Verilog Options Parameters
You can use the Verilog Options parameters (Figure 2-30) only with Verilog design files. They control how Verilog parameters are handled during the compilation process.

Figure 2-30  Cycle Model Compiler Verilog Options Parameters

For more information about compilation settings, see also:

- “Setting the Verilog variant” on page 35
- “Setting Preferences” on page 29
- Cycle Model Compiler User Manual (101050)
2.3.3.3 RTL Folder Properties

You display the RTL Folder properties page by selecting the RTL folder in the Project Explorer view (named **RTL Model** in our sample). The RTL Folder properties, shown in Figure 2-31, allow you to define the:

- name of the RTL folder
- name of the Verilog library in which the files in this folder should be placed
- Verilog compile options to apply to the files in this folder when the project is compiled

![Figure 2-31 RTL Folder Properties](image)

Enter information in the parameter fields in any of the following ways:

- clicking a drop-down menu and selecting the appropriate value
- clicking a **Browse** button and navigating to a file
- clicking the field and entering text

For descriptions of these parameters, select the item and view the information in the Parameter Help window.

**Note:** The compiler property settings you make here override the Cycle Model project compiler settings. These settings apply to the files in this folder only.
2.3.3.4 RTL File Properties

You display the RTL File properties page by selecting a file within the RTL Model in the Project Explorer view. The RTL File properties, shown in Figure 2-32, allow you to define compiler properties unique to a specific file that is part of your project.

![Figure 2-32 RTL File Properties](image)

Note: The property settings you make here override the compiler settings for the project and the RTL Folder. The settings made here apply to the current file only.

For descriptions of these parameters, select the item and view the information in the Parameter Help window.

2.3.3.5 Directives File Properties

Directives control how the Cycle Model Compiler interprets and builds a Cycle Model. There are three ways to apply directives to your project:

- Using a directives file — Discussed below.
- Manually applying directives to modules and nets — See “Applying Directives to Modules and Nets” on page 72.
- Embedding directives in Verilog source as comments — See “Embedding Directives in Verilog Source Files” on page 77.

To use a directives file, you must specify the existing file name and location using the \-directive Compiler Property. After you define this property, the name appears in the Project
Explorer. When you click the directive file name (<name>.dir) in the Project Explorer tree, the path and file display in the Properties view, as shown in Figure 2-33.
2.3.4 Using the Console View

The Console view, shown in Figure 2-34, displays all process events that occur during and after compiling RTL into a Cycle Model.

**Note:** The console view is read only.

![Console View](image)

Colors are used in the Console view to call out important compilation information (see Figure 2-35). The colors that are used, and their meaning, include:

- **Red** — An error discovered in the Cycle Model Studio configuration information
- **Dark Red** — An error discovered in the Cycle Model Compiler configuration information
- **Blue** — A warning message about the Cycle Model Studio configuration

![Console Messages](image)
To display the location of the error in the source file in the Main view window, double-click highlighted messages.

### 2.3.5 Using the Error List View

The **Error List** view displays Errors, Warnings, and Messages generated during the compile process. The buttons along the top of this window display the total number of messages of each type. The buttons also enable you to filter (remove) certain messages from the list. The buttons are:

- **Errors** — Critical errors that stop the generation of the Cycle Model
- **Warnings** — Warning messages that could affect the generation of the Cycle Model
- **Messages** — Informational messages
- **Filtered** — Used to filter certain messages

Help for each error message is displayed at the bottom of the **Error List** window, as shown in Figure 2-36.

#### Figure 2-36 Error List Window

Error message descriptions can help you determine the cause of a problem and provide potential ways to fix it.

To use the **Error List** view:

1. Click any of the Select / Deselect buttons to hide or redisplay Errors, Warnings, or Informational Messages from the view (Figure 2-37).

#### Figure 2-37 Error List Window Buttons
2. To navigate to the location of a source file error in the main view window, double-click any error, warning, or message (Figure 2-38).

![Image of error location in RTL file](image)

Figure 2-38 Error Location in RTL File

3. Right-click any item to display the **Error List** context menu (Figure 2-39).

![Image of error list context menu](image)

Figure 2-39 Error List Context Menu

4. Right-click any error in the **Error List** view for which a file exists. This displays the **Error List** context menu.
5. Select the **Open in Design Hierarchy** option to see the hierarchical view of the item (Figure 2-40).

![Error List Link to Design Hierarchy](image)

**Figure 2-40** Error List Link to Design Hierarchy
To filter the errors, warnings, and messages that are displayed in the Error List view:

1. Right-click the item(s) in the error list that you wish to filter out.
2. From the Error List Options menu, select Filter Message to remove all instances of the message from the Error List view.
3. To re-display (cancel the filtering of) any messages you have previously filtered out, click the Filtered Button (Figure 2-41).

![Figure 2-41 Error List Window Filtered Button](image)

Figure 2-41 Error List Window Filtered Button

2.3.6 Using the Design Hierarchy View

Use the Design Hierarchy view, shown in Figure 2-42, to show design structure and manage the functions of design modules and signals. The Design Hierarchy provides two panes: the left displays the modules in the design tree, and the right pane displays the nets associated with the design modules.

![Figure 2-42 Cycle Model Studio Design Hierarchy Window](image)

Figure 2-42 Cycle Model Studio Design Hierarchy Window

To use the Design Hierarchy:

- In the Modules pane:
  - Click any module in the left pane to display the nets associated with that module in the right pane. If the module contains Verilog parameters, the Nets pane shows the parameters for each instance.
  - Right-click a module to set the observeSignal directive or the depositSignal directive on all the nets in the module, or just for that instance of the module.
  - Right-click any module in the left pane to display the RTL code for the module, or the RTL code for just that instance of the module, in the Main view.

- In the Nets pane:
  - Right-click a net to set the observeSignal, depositSignal, or forceSignal directive.
- Right-click a net to display the location in the RTL code where the net is located.
- When nets have sub-components, click the plus sign to expand the net to view the elements.
- When editing and tuning components, drag nets from the right pane to ports, registers, memories, and profiles (see Chapter 4, Creating Components for Specific Platforms).

- Use the Filter field and the check-boxes (Explicitly Observable, Explicitly Depositable) to restrict the view of the nets in the Nets window. This is useful when looking for specific nets within the design.

Note: Any nets displayed in red are not visible (not observable). If you require access to any of these nets, you must explicitly set the observeSignal directive.
Chapter 3

Compiling RTL into a Cycle Model

The Cycle Model Compiler takes an RTL hardware model and creates a high-performance linkable object, the Cycle Model, that is cycle and register accurate. The Cycle Model provides an API for interfacing with your validation environment. The Cycle Model Compiler fits into the design flow as shown in Figure 3-1.

![Figure 3-1 Cycle Model Studio Process Flow - Cycle Model Compiler](image-url)
This chapter provides information regarding the Cycle Model Compiler functions that are supported by the Cycle Model Studio. For comprehensive information regarding the Cycle Model Compiler, refer to the Cycle Model Compiler User Manual (101050).

This chapter includes the following sections:

- Reviewing Remote Compile Requirements
- Cycle Model Compiler Inputs
- Cycle Model Compiler Directives
- Compiling RTL with Cycle Model Studio

3.1 Reviewing Remote Compile Requirements

Cycle Model Studio requires that your RTL hardware description be compiled on Linux. However, it is possible to run the Cycle Model Studio on Windows and control a compile process that is running on Linux. This section describes how to set up Cycle Model Studio on Windows to manage remote compilation on a Linux server.

If you are running on Windows, when you initially click Compile, you are prompted to configure Remote Server Configuration settings.

You need the following information:

- **Server Name** — Name of the Linux machine used for compilation.
- **Username** — Username for access to the Linux machine.
- **Remote Working Directory** — The directory where compilation occurs.
- **Remote Command Prefix** (optional) — Script to run after logging in - for example, one that defines CARBON_HOME and also places CARBON_HOME/bin into the Linux path.
- **Remote CARBON_HOME** — Location where CARBON_HOME resides on the remote Linux machine: the directory where Cycle Model Studio is installed.

*Note:* The project must not reference any files that reside outside the scope of the defined Remote Working Directory. For example, source files located in a Linux path /library are not opened by Cycle Model Studio; however, they still compile on the remote machine. This also means that errors might not be easily attributed to those files.

Click OK when this dialog is complete. You are prompted to enter the password for the Linux account.
These settings are shown in the Cycle Model Studio Project Properties window (Figure 3-2).

![Figure 3-2 Cycle Model Studio Project Properties](image)

Cycle Model Studio performs a check to ensure that these directories exist when executing a remote compilation. Refer to the *Cycle Model Studio Installation Guide* (101106) for more installation information.

**Important note regarding SSH:** Cycle Model Studio comes with re-distribution of PuTTY’s *plink* program (http://www.chiark.greenend.org.uk/~sgtatham/putty/) and uses *plink* to open up the remote Linux shell.
3.2 Cycle Model Compiler Inputs

A Cycle Model can be generated only by the Cycle Model Compiler. The Cycle Model Compiler reads the following files, in order, and generates a Cycle Model for the design.

1. Options files – Contain command options that provide control and guidance to the Cycle Model Compiler (sometimes these are called “switches”).
2. Directives files – Contain directives that control how the Cycle Model Compiler interprets and builds a Cycle Model.
3. Verilog design and library files – Golden RTL of the hardware design.

![Figure 3-3 Cycle Model Compilation Overview](image)

3.2.1 Cycle Model Compiler Options

You use the Cycle Model Compiler properties to configure parameters to be applied when compiling your Cycle Models. These parameters display when Cycle Model or RTL Sources is highlighted in the Project Explorer view. They are organized into a variety of categories.

3.2.2 Cycle Model Compiler Directives

Directives are compiler commands that can be contained in a directives file or embedded in Verilog source code. Directives control how the Cycle Model Compiler interprets and builds a linkable Cycle Model. As previously mentioned, Cycle Model Studio can manage two types of compile directives: Net directives and Module directives. Net directives provide access to specified signals in the Cycle Model from the external environment. Module directives identify a module in the design hierarchy that you intend to be hidden in the Cycle Model. For more information, refer to the Cycle Model Compiler User Manual (101050).
3.3 Compiling RTL with Cycle Model Studio

The Cycle Model Studio provides access to all the features needed to configure the compile process to your needs. You can:

• Define compiler properties
• Define source files
• Add directives
• Use compiler options
• Compile for Verilog

To compile RTL using the Cycle Model Studio you must follow the tasks listed below:

• Create your project
• Add RTL source files
• Define compiler properties
• Compile the project
• Define directives for modules and nets
• Recompile the project

3.3.1 Creating your Project

Follow the steps below to create a project.

1. In the File menu, select New, and select Project.

Figure 3-4 New Project from File Menu
2. The **New Project** dialog appears.

![New Project dialog](image)

**Figure 3-5 New Project dialog**

The top part of the **New Project** dialog appears only for Windows users who are performing remote compilation on a Linux machine. At least one drive mapping must be set up before you can define a new project. For Windows users, follow the next step. For Linux users, skip to step 8 on page 67.

3. For Windows users, select the Mapped Drive to be used to perform remote compilation of the Cycle Model. Click **Map Network Drive...** to map a network drive if no drives have been set up, and the **Network Drive to Unix Directory Mappings** dialog appears.

![Network Drive to Unix Directory Mappings](image)

**Figure 3-6 Network Drive to Unix Directory Mappings dialog**

This dialog enables you to manage the Windows Network drive to Linux directory mappings. You can add new drive mappings or remove existing drive mappings.
4. Click **Add** to add a new drive mapping and the following dialog appears.

![Map Network Drive to Unix Path dialog](image)

Figure 3-7 **Map Network Drive to Unix Path** dialog

5. Perform the following steps in this dialog:
   - Select the network drive that has already been set up in Windows.
   - Enter the Linux path to be equated to the network drive letter.
   - Enter the name of the Linux Server and your valid Username.
   - Click the **Verify** button to verify that the mapping is set up correctly. You must enter the password for the remote Linux server.

6. Once the verification is successful, click **OK** to return to the **Network Drive** dialog.

7. Click **OK** to return to the **New Project** dialog.

8. Select the type of new project that you want to create. See the list of project types on page 24 for a description of the different methods you can use to create a new project.

9. In the **Name** field, enter the name for your new project.
10. In the **Location** field, browse to the location where you plan to store your new project.

11. Click **OK**.

*Note:* Select the checkbox **Create Directory for Project** to automatically create a new directory using the name of the project. The project files are placed in that directory.

### 3.3.2 Adding RTL Source Files

Follow the steps below to add RTL source files to the project.

1. From the **Project** menu, select **Add RTL Source(s)**... You can also right-click the project in the Project Explorer view and select **Add RTL Source(s)**... The **Select RTL Source(s)** dialog appears.

![Figure 3-8 Add RTL Source Files](image)

2. Browse to and select your project’s RTL source file or files.
3. Click **Open** to add the RTL files to your project. The result is shown in Figure 3-9.

![Project Explorer](image)

**Figure 3-9  RTL Source Files in Project Explorer**

**Note:** The compilation of the project is affected by the order of RTL Source files in the **Project Explorer**. You can move the files up or down in the **Project Explorer** tree view using the **Move Up** and **Move Down** buttons.
3.3.3 Defining Compiler Options and Compiling the Cycle Model

By default, the initial compiler settings allow you to compile your project immediately into a Cycle Model. The -o option (under Basic Options) defines the default Cycle Model name. This name defaults to lib<project_name>.lib when running Cycle Model Studio on Windows, and to lib<project_name>.a when running on Linux. Many other options exist; fine-tune these to create the best Cycle Model for your application.

Follow the steps below to define the Cycle Model Compiler properties.

1. From the drop-down list in the toolbar, select the Compiler Configuration you want to use to compile the Cycle Model. The Compiler Configuration contains the unique compiler options to be used when you click the Compile button.

![Figure 3-10  Compiler Configuration Selection](image)

You can have many different sets of compiler properties that include different settings depending on the stage of development you are in. For example, you could have the Default standard set, a compiler set that includes the use of a directives file (-directive), and so forth. You create new sets of compiler properties using the Configuration Manager option under the Project menu.

2. In the Compiler Properties panel (Figure 3-11), set the desired option values. A brief description of each option appears at the bottom of the view in the Parameter Help Window. See Chapter 3 of the Cycle Model Compiler User Manual (101050) for more detailed information.

![Figure 3-11  Cycle Model Compiler Properties Window](image)
3. Click the **Compile** button in the toolbar. This creates the initial Cycle Model.

### 3.3.4 Defining Directives and Recompiling the Cycle Model

Directives are compiler commands that can be contained in a directives file, or embedded in Verilog source code. Directives control how the Cycle Model Compiler interprets and builds a Cycle Model. There are three ways to apply directives to your project:

- using a directives file
- manually applying directives to modules and nets
- embedding directives in Verilog source as comments

As mentioned in the previous section, you can use a directives file that affects the compilation result of your Cycle Model by using the `-directive` option. This is also described in “Directives File Properties” on page 52.

After you define the directives for the modules and nets in your design, you must recompile the Cycle Model.
### 3.3.4.1 Applying Directives to Modules and Nets

You can assign directives to modules and nets within your Cycle Model. This allows you to control the handling of modules and nets. Follow the steps below to define the module and net directives for the project.

**Adding Module Directives**

1. In the Project Explorer view, select **Compiler Directives**. The **Directives** view displays in the Main view. Note the **Nets** and **Modules** tabs at the bottom of the view.

![Figure 3-12 Cycle Model Studio Nets Directives Window](image)

2. In the Design Hierarchy, click any module to display the nets.

![Figure 3-13 Modules and Nets in Design Hierarchy Window](image)
3. Drag and drop modules to the **Directives** pane in the Main view, and apply directives to them (see Figure 3-14). Note that you can only place modules in the Modules tab, and nets in the Nets tab.

Figure 3-14 Add Module to Module Directives Window

4. Once the Module is in the Directives pane you can apply a single directive, or multiple directives, by selecting a Directives column and selecting the directive from the list. You can also select the directive from the Properties window, as shown below.

Figure 3-15 Set Module Directives in Directives Window and in Properties
One additional way to set two key directives (Observe and Deposit) to all nets within a module is to right-click the module in the Module window and select the directive.

![Figure 3-16 Set Module Directives in Design Hierarchy](image)

You can set the `observeSignal` directive or the `depositSignal` directive on all the nets in the module, or just for that instance of the module. Once you click the directive option, the module is automatically moved to the **Modules** tab in the **Directives** window and the selected directive (Observable, etc.) is set for that module or instance.

![Figure 3-17 Set Module Directives Results](image)
Adding Net Directives

1. Drag and drop nets to the Nets tab in the Directives pane and apply directives to them (see Figure 3-18).

2. Once the net is in the Directives pane you can apply a single directive, or multiple directives, by selecting a Directives column and selecting the directive from the list. The three most common net directives (Observe, Deposit, and Force) are provided as check boxes to make selection easier.

Figure 3-18 Add Net to Net Directives Window and Set Directives
You can also select the directive from the Net Directives Properties window as shown below.

Figure 3-19  Set Net Directives in Properties Window

One additional way to set the common net directives (Observe, Deposit, and Force) is to right-click the net in the Net window and select the directive.

Figure 3-20  Set Net Directives in Design Hierarchy

Once you click the directive, the net is automatically moved to the Net tab in the Directives window and the selected directive (Observable, etc.) is checked.

See the Cycle Model Compiler User Manual (101050) for a complete description of all the available compiler directives.
3.3.4.2 Embedding Directives in Verilog Source Files

As an alternative to the previous section of applying directives to modules and nets, directives may be embedded in Verilog source as comments. The prefix ARM_CM, shown in the examples below, is automatically recognized by the Cycle Model Compiler.

An embedded directive is associated with a net or a module. A sample section of a Verilog file is shown below:

```verilog
module top(in1, in2, clk1, clk2, out, ena);
  input in1, in2;
  input ena;  // ARM_CM tieNet 1'b1
  output out;
  input clk1;
  input clk2;  // ARM_CM collapseClock top.clk1
  reg a;  // ARM_CM observeSignal
         // ARM_CM depositSignal
  always @(posedge clk1)
    if (ena)
      a <= ~in1;
  wire out;  // ARM_CM depositSignal
  flop u2(out, in2, clk2, ena);
endmodule
```

To use a prefix other than ARM_CM to identify embedded directives, you must specify a compiler option.

To embed directives in source files, you can edit the files using an external editor, or you can edit the file within the Cycle Model Studio.

1. Double-click a source file in the RTL Sources list and the file is displayed in the Main view.

![Figure 3-21 Add Directives in RTL Source File](image-url)
2. Add the directives to the modules and ports. Sample directives are shown in a Verilog file in the figure above.

3. Click the **Compile** button to recompile the Cycle Model with the selected directive settings.
Chapter 4

Creating Components for Specific Platforms

This chapter describes the process for creating Cycle Models for specific platforms. Cycle Model Studio can create models for multiple platforms, as described in the following sections:

- Understanding the Process
- Starting and Configuring the Project
- SoC Designer-Specific Information
- Using the Component in SoC Designer
- Platform Architect-Specific Instructions
- Creating Components for SystemC
4.1 Understanding the Process

Cycle Model Studio manages the process of creating models for specific platforms so that changes made to the source RTL automatically regenerate any components derived from that RTL (see Figure 4-1).

![Diagram of Cycle Model Studio Process Flow - Component Generation](carbon.css)

**Figure 4-1 Cycle Model Studio Process Flow - Component Generation**

After compiling the Cycle Model from your source RTL, the next step is to generate a component that is compatible with your simulation environment.

4.1.1 Cycle Model Studio Component Generator Overview

The Cycle Model Studio tool can package a Cycle Model in the form of an SoC Designer, Platform Architect, or SystemC component. Refer to the section Starting and Configuring the Project for general instructions and information about configuration options. For important information about the different component output formats, refer also to the relevant section: SoC Designer-Specific Information, Platform Architect-Specific Instructions, or Creating Components for SystemC.

The Cycle Model Studio tool has several powerful features that allow you to integrate more tightly with the SoC Designer environment, for example:

**Transactor Adaptors**
Connect your component directly to transaction-level interface ports.

**Clock and Reset Generators**

*Note: Clock and Reset Generators are not supported for Platform Architect components.*
The clocks are an abstract construct that merely indicate when it is time for your component to execute another ‘cycle.’ HDL designs typically require alternating signal values of 0 and 1. The Cycle Model Studio tool’s clock and reset generators automatically stimulate your Cycle Model with signal values on every clock pulse, or on the schedule you set up. Refer to “Clock Inputs and Clock Generators” on page 148 for more information.

**Debug Registers**
RTL signals deep inside the Cycle Model may be made available as named debug registers for read and write during simulation.

**Debug Memories**
HDL memories may be made available for debugging by adding a memory to the memories tab (see “Memories Tab” on page 111).

**Profiling**
Capture Cycle Model state data in a form that can be easily analyzed using the SoC Designer profiling tools.

*Note: Profiling is not supported for Platform Architect components.*

**Ties and Disconnects**
Cycle Model input ports (e.g. test inputs) may be tied to a constant value instead of exposed as component ports.

Cycle Model output ports may be left unconnected (disconnected), instead of exposed as component ports.

**Port Expressions**
The value of signal ports may be modified by providing a C language expression. This is often useful to bridge the gap between an abstract and RTL signal interface (for example, to convert an integer value into a bit mask).

**Pseudo-Transactors**
Some common Port Expressions have been packaged in the form of Transactors for your use. For example, the Interrupt_Master and Interrupt_Slave transactors handle conversion of integer interrupt numbers into bit masks, and vice-versa.

The Null_Input and Null_Output transactors may be used to add extra SoC Designer ports to the component that are not connected to the Cycle Model. This is useful for matching the port interface of a behavioral component for which the component will be substituted. See Appendix A for more information.
4.1.1 Transactors

SoC Designer supports transaction-level port interfaces, but Cycle Models typically communicate at the pin level. Transaction adapters (known as Transactors) are provided to convert between several common transaction level interfaces and the Cycle Model pins.

Note: If you are creating a model for Platform Architect, note that the term used in the GUI changes from “Transactor” to “Protocol.”

Refer to the SoC Designer User Guide (100996) or Platform Architect documentation for details about the difference between transaction-based and signal-based communication in the selected environment.

The transactors you add to your component in the component typically add new SoC Designer transaction ports, and hide Cycle Model ports.

For example, an AHB_Slave_T2S converts AHB transactions to signal value changes (T2S means “transaction to signal”). When you add an AHB_Slave_T2S transactor to your component in the Cycle Model Studio tool, a new transaction slave port is created in the component for incoming AHB transactions. You must use the Cycle Model Studio tool to connect the transactor to the appropriate Cycle Model signal ports. Each Cycle Model signal connected to the transactor is no longer exposed as a port.

The resulting component may be connected to a transaction master port.

4.1.1.2 Component Clocking

The component generated by the Cycle Model Studio tool uses cycle-based scheduling. Refer to the SoC Designer User Guide (100996) or Platform Architect documentation for information about cycle-based scheduling.

The component has a clock input port named ‘clk-in’. This is a cycle-based clock, not an RTL signal port. The clk-in port determines how frequently the component is called to execute a cycle. For more information about clocking options, refer to “Clock Inputs and Clock Generators” on page 148.

• If you connect the clk-in port to the clock master port of another component (e.g., a CDIV clock divider), then that component determines when the component runs a cycle.

• If you do not connect the clk-in port to anything, then the component is driven by the simulator reference clock, running one cycle per time unit.

The component is a subclass of C++ class sc_mx_module. It implements the two methods — update() and communicate() — which are called by the clock master to which the clk-in port is connected.

In the communicate() method, all output ports that have new values are driven.
In the update() method, the Cycle Model is executed.
4.1.1.3 Clock Generation

In SoC Designer cycle-based scheduling, there is no signal value (i.e., 1 or 0) associated with a clock slave port. The SoC Designer clock slave port is only a mechanism for configuring when the component `communicate()` and `update()` methods are invoked.

*Note: Clock Generators are not supported for Platform Architect components.*

You can drive the Cycle Model clock signal ports using a Cycle Model Studio clock generator. A clock generator applies 0 and 1 signal values to the Cycle Model clock signal ports every time the component’s `update()` method is called. A clock generator may be configured to run at the same speed, faster, or slower than the SoC Designer reference clock.

*Note: Rather than creating a clock generator, Arm recommends creating a clock input trans-actor and exposing the clock input port externally.*

For additional information on the use of clock generators, refer to “Clock Inputs and Clock Generators” on page 148. For instructions on creating a clock generator, refer to “Specifying Generated Clocks” on page 92.
4.2 Starting and Configuring the Project

Use the Cycle Model Studio Project Explorer view to begin.

1. In the Project Explorer, right-click the Cycle Model to display the context menu.
2. From the context menu, select the desired component type:
   - Create Platform Architect Component
   - Create SoC Designer Component
   - Create SystemC Component

![Figure 4-2 Select the Type of Component to Create](image)

The new component, and its associated output files, are displayed in the Project Explorer as shown in Figure 4-3.

![Figure 4-3 Component for SoC Designer in Project Explorer](image)
4.2.1 Editing the Component Properties

Use the Component Properties view (shown in Figure 4-4) to edit the component properties.

Figure 4-4  SoC Designer Component Properties

The component properties differ depending on the type of component you are working with; for example, SoC Designer components have “Waveform File” and “Waveforms” properties, while Platform Architect components do not display these properties. When a property is selected, information about that property is displayed in the lower-right information panel of the CMS GUI.

4.2.1.1 Naming the component

By default, the name of the top-level module is used for the component, the SoC Designer C++ class name, and the *.cpp and *.h files generated by Cycle Model Studio. The Cycle Model Studio project name is not used. This name is shown in the Component Name or Model Name field.

To change the component name:

1. Click in the Component Name field (for Platform Architect, Module Name) to highlight the current component name.
2. Type the new name.
4.2.1.2 Specifying Force Update

Force Update (supported for Platform Architect only) specifies that calls to 
`sc_prim_channel::request_update` are forced for all input changes. If this is not speci-
fied, `request_update` is called only for clock, reset, and feed-through inputs.

4.2.1.3 Enabling Waveform Generation

Refer to the Cycle Model Studio Installation Guide (101106) for required versions of the FSDB 
writer library.

For SoC Designer

To use the dump to waveform feature:

1. In the Properties view, under the Component Properties section, click the Browse button 
in the Waveform File field to display the Output File dialog (Figure 4-5).

   ![Figure 4-5 Enable Waveforms in SoC Designer Component](image)

   *Figure 4-5 Enable Waveforms in SoC Designer Component*

2. In the Output File dialog, browse to the location of an existing wave file, or create a new 
file name in the File name field, and then click Save.

3. Click the drop-down menu from the Waveforms field and select the waveform file format 
you want to use, as shown in Figure 4-6.

   ![Figure 4-6 Waveform Type](image)

   *Figure 4-6 Waveform Type*
Note: By default, design elements larger than 1024 bits are not dumped to waveform files. To allow elements larger than 1024 bits to be dumped, increase the maximum size using the -waveformDumpSizeLimit compile option under Net Control.

For Platform Architect
To dump data to waveforms for Platform Architect:

add

-D CARBON_DUMP_VCD=1

or

-D CARBON_DUMP_FSDB

to scsh preprocessor options.

For example:

::scsh:: cwr_append_simbld_opts preprocessor -DCARBON_DUMP_FSDB=1

Note: By default, design elements larger than 1024 bits are not dumped to waveform files. To allow elements larger than 1024 bits to be dumped, increase the maximum size using the Cycle Model compiler -waveformDumpSizeLimit option under Net Control.

4.2.1.4 Setting Compiler and Linker Flags

The Cycle Model Studio allows you to customize your component by adding C++ Compile flags, with paths to include files, macros, etc., and Linker flags, with paths to include libraries, source files, etc.

Note: This functionality is not supported for Platform Architect.

To use the Compiler and Linker flag feature:

1. In the Component Properties view, click the Value cell in the C++ Compile Flags row to enable the text field (Figure 4-7).

Figure 4-7 Compiler and Linker Files and Flags

2. Enter the required compile flags.

Note: If you are creating a model to be used as a Swap & Play memory controller, add the following C++ Compile Flag:

\[-DCARBON_MEMORY_RESTORE_PORT_<portname>\]

where <portname> is the port with the lowest memory address region.

3. Click the Value cell in the Include Files row to add additional include files to be passed into the generated Makefile.

4. Click the Value cell in the Linker Flags row and enter any required Linker flags.
5. Click the **Value** cell in the **Source Files** row to add additional source files to be passed into the generated Makefile. For example, if you plan to use disassemblies (see “Creating Disassembly Views” on page 118), then you must list here the source files to be used.

### 4.2.2 Component Editing View

The **Component Editor** provides tabs to access ports, registers, memories, and profile (SoC Designer only). Double-click the `.ccfg` file in the **Project Explorer** to display the **Component Editor** (Figure 4-8).

![Component Editor Tabs for SoC Designer](image)

![Component Editor Tabs for Platform Architect](image)

Figure 4-8 CMS Component Editor
4.2.2.1 Ports Tab

Use the options on the **Ports** tab to connect the Cycle Model’s inputs and outputs to the component’s signals and drivers.

The **Ports** window is composed of sections in a tree-like structure: **Component Ports**, **Component Parameters**, **RTL Ties**, **RTL Disconnects**, **Reset Generators** (not available for Platform Architect), and **Clock Generators** (not available for Platform Architect). You use this window to define and configure the ports that are exposed in the completed component.

**Component Ports Window**

By default, the **Component Ports** section of the tree is expanded. The first column lists the ESL ports mapped to the corresponding RTL ports in the second column. Initially, there is a one-to-one correspondence of port names in the RTL and ESL Ports lists. The RTL ports that are displayed include all the primary I/Os of the Cycle Model, plus internal signals that were marked with the directive `observeSignal/scObserveSignal` or `depositSignal/scDepositSignal` when the Cycle Model was compiled with the Cycle Model compiler.

Each RTL port may be connected to the following sources:

- ESL Input or ESL Output
- Generated Clock
- Generated Reset
- Tie
- Disconnect
- Transactors

These connections are established by selecting one or more RTL ports (use **Ctrl-click** to select multiple ports) and then selecting an entry from the **right-click** context menu. The context menu offers different functions depending on the type of port, or node, you select in the Ports tab. This is shown in Figure 4-9.

![Component Ports](image)

**Figure 4-9 SoC Designer Component RTL Port Connection Options**
The ESL ports are the ports through which SoC Designer or Platform Architect connect to the component. These include signal ports (connected directly to the Cycle Model) and transactor ports. As necessary, reconnect RTL ports to clock generators, reset generators, ties, and transactor ports. You can also add additional ESL ports from the Design Hierarchy, and change the direction of ports.

Depending on the option you select, the RTL port is moved to the applicable section. For example, if you disconnect a port it is moved to the RTL Disconnects section. Any errors that occur during these operations appear in the Model Studio Status Bar. These selections, and their corresponding fields, are described in the following pages.

*Note:* *If an RTL signal is connected to a Generated Clock, Generated Reset, or Tie, then it may only have one connection.*

### Ports Toolbar

The **Ports** tab includes the Ports Toolbar (Figure 4-10), which you can use to further define your SoC Designer component.

![Ports Toolbar](image)

Figure 4-10  **Ports** Toolbar

The buttons include:

- **Delete** — Performs different functions depending on where this operation is used. For example, in the **Component Ports** section this moves an RTL port to the **Disconnects** section. In the **Disconnects** section this operation moves the port back to the **Component Ports** section to reconnect to an ESL port.
- **Undo** — Cancels the last operation.
- **Redo** — Performs a redo of a previous undo operation.
- **Transactor** — Lists the available transactors. For Platform Architect, this is “Protocol.”
- **Add Transactor** — Opens the **Add SoC Designer Transaction Port** dialog, where you can add a transactor to the SoC Designer component and map the RTL ports to the transactor ports. For Platform Architect, this button is called **Add Protocol**.
- **Add Parameter** (not available for Platform Architect) — Adds parameters to your component that can be accessed in the SoC Designer environment. The parameter can also be tied to RTL or ESL ports.
Changing ESL Port Names
The port names shown in the list are the names to be assigned to the ports of the finished component. By default, the input and output pin names used in the RTL code are also used in the ESL port list. Cycle Model Studio enables you to change the ESL port names within the Component Ports section (see Figure 4-11).

To change the name of an ESL port or transactor port:
1. In the Component Ports section, click on the port you want to rename.
2. Type the new name.

Tying Off Signals
You should disconnect (tie off) any signals that do not need to change during validation, such as scan-enable. To tie off input pins:
1. In the Component Ports section, select the input pin whose signal you want to tie.
2. Right-click and select Tie High or Tie Low from the context menu.

The port is moved to the RTL Ties section along with the selected tie value, and it is removed from the Component Ports list, indicating that this pin will not be used as an input port. You can change the tie value later in the RTL Ties list (Figure 4-12) if required.

Disconnecting Signals
To disconnect any input or output pins that are not needed:
1. In the Component Ports section, select the pin whose signal you want to disconnect.
2. Right-click and select Delete from the context menu.

---

**Figure 4-11 Component ESL Port Name**

To change the name of an ESL port or transactor port:

1. In the Component Ports section, click on the port you want to rename.
2. Type the new name.

**Figure 4-12 RTL Ties list**

*Note: Any RTL port on which the tieNet directive has been applied is automatically marked as tied in this pane, with the message Set by Compiler.*

If you decide later that a port does not need to be tied off, just right-click the port in the RTL Ties section and select Delete from the context menu. The port is removed from the tie offs list and appears back in the ESL ports list.

---
The port is moved to the **RTL Disconnects** list (Figure 4-13), and it is removed from the **Component Ports** list, indicating that this pin will not be used as an input or output port.

<table>
<thead>
<tr>
<th>RTL Disconnects</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Vic_carbon.HRESETn" alt="Pin 1" /> 1</td>
</tr>
<tr>
<td><img src="Vic_carbon.HRESP" alt="Pin 2" /> 2</td>
</tr>
<tr>
<td>input</td>
</tr>
<tr>
<td>output</td>
</tr>
</tbody>
</table>

**Figure 4-13 RTL Disconnects list**

If you decide later that a port should be connected to an ESL port, just right-click the port in the **RTL Disconnects** section and select **Delete** from the context menu. The port is removed from the **Disconnects** list and appears back in the **Component Ports** section.

**Specifying Generated Clocks**

When you mark your design’s input clock signals as generated clocks, the Component generator does not create ESL ports for these signals. Instead, the Component generator creates internal signals that are used to activate the component when SoC Designer Plus sends a reference clock signal to the component.

**Note:** *Clock Generators are not supported for Platform Architect.*

**Note:** *Rather than using clock generators, Arm recommends creating clock input transactors and exposing the clock input ports externally. For more about the use of clock generators, refer to the section “Clock_generator” on page 152.*

1. In the **Component Ports** section, select the signal that you want to designate as a clock.
2. Right-click and select **Create Clock Generator** from the context menu.
   The signal and default values appear in the **Clock Generators** section, and it is removed from the **Component Ports** list.
3. Modify the clock controls as necessary in the **Clock Generators** section, as shown in Figure 4-14.

<table>
<thead>
<tr>
<th><strong>Clock Generators</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Vic_carbon.HCLK" alt="Pin 1" /> 1</td>
</tr>
<tr>
<td>Initial Value</td>
</tr>
<tr>
<td>Delay</td>
</tr>
<tr>
<td>Duty Cycle</td>
</tr>
<tr>
<td>Frequency</td>
</tr>
<tr>
<td>![Clock Cycles] 1</td>
</tr>
<tr>
<td>![Component Cycles] 1</td>
</tr>
</tbody>
</table>

**Figure 4-14 SoC Designer Component Clock Settings**

For details about parameter settings, refer to “Clock Inputs and Clock Generators” on page 148.
Specifying Generated Resets

In general, you should mark your design’s reset signals as generated resets. This prevents the Component generator from creating unnecessary ESL ports for these signals. Instead, the Component generator creates internal signals that activate the component when SoC Designer sends a user-activated reset signal to the component.

Note: Reset Generators are not supported for Platform Architect.

1. In the Component Ports section, select the signal that you want to designate as a reset.
2. Right-click and select Create Reset Generator from the context menu.

   The signal and default values appear in the Reset Generators section, and it is removed from the Component Ports list.
3. Modify the reset controls as needed in the Reset Generators section, as shown in Figure 4-15.

   ![Figure 4-15: SoC Designer Component Reset Generator Settings](image)

   Resets are specified as follows:

   - **Active Value** and **Inactive Value**: Specify a hex or decimal value to be used when reset is active (asserted) and when it is inactive (deasserted). The default is 1 for active and 0 for inactive. The values can be used so the reset generator can be applied to a bus of reset signals.

   - **Cycles Before, Cycles Asserted, Cycles After**: Cycles Before is the number of cycles to wait during the reset period before asserting the signal. Cycles Asserted is the number of cycles the signal remains asserted. Cycles After is the minimum number of cycles the signal remains deasserted before the reset period ends.

   - **Frequency**, as a reset cycle-to-component cycle ratio:
     1:1 means one reset cycle per one component cycle; this is the default setting. 2:1 means 2 reset cycles to one component cycle. 1:2 means 1 reset cycle extends across two component cycles.
The length of the reset period is determined by the longest reset waveform duration. All reset waveforms that complete before the end of the period are extended by padding the deasserted time. See the examples below.

**Active Value = 1**
**Inactive Value = 0**
Frequency: 2 reset cycles per 1 component cycle = 2:1
Cycles: before, asserted, after (deasserted) = 1, 2, 1

```
0 1 2
```
Before = 1
Asserted = 2 cycles at 2:1
After = 1

**Active Value = 1**
**Inactive Value = 0**
Frequency: 4 reset cycles per 1 component cycle = 4:1
Cycles: before, asserted, after (deasserted) = 3, 3, 1

```
0 1 2
```
3 Cycles at 4:1 - Padded -
Asserted = 3 cycles at 4:1
Adding ESL Ports

All ports are automatically added and displayed in the Ports view. You can add additional ESL ports that you want to be accessible through the component. Only ports that have been marked observable or depositable can be added to the component.

Right-click on the Component Ports node, as shown in Figure 4-16, and select Add transaction port from the context menu.

![Figure 4-16 Add Port to Component](image)

Click on the new port and use the context menu to make further changes.

By default, the ESL port name is the same as the RTL net name. See “Changing ESL Port Names” on page 91 if you want to change the port name that is exposed in the component.

Adding Transactors and Other Interface Entities

This section applies to transactors, protocols (for Platform Architect), and other entities, referred to as pseudo-transactors, which act as go-betweens from ESL ports to Cycle Model ports. The pseudo-transactors handle interrupt signals, input clocks driven at variable speeds, generated output clocks, and null ports (ESL ports that are not connected to RTL ports). In the steps below, the terms transactor and protocol include pseudo-transactor entities. See Appendix A for more information.

To use transactors/protocols in your component, you need to specify the type of transactor or protocol, and then map the desired RTL ports from your design to the transactor’s or protocol’s ports. SoC Designer creates a connection to the transactor/protocol, but the connections between the transactor/protocol and the Cycle Model are invisible to SoC Designer Plus.
To add a transactor or protocol:

1. In the **Ports Toolbar**, click the **Add Transactor** button (for Platform Architect, the button is **Add Protocol**). The **Add Port** dialog appears (Figure 4-17).

![Add Port dialog](image)

**Figure 4-17 Add Port dialog**

2. Click the **Interface Type** pulldown menu to display the available transactors. Select the transactor or protocol to use for your design; the example (Figure 4-18) selects an **AXI_Flowthrough_Master** transactor.

![Selected Transactor in SoC Designer Transaction Port dialog](image)

**Figure 4-18 Selected Transactor in SoC Designer Transaction Port dialog**

By default, Model Studio selects the most likely RTL ports to be mapped to the transactor or protocol ports in the **Potential Matches** column. It does this by matching the name of the port to the RTL port. Refer to the transactor’s or protocol’s user manual for pin names.
3. Use the following options to complete the mapping of RTL ports to transactor ports:
   - If your RTL pin names match the transactor/protocol pin names, and the ports are mapped correctly for your design, click Apply. The ports in the Potential Matches column move to the RTL Name column.
   - Use regular expressions to more efficiently match port names to RTL signals. Refer to “Using Regular Expression Name Matching” on page 98 for more details.
   - If the RTL ports adhere to the transactor or protocol naming convention, but have a common prefix or suffix appended to the name, use the RTL Prefix and RTL Suffix fields to identify the common prefix or suffix to use in the name matching for the port bindings.
   - Use the pulldown menu selections in the RTL Name column to select an RTL port for each transactor or protocol port.

Note: Clicking the Reset button clears the list of RTL ports if you want to restart the port mapping.

4. Click OK. The transactor or protocol is added to the Component Ports section of the tree (Figure 4-19).

![Figure 4-19 Transactor added to Component Ports section](image)

The transactor or protocol added to the Component Ports section includes its name, how it is clocked, the list of ports and their mapping to RTL ports, and the available transactor or protocol parameters (with default settings).

5. To change the name of the transactor or protocol, click on its name and type a new name.

6. If you need to change the transactor or protocol port mapping, double-click the top-level name and the Edit Connections dialog appears. From there you can change any port mappings.

Note: If you need to create and use your own transactor, see Appendix B.
Using Regular Expression Name Matching
You can use regular expressions to more efficiently map transactor or protocol ports to RTL signals:

2. On the Add Port dialog, click Advanced Matching. The Regular Expression Name Matching dialog appears (Figure 4-20).

Figure 4-20 Regular Expression Name Matching dialog

3. Click the String to test pattern with pulldown to select one of the RTL signals you want to match (Figure 4-21). This is used to test and verify your regular expression output.
4. In the Enter Regular Expression Pattern field, specify the regular expression to use (Figure 4-21). For details about using regular expressions, refer to the QT® Developer Network QRegExp Class Reference.

Figure 4-21 RTL signal and regular expression specified
5. Click **Apply**. SoC Designer applies the regular expression pattern you specified to the test string, and displays the result in the **Resulting String** field (Figure 4-22). Modify the regular expression as needed and click **Apply** until the required string results.

![Regular Expression Name Matching dialog](image)

**Figure 4-22** Resulting string

6. If necessary, assign **Prefix**, **Suffix**, or **Remove** to the captured name elements.

![Regular Expression Name Matching dialog](image)

7. Click **OK**.

The **Regular Expression Name Matching** dialog closes. SoC Designer converts each RTL signal name based on your regular expression. The converted strings are used to find poten-
tial matches for each transactor or protocol port, and displayed in the Add Port dialog (Figure 4-23).

![Add Port dialog](Figure 4-23 Matches resulting from regular expression)

8. Click Apply to make the connections shown. The ports in the Potential Matches column move to the RTL Name column.

If a transactor’s signals use multiple naming conventions, click Advanced Matching again to repeat the process. Ensure that Apply matches to unbound ports only is enabled.

### Editing Transactor Parameters

*Note: This functionality is not available for Platform Architect.*

Most transactors have parameters associated with them. These parameters appears as component parameters in the SoC Designer environment. To edit transactor parameters:

1. Under the transactor, click the plus sign next to Parameters to display the full list of parameters. Then click the plus sign next to the selected parameter to display the Value field (Figure 4-24).

![SoC Designer Component Transactor Parameters](Figure 4-24 SoC Designer Component Transactor Parameters)
2. In the **Value** field, enter the new parameter value, or select the value from a drop-down menu (Figure 4-25).

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Bus Width</td>
<td>(compile-time) integer</td>
</tr>
<tr>
<td>Value</td>
<td>32</td>
</tr>
<tr>
<td>Align Data</td>
<td>(init-time) bool</td>
</tr>
<tr>
<td>Value</td>
<td>True</td>
</tr>
<tr>
<td>Base Address</td>
<td>False</td>
</tr>
<tr>
<td>Big Endian</td>
<td>False</td>
</tr>
<tr>
<td>Data Bus Width</td>
<td>(compile-time) integer</td>
</tr>
<tr>
<td>Enable Debug Messages</td>
<td>(run-time) bool</td>
</tr>
</tbody>
</table>

The default value for a parameter is shown in regular text. Any value which has been overridden is shown in **bold** text.

3. You can right-click a parameter and select **Connect to RTL** if you want to tie an RTL input port to a transactor parameter. This removes the corresponding ESL port from the component and moves the RTL port under the transactor parameter. When in SoC Designer, setting the parameter value changes the value assigned to the RTL port.

### Adding Unused (Null) Ports

*Note: This functionality is not available for Platform Architect.*

In the event SoC Designer requires more ports than are used by your design, you can add unused ports. Unused ports comprise **Null Inputs** and **Null Outputs** and show up as ports in SoC Designer, but they do not affect the operation of the generated component.

To create Null ports:

1. In the **Ports** Toolbar, click the **Add Transactor** button. The **Add SoC Designer Transactor Port** dialog appears.
2. Select **Null_Input** or **Null_Output** from the **Transactor Type** pull-down menu.
3. Click **OK** and the transaction port is added to the **Component Ports** list.

### Transactor Clocking

*Note: This functionality is not available for Platform Architect.*

You can run a transactor at a different speed than the ESL reference clock by associating it with a Clock_Input or Clock_Generator pseudo-transactor. Follow the steps below:

1. Create and configure a Clock_Input or Clock_Generator transactor (for specific instructions see “Specifying Generated Clocks” on page 92).
2. Select the transactor in the **ESL Ports** list; for example, the AHB_Slave_T2S.
3. In the **Clocked By** field, select the **clock** pseudo-transactor that has been defined with the different clock settings (Figure 4-26).

![Component Ports](image)

**Figure 4-26 Selecting the Clock to Use for a Transactor**

**Adding Parameters to your Component**

*Note: This functionality is not available for Platform Architect.*

You can add parameters to your component that appear as object parameters in SoC Designer. You can create init-time parameters and run-time parameters. **Init-Time** parameters can be changed in the SoC Designer Canvas only. **Run-Time** parameters can be changed in the SoC Designer Canvas and at runtime during simulation.

To add a parameter in the **Component Parameters** list, follow the steps below:

1. Right-click the **Component Parameters** heading and select the **Add Parameter** option from the context menu. You can also click the **Add Parameter** toolbar button. The **Add New Parameter** dialog appears (Figure 4-27).

![Add New Parameter](image)

**Figure 4-27 Add New Parameter dialog**

2. Define the new parameter as described below:
   - Enter a **Name** for the parameter.
   - Select the **Type** for the parameter: UInt32 or Bool
   - Enter the default **Value** for the parameter.
   - Select the **Scope** of the parameter: Init-Time or Run-Time.
   - Enter a **Description** for the parameter.

3. Click **OK** and the new parameter is added to the **Component Parameters** list (Figure 4-28).

![Component Parameters](image)

**Figure 4-28 New Parameter**

*Note: The new parameters you add can also be used in user code. See “Example of adding Debug Bypass Code to a source file” on page 125 for more information.*
Connecting Parameters to Ports

Note: This functionality is not available for Platform Architect.

Component parameters can be tied to an RTL input port or to an ESL port. When tied to an:

- RTL port — The ESL port to which it was connected is removed from the component visibility, and the value can be changed only in Component Parameters in SoC Designer.
- ESL port — The value can be changed in Component Parameters in SoC Designer, and it can be changed by connecting the ESL port. In this case, the parameter value is used whenever the ESL port is not connected. If the port is connected, the connection value takes precedence over the parameter value.

Note: See “Editing Transactor Parameters” on page 100 for information about connecting transactor parameters to RTL input ports.

To connect a parameter to an RTL input port:

1. Right-click the parameter name and select Connect to RTL from the context menu (Figure 4-29).

   ![Component Parameters](image)
   
   Figure 4-29 SoC Designer Component Parameters

   This displays a list of the available RTL input ports to which the parameter can be connected in the Choose RTL Signal dialog (Figure 4-30).

   ![Choose RTL Signal](image)

   Figure 4-30 Choose RTL Signal dialog
2. Select the signal from the list and click OK, and the RTL port is moved from the Component Ports section to the Component Parameters section (Figure 4-31).

![Component Parameters](image)

**Figure 4-31** SoC Designer Component Parameter Mapped to RTL Port

To connect a parameter to an ESL port:

1. Right-click the ESL port name and select Connect to Parameter from the context menu, and then select the existing parameter (Figure 4-32).

![Component Parameters](image)

**Figure 4-32** Connecting ESL Port to SoC Designer Component Parameter

2. The parameter appears under the name of the ESL port (Figure 4-33).

![Component Parameters](image)

**Figure 4-33** SoC Designer Component Parameter Mapped to ESL Port

*Note:* The parameter name does not need to be the same as the port name, but it can be useful for the user in SoC Designer to know that both methods can be used to affect the port value.

### Using C-Expressions to Modify Port Connections

By default, the signal applied to the ESL port or transactor port in SoC Designer is transmitted unchanged to the Cycle Model’s RTL port. You can use C-expressions to create a more complex connection between the ESL and RTL ports as follows:

1. Highlight an ESL input or output, or a transactor input or output, in the Component Ports list.

2. Right-click and select Add Port Expression from the context menu. The Port Expression field appears below the port (Figure 4-34).

![Component Parameters](image)

**Figure 4-34** Adding a Port Expression
3. Type any valid C-expression that references the port by its ESL name in the **Port Expression** text input field.

If the connection is an RTL output and ESL output, the port expression modifies the RTL output data before writing it to the ESL port. For the other direction, the port expression modifies the ESL input value before writing it to the RTL input port.

**Examples of Port Expressions**

Port expressions provide a mechanism to transform a signal port value between the ESL environment and the Cycle Model. The transform is expressed as a C-expression based on the ESL port name.

*Note: Currently, port expressions can only be used on ports that are 64-bits wide or smaller.*

- To invert the sense of a signal named `interrupt`, type in a port expression:
  ```
  ! interrupt
  ```
- To right-shift an address by two, type:
  ```
  address >> 2
  ```
- To shift the data by a constant amount; e.g. to shift the data right by two bits before transferring it:
  ```
  my_esl_port >> 2
  ```
- To tie off the transactor or port:
  ```
  1
  ```
- To change encoding from packed to one-hot:
  ```
  1 << my_esl_port
  ```
- To change encoding from one-hot to packed, call a function in the C-expression:
  ```
  log2(my_esl_port)
  ```

The name used in the port-expression text must match the ESL port name.

Apply port expressions to signal inputs or outputs. When used on an:

- **Input** — The transformation is made after reading the signal value from the ESL environment and depositing it in the Cycle Model.
- **Output** — The transformation is made after reading the signal value from the Cycle Model and driving it into the ESL environment.
Using Functions in Port Expressions

To use a function in a C-expression, add the code for the function to the User Code section of the component integration output files. An example user code section for the port expression log2(my_esl_port) is shown here:

```c
// CYCLE MODEL USER CODE [POST INCLUDE] BEGIN
MxU32 log2(MxU32 value)
{
    MxU32 result = 0;
    while (value != 0)
    {
        ++result;
        value >>= 1;
    }
    return result;
}
// CYCLE MODEL USER CODE END
```

Error Checking

The component generator does limited error checking on a C-expression. If any invalid C syntax or invalid identifiers are detected, these are labeled as “invalid signals” in the ESL port list. However, signals labeled as invalid can still be saved.

It is legal to call an external function in the C-expression; however, the Cycle Model Studio labels the function as an “invalid signal.” As long as a valid path to the function is included in the C-expression, the expression is valid and you can ignore the warning.
4.2.2.2 Registers Tab

The **Registers** tab, shown in Figure 4-35, manages a programmer’s view of logical registers inside the RTL. These registers are accessible from the component through the CADI debug interface of SoC Designer or Platform Architect.

For Platform Architect, the available columns are: Offset, Name, Width, Endian, Description, and Fields.

![Figure 4-35 SoC Designer Component Registers Tab](image)

The mapping of logical registers to RTL is controlled by Cycle Model Studio. Each logical register is divided into one or more fields spanning a subrange of the register’s width. Each of these fields can be mapped to one of the following:

- A vector or scalar register in the design hierarchy, or a bitselect/partselect of that register
- A constant index into a 2-D array of registers in the design hierarchy, or a bitselect/partselect of that indexed element
- A constant literal

This section discusses:

- Registers Tab Composition
- Adding a Register
- Setting the Base Address Parameter
- Configuring Register Fields
- Binding a Field to a Constant Value
- Binding an RTL Signal to a Register
Registers Tab Composition

The Registers tab comprises three panes:

- **Register Pane** — Displays a list of the logical registers and their attributes. You can create any number of registers.

- **Field Pane** — Displays a list of the current register fields and their attributes. Any number of fields can be added, provided their ranges are non-overlapping.

- **Design Hierarchy Pane** — The lower left subpane displays the module hierarchy of the current design. When a module instance is selected, the right subpane displays all the signals within that instance. The size of each signal is displayed, along with additional properties indicating whether the net is visible and/or depositable.

A net needs to be visible to be used in a component register. Nets displayed in red are not visible. Nets displayed in blue and labeled Visible (sampled) are visible, but are read in an inefficient manner. To fix each of these issues, use the `observeSignal` directive when compiling the design with Cycle Model compiler. Similarly, only signals that are labeled Depositable can be written with new values through the component register interface. The `depositSignal` compiler directive can be used to ensure this.

Adding a Register

To add a new logical register:

1. On the Register tab, click **Add Register**. A new row is added to the Register pane.
2. Double-click the appropriate cell of the table to edit the register’s attributes. For SoC Designer, this includes the Register Name and Group. These fields are used by SoC Designer for grouping and displaying the register.
3. Additionally, you can access registers defined for the component through the debug ports of a protocol slave transactor. To gain access to the register, specify an Offset and a Port (SoC Designer only) to use to access the register definition.

Setting the Base Address Parameter

*Note: This functionality is not available for Platform Architect.*

The base address parameter is used by SoC Designer to determine the base address when loading virtual registers in the Fast Models dialog. This needs to be specified if you are planning to use Swap & Play with a custom interconnect component.

By default, SoC Designer uses the address specified by the PERIPHBASE parameter. If you plan to use an address other than PERIPHBASE for the register’s base address, specify the address in the Base Address Parameter field.

To set the base address parameter, select the appropriate parameter from the **Base Address Parameter** menu. This menu is populated with component parameters that have been defined as integers (see “Adding Parameters to your Component” on page 102).

Alternatively, you may enter the base address as a hexadecimal value.
Configuring Register Fields
To configure register fields:

1. Click to select a register. The Field pane displays the current list of fields. Initially, each register has a single field spanning its entire width.

2. In the Bits column, click to edit the range of a field within the logical register.

3. In the Access column, click to edit the field’s read/write access.

4. Click the Add Field button to add a new field (provided there are bits in the register not covered by an existing field).

Binding a Field to a Constant Value
To bind a field to a constant value:

1. Select the field and click Bind to Constant.

   The Bind Constant dialog appears (Figure 4-36).

   ![Figure 4-36 Bind Constant dialog](image)

   In the Value field, enter the hex value and click the OK button.
Binding an RTL Signal to a Register

You can bind signals to registers and edit their parameters as needed.

To bind a register field to an RTL signal:

1. Drag a signal from the Design Hierarchy view to the Register pane (Figure 4-37).

The signal is added to the top of the Register pane, and the field within the signal is added to the bottom of the Register pane.

2. Click any cell to edit that parameter.

3. If the signal is a 2-D array, specify the Memory Index to use for the field’s value.

4. For both arrays and vectors, edit the Source column to specify a bitselect/partselect of the signal’s value, for example [31:0]. The Notes column indicates an unbound field or conflicting width value between the bound RTL entity and the field.
4.2.2.3 Memories Tab

The Memories tab, shown in Figure 4-38, allows you to define debug visibility into RTL memories during system simulation. Use this tab to make memories accessible during validation or to specify a file to load into the memory during validation.

![Figure 4-38 SoC Designer Component Memories Tab](image)

The following sections discuss these tasks:

- Disabling Automatic Memory Checking
- Adding a Memory
- Working with Non-Byte-Aligned Memories
- Deleting a Memory
- Modifying Memory Parameters
- Changing the Memory’s Max Address
- Specifying System Address Mapping for Slave Transactors
- Creating Custom Code Sections
- Creating Blocks within Memories
- Specifying the Disassembler
- Creating Disassembly Views
- Creating Subcomponent Views
Disabling Automatic Memory Checking

By default, when you add memories or make changes using the Memories tab, Cycle Model Studio performs validation and checks on your choices. Normally you do not notice any performance lag unless you are working with many memories or the memories are large.

If you notice a performance lag or if you are making many changes and prefer to wait for checking to occur until after you have made the changes, you can temporarily disable the checking by deselecting the Automatically Check Memories option at the top of the Memory tab shown in Figure 4-39.

![Automatically Check Memories Option](image)

Figure 4-39  Automatically Check Memories Option

After you have completed your changes, re-enable automatic memory checking to make sure that no problems have been introduced by your changes.

Adding a Memory

To add a memory:

1. In the Design Hierarchy pane, select a memory instance. (If the Design Hierarchy pane is not visible, choose View > Design Hierarchy from the main menu. Make sure that the top module is selected in the Module pane.)

2. Drag the instance to the Memories window, as shown in Figure 4-40.

To specify the memories to be observed during simulation individually, or all at once:

- **Individually.** Highlight individual memories in the Nets list of the Design Hierarchy pane. Highlight one memory at a time and drag it to the Memories box in the main Memories tab window, dropping it where you want it to appear in the list (see Figure 4-40).
  
  — or —

- **All at once.** Click the Add All Memories button. This button searches through the RTL design and adds all the memory instances to the Memories pane.

*Note: The memory must be Visible to be added to the list. It cannot be shown in red color, which means 'not visible'.*
Working with Non-Byte-Aligned Memories

Note: This section applies to SoC Designer components only.

SoC Designer component memories must be represented in byte-aligned Minimum Addressable Unit (MAU) format. MAU is the minimum size of data (in bits) that can be accessed.

This section describes how to display a Cycle model that has a non-byte-aligned memory width (for example, 11 bits) as SoC Designer component memory.

To support non-byte-aligned Cycle model memories as SoC Designer component memories, the SoC Designer Wrapper must pad the memory word size to a byte-aligned size.

To pad the SoC Designer component view of the memory:

1. In Cycle Model Studio, access the Memories tab for the SoC Designer wrapper.
2. Increase the "word size in bits" value to a byte-aligned value by clicking on the value in the Id/Value column and entering the new value (see Figure 4-41).
For example, if your memory has an 11-bit data width, increase the "word size in bits" from 11 to 16.

*Note:* Padding the SoC Designer component view of the memory does not impact the Cycle model's memory functionality or actual width. It impacts only the SoC Designer component memory view, including SoC Designer read and write debug accesses to the memory. That is, when you view the component's memory in SoC Designer, the padded values are shown.

If you load the memory using the MxScript `CADIMemLoadFromFile()` function or the sdsim GUI option Write memory image, you must use byte-aligned padded values in the file being loaded to the memory.

If the SoC Designer wrapper does not properly pad a Cycle model memory being displayed as SoC Designer component memory, sdsim displays a warning similar to the following when viewing the memory:

```
WARNING :: sdsim does not support non-byte aligned MAU (sys_memtop.mem-top:mem, bits per MAU=11)
```
Deleting a Memory

To remove a memory from the list, highlight the memory and click the Delete button. If you have clicked the Delete button by mistake, click Undo to add the memory back.

Modifying Memory Parameters

You can change a memory’s parameter by selecting it (click underneath the id/Value column) and changing the value there. Figure 4-42 shows the parameters that are currently available.

If a parameter appears dimmed (grey), it indicates that the parameter is read-only. Whether a parameter is editable or not depends on the memory; a parameter that is editable in one memory might not be editable in another.

Changing the Memory’s Max Address

Each memory is assigned a maximum address by default. The Max Address is the base address of the component and the address offset into the component. If you have more than one memory to preload in a component, the base addresses of the memories cannot overlap. In other words, the base address and the max address of the memory cannot overlap with another memory for the selected slave transactor.

Currently, only 32-bit wide memories are supported. The memories are assumed to be byte-addressable. Therefore, when loading the component, the address passed into the load function
is shifted by 2 bits to calculate the address for the memory to be loaded. The 2 bits are used to select the byte in the word of the memory.

To change or view the Max Address, expand the General heading.

**Specifying System Address Mapping for Slave Transactors**

*Note: This functionality is not supported for Platform Architect.*

You can instruct the program that is loaded into the SoC Explorer environment to initialize the memory through one or more slave transactors. In previous versions of Cycle Model Studio, you were allowed to specify a single slave T2S (Transactor-to-signal) transactor. You are no longer restricted to either a single slave transactor nor the T2S type, but the transactor must be a slave transactor.

To specify System Address Mapping, expand the System Address Mapping heading.

**Creating Custom Code Sections**

When you compile the component for SoC Designer, Cycle Model Studio generates a C++ header file and source file that contain the generated code that represents the implementation. You can add your own C++ code using the Class, Constructor, Destructor, Read, and Write sections, and include pre-condition and post-condition processing. For example, you might add custom code that specifies how to initialize a memory component during initialization.

To add custom code, expand the Custom Code Sections heading, as shown in Figure 4-43.

![Figure 4-43 Adding Custom Code](image-url)
Creating Blocks within Memories

Blocks allow you to group memory units together.

To create a new block:

1. Right-click **Blocks** and choose **Add Block**.
2. Edit the following fields as required.
   - **Base Address** — This allows you to specify the base address of the component and the address offset into the component. If you have more than one memory to preload in a component, the base addresses of the memories cannot overlap. In other words, the base address and the max address of the memory cannot overlap with another memory for the selected slave transactor.
   - **Size** — Currently, only 32-bit wide memories are supported. The memories are assumed to be byte-addressable. Therefore, when loading the component, the address passed into the load function is shifted by 2 bits to calculate the address for the memory to be loaded. The 2 bits are used to select the byte in the word of the memory.
   - **Custom Code Sections** (see “Creating Custom Code Sections” on page 116 for more information).

The **Locations** section displays the following information under **RTL Path** (the path to the RTL code from the top-level module):

- **Display** — Start Word Offset, End Word Offset, Least Significant Bit (LSB), and Most Significant Bit (MSB).
- **RTL** — Start Word Offset, End Word Offset, Least Significant Bit (LSB), and Most Significant Bit (MSB).

Specifying the Disassembler

*Note: This functionality is not supported for Platform Architect.*

To specify the name of the disassembler to use to display the disassembly view in SoC Designer:

1. Click **Disassembler**.

![Figure 4-44  Specifying the Disassembler](image)

When a box appears in the **Id/Value** column (Figure 4-44), enter the name of the class to be used to disassemble the memory. The source code that contains this class must be specified as part of the project in the **SoC Designer Component Properties** page (see “Setting Compiler and Linker Flags” on page 87).

*Note: All the memories in a subcomponent must use the same disassembler. (See “Creating Subcomponent Views” on page 118 for information on subcomponents.)
Creating Disassembly Views

Previous versions of Model Studio referred to creating “disassembly views.” This terminology has changed. The view is now called a SubComponent view, as described in the following section (Creating Subcomponent Views).

Creating Subcomponent Views

Note: This functionality is not supported for Platform Architect.

If you have multiple memories within your Cycle Model, you can group them into subcomponents. You can then use the subcomponent as a single debug interface for the group of memories.

To create a subcomponent view:

1. Click the Add a Subcomponent button. A subcomponent row is added to the Memories list as shown in Figure 4-45.

2. Drag memories into the area labeled drop new memories here.

3. Define a disassembler for the subcomponent. (See “Specifying the Disassembler” on page 117 for instructions.)

Note: All of the memories in the subcomponent must use the same disassembler.
4.2.2.4 Profile Tab

*Note: This tab is available only for SoC Designer components.*

Use the **Profile** tab, shown in Figure 4-46, to facilitate the measuring of events internal to a Cycle Model, and display them graphically with SoC Designer. The profiling mechanism is organized into **streams, channels, and buckets**. You control when and how the output displays during SoC Designer profiling by defining **control statements** for the streams’ triggers, channels, and buckets.

![Figure 4-46 SoC Designer Component Profile Tab](image)

**Streams, Triggers, Channels, and Buckets**

A **stream** is a collection of nets that form a logical entity whose values are measured and displayed during simulation. Streams can have multiple triggers that control when their channels are activated at simulation time in the SoC Designer environment. Streams consist of one or more channels and can view one or more RTL nets.

A **trigger** is a boolean C expression that determines when SoC Designer records data values for each of the stream’s channels.

A **channel** represents a single simulation event value that you wish to measure. When its trigger is activated in SoC Designer, the channel’s data is displayed graphically. To display the data as:

- Integers — Set up a channel controlled by a filter (C) expression. The filter expressions generally return the value of a specified net, but can also return the value of a computation involving more than one net.
- A set of discrete symbolic values in a color-coded bar graph — Set up a channel with **buckets**. Each bucket has a boolean C expression to determine which of the channel’s buckets are active at any given time. SoC Designer checks buckets in sequence; the first bucket expression to return a non-zero value results in a profiling event.
Expressions control the output of a stream, channel, or bucket:

- Trigger expressions are boolean C expressions that trigger a stream to record data values for its channel; for example: `posedge (clk)`.
- Integer channel filter expressions can be C expressions that return an integer; for example: `HSIZE`.
- Bucket channel expressions are boolean C expressions; for example:
  
  - `VectAddr > 8` (green)
  - `VectAddr > 16` (blue)

**Creating Streams**

To create a stream:

1. Click **Add Stream** to add a stream to the profile list.
2. Edit the stream’s name in the **Name** field.
3. Define the nets belonging to a stream:
   - Open the Design Hierarchy view and select a module from the **Modules** list.
   - Select nets, one at a time, from the **Nets** list, and keeping the left mouse button depressed, drag-and-drop the nets from the Design Hierarchy to the **Nets** section of the desired stream (see Figure 4-47).

Figure 4-47  Drag Nets to Stream in Profile Tab
Defining the Triggers

To define a trigger control expression for a stream:

1. Highlight the desired Trigger expr line in the Profile Streams list.
2. In the Expression text entry field, enter a boolean expression that involves at least one of the nets in the stream.
3. To define multiple triggers for a stream, click the Add Trigger button.
4. Specify a different triggering expression for each added Trigger in the Expression field.

Note: In the control expressions, use the net name only, do not use the full path name.

Setting Up Channels and Buckets

Figure 4-48 illustrates setting up channels and buckets in the Profile tab.

Note: SoC Designer requires that every stream contain a bucket channel, so you must add at least one bucket channel to each stream.

Figure 4-48 Set Up Channels in Profile Tab

To set up channels:

1. Highlight any trigger in the stream.
   By default, each trigger contains one integer, or filter expression, channel. You can keep this as an integer channel (and add other channels if you wish) or change this to a bucket channel by highlighting it and clicking the Add Bucket button.
2. To add more channels to the stream, click the Add Channel button to add additional channels to that stream.

Note: Each new channel is added under every trigger in the stream; in other words, every trigger activates the same set of channels.
3. If desired, change the channel’s name in the **Name** text entry field.

4. For integer channels, type a net name or a computation involving more than one net in the **Expression** text entry field.

5. For channels containing a set of discrete buckets:
   - Click **Add Bucket**. You can add multiple buckets to the channel.
   - Type a boolean control expression for that bucket in the **Expression** text entry field. This expression defines when that bucket is active.
   - Change the display color of the bucket as desired in the right-hand pull-down menu. Note that while the Cycle Model Studio automatically assigns a different color to each bucket, you can override these settings as desired. If none of the bucket conditions are met, an event on a default OutOfRange bucket is generated; these events appear in red.

### 4.2.2.5 Control Expressions

Control expressions for triggers, channels, and buckets are based on nets contained in their stream. Control expressions are C-expressions and can include C operators and the functions `posedge<net>`, `negedge<net>`, and `changed<net>`. The type of C-expression used depends on the entity being controlled:

- Trigger expressions are boolean.
- Integer channel expressions are integers.
- Bucket channel expressions are boolean.

### 4.2.3 Recompiling the Model

After you have defined all the specific settings for your component using the **Component Editor**, you need to recompile your project. Click the **Compile** button at this point to generate the updated files to be used with your component.
4.2.4 Generated Output Files for the SoC Designer Component

This section describes the output files associated with a Cycle Model Studio component—the configuration file, source files, make files, and component file (see Figure 4-49).

![SoC Designer Component Output Files Diagram]

Figure 4-49 SoC Designer Component Output Files
4.2.4.1 Configuration Files

A configuration file, *.ccfg, is the first of several intermediate files generated by Cycle Model Studio. This file can be used:

- By users who are migrating to Cycle Model Studio from the SOC-VSP tool. Use this file as input for a run of the Cycle Model Studio, allowing you to make additional modifications to the component.
- By the Cycle Model Studio to create the customizable source files and Makefile, which are used to generate the component.

4.2.4.2 Makefiles

The Cycle Model Studio generates a Makefile for the following platforms:

- Linux: Makefile.<config-file>.mx
- Windows: Makefile.<config-file>.mx.windows

These Makefiles use the source *.cpp and *.h files to create the component.

4.2.4.3 Customizing Component Source Files

You may want to customize a component prior to passing it to SoC Designer. For example, you might add an SoC Designer API call to activate readDbg or writeDbg for a slave port, or include debug bypass code for a component (see the example below).

To customize the component, edit the component source files (*.cpp or *.h). By default, the source files take the name of the top-level module in your design. However, if you changed the Component Name field on the Cycle Model Studio’s Properties Tab, these files use the new name.

Review the following important rules before making any changes to component source files:

- You must make all edits inside an existing Cycle Model User Code section of these files. This ensures that Cycle Model Studio retains your edits when you re-run the Cycle Model Studio using the configuration file. User-created Cycle Model User Code sections are not retained.
- Do not move the source files from the output directory.
- Empty Cycle Model User Code sections or sections containing white space are ignored. Any Cycle Model User Code sections that are unused during component generation are appended to the end of the generated source in an #if 0 block and a warning is generated.
- If compile or link flags are needed, enter the relevant paths in the Model Studio General Properties tab (see “Setting Compiler and Linker Flags” on page 87).
- Editing these files requires familiarity with the SoC Designer API. Refer to the ESL API Developer’s Guide (Arm DUI1090) for information on how to customize these files.
To customize the component:

1. Edit the `mx.<component>.cpp` and/or `mx.<component>.h` files
2. Re-run the Make process at the command prompt:
   
   For Linux platforms — `make -f Makefile.<config_file>.mx`
   
   For Windows platforms —
   
   `nmake /F Makefile.<config_file>.mx.windows`

**Example of adding Debug Bypass Code to a source file**

The following code is an example of adding customized code to the *Cycle Model User Code* section, inside the method `CompName::debugAccess`. The example shows a 4x4 matrix that forwards transactions based on the address map defined:

```c
// CYCLE MODEL USER CODE [PRE compName::debugAccess] BEGIN
if ((addr >= 0x00000000) && (addr <= 0x0fffffff))
{
    return (AXI_Flowthru_Master_CarbonAxiFS2T->debugAccess(dir, addr,
                 numBytes, buf, numBytesAccepted, ctrl));
}
if ((addr >= 0x10000000) && (addr <= 0x1fffffff))
{
    return (AXI_Flowthru_Master_1_CarbonAxiFS2T->debugAccess(dir, addr,
                 numBytes, buf, numBytesAccepted, ctrl));
}
if ((addr >= 0x20000000) && (addr <= 0x2fffffff))
{
    return (AXI_Flowthru_Master_2_CarbonAxiFS2T->debugAccess(dir, addr,
                 numBytes, buf, numBytesAccepted, ctrl));
}
if ((addr >= 0x30000000) && (addr <= 0x3fffffff))
{
    return (AXI_Flowthru_Master_3_CarbonAxiFS2T->debugAccess(dir, addr,
                 numBytes, buf, numBytesAccepted, ctrl));
}

// CYCLE MODEL USER CODE END
```

**Note:** Implementation note for Debug Bypass Code: If overlapping memory regions exist for two ports, debug bypass code is necessary on only one of the ports.
4.2.4.4 Adding a Component to the SoC Designer Model Library

Cycle Model Studio creates a configuration file that can be used to add the generated component into the model library of SoC Designer. To add the component to the model library from SoC Designer:

1. Select File > Preferences.
2. Click on Component Library in the list on the left.
3. Under the Additional Component Configuration Files window, click Add.
4. Select either maxlib.lib<model_name>.conf (Linux) or maxlib.lib<model_name>.windows.conf (Windows) depending on your platform.
5. Click OK.
6. If you want to save the preferences permanently click OK & Save. To save them for the current session only, click OK.

The component is now available from the SoC Designer Component Window.

4.2.4.5 SoC Designer Component Files

The component file is the final output file from the Cycle Model Studio and is the input to SoC Designer. The Cycle Model Studio generates two versions of the component; an optimized release version for normal operation and a debug version.

On Linux the debug version of the component is compiled without optimizations and includes debug symbols for use with gdb. The release version is compiled without debug information and is optimized for performance.

On Windows the debug version of the component is compiled referencing the debug runtime libraries, so it can be linked with the debug version of SoC Designer. The release version is compiled referencing the release runtime library. Both release and debug versions generate debug symbols for use with the Visual C++ debugger on Windows.

Linux and Windows debug versions all define the macro CARBON_DEBUG when compiled. The CARBON_DEBUG macro can be used to filter debug messages or other code that should only be run when executing the debug version of the component.

The name of the component libraries are:

- 
  * lib<model_name>.mx.so and lib<model_name>.mx_DBG.so for Linux platforms
  * lib<model_name>.mx.dll and lib<model_name>.mx_DBG.dll for Windows platforms

By default, the name of the component file is the same as the name of the Project.

See the previous section for information regarding how to register your new component with SoC Designer.
4.3 SoC Designer-Specific Information

You use Cycle Model Studio to create a SoC Designer-compatible component from the Cycle Model, which includes the simulation and debugging interfaces.

Using this process, system engineers use the component in SoC Designer to build a simulatable system and perform the following tasks:

- Architectural exploration
- System and software validation and debug
- Embedded software development

Figure 4-50 shows the process flow from source RTL to component for SoC Designer.

The Component Generator enables you to:

- Specify the connection interface between your Cycle Model and SoC Designer. For example you can:
  - Choose which of your Cycle Model ports are visible to SoC Designer.
  - Insert and connect transactors, which shield many of your Cycle Model ports from SoC Designer.
  - Create unused input and output ports (null), if required by SoC Designer.
- Set the timing for the SoC Designer reference clock so that your Cycle Model’s clocks can fully exercise your design.
• Specify the internal registers and memories that you wish to observe during validation.

After you use the Cycle Model Studio to specify the settings above, Cycle Model Studio generates a component, which includes the simulation and debugging interfaces (Figure 4-51).

![Component for SoC Designer](image)

Figure 4-51 Component for SoC Designer

When the component is registered with SoC Designer, the validation engineer builds a system by connecting the component with other components via the visible input and output ports, as shown in Figure 4-52. The engineer then simulates the system, observing the exposed internal registers and accumulated profiling data.
4.3.1 Prerequisites for SoC Designer

Before you generate the component for SoC Designer, make sure you have performed the following steps:

- If they have not already been defined, set the necessary environment variables:
  
  ```
  MAXSIM_HOME = <SoC Designer installation directory>
  MAXSIM_PROTOCOLS = <SoC Designer installation directory>/Protocols
  CARBON_HOME = <Cycle Model installation directory>
  ```

- Make sure that the Cycle Model output libraries are static:
  
  For Linux: `lib<design_name>.a`
  
  For Windows: `lib<design_name>.lib`

- To ensure that the validation engineer can access important signals in the component, use the `observeSignal` and `depositSignal` directives to mark any desired registers or internal memories as observable and/or depositable.

  Mark any internal registers intended to be I/O ports in the SoC Designer component (that is, those to be connected to a transactor or to an SoC Designer port) with `scObserveSignal` or `scDepositSignal`. Be aware that this can slow down performance. See “Defining Directives and Recompiling the Cycle Model” on page 71 for more information.

- Compile your Cycle Model following the steps defined in Chapter 3. Note that the `lib<design>.syms.tab.db` file must be present during the Cycle Model Studio run to create the component, but it is not required at SoC Designer runtime.
### 4.3.1.1 Transactors

SoC Designer supports transaction-level port interfaces, but Cycle Models typically communicate at the pin level. Transaction adapters (known as Transactors) are provided to convert between several common transaction level interfaces and the Cycle Model pins.

*Note: If you are creating a model for Platform Architect, note that the term used in the GUI changes from “Transactor” to “Protocol.”*

Refer to the SoC Designer User Guide for details about the difference between transaction-based and signal-based communication in the SoC Designer environment.

The transactors you add to your component in the Cyclecomponent typically add new SoC Designer transaction ports, and hide Cycle Model ports.

For example, an AHB_Slave_T2S converts AHB transactions to signal value changes (T2S means “transaction to signal”). When you add an AHB_Slave_T2S transactor to your component in the Cycle Model Studio tool, a new SoC Designer transaction slave port is created in the component for incoming AHB transactions. You must use the Cycle Model Studio tool to connect the transactor to the appropriate Cycle Model signal ports. Each Cycle Model signal connected to the transactor is no longer exposed as an SoC Designer port.

The resulting component may be connected to a transaction master port in SoC Designer.
4.3.1.2 Component Clocking

The component generated by the Cycle Model Studio tool uses SoC Designer cycle-based scheduling. Refer to the *SoC Designer User Guide* (Arm 100996) for information about cycle-based scheduling.

The component has a clock input port named ‘clk-in’. This is an SoC Designer cycle-based clock, not an RTL signal port. The clk-in port determines how frequently the component is called to execute a cycle. For more information about clocking options, refer to “Clock Inputs and Clock Generators” on page 148.

- If you connect the clk-in port to the clock master port of another component (e.g., a CDIV clock divider), then that component determines when the component runs a cycle.
- If you do not connect the clk-in port to anything, then the component is driven by the SoC Designer reference clock, running one cycle per time unit.

The component, like all SoC Designer components, is a subclass of C++ class `sc_mx_module`. It implements the two methods `update()` and `communicate()`, which are called by the clock master to which the clk-in port is connected.

In the `communicate()` method, all output ports that have new values are driven. In the `update()` method, the Cycle Model is executed.

4.3.1.3 Clock Generation

Clock generators are supported for SoC Designer components only (not for Platform Architect components).

In SoC Designer cycle-based scheduling, there is no signal value (i.e., 1 or 0) associated with a clock slave port. The SoC Designer clock slave port is only a mechanism for configuring when the component `communicate()` and `update()` methods are invoked.

You can drive the Cycle Model clock signal ports using a Cycle Model Studio clock generator. A clock generator applies 0 and 1 signal values to the Cycle Model clock signal ports every time the component’s `update()` method is called. A clock generator may be configured to run at the same speed, faster, or slower than the SoC Designer reference clock.

*Note:* Rather than creating a clock generator, Arm recommends creating a clock input transaction and exposing the clock input port externally.

For additional information on the use of clock generators, refer to “Clock Inputs and Clock Generators” on page 148. For instructions on creating a clock generator, refer to “Specifying Generated Clocks” on page 92.
4.4 Using the Component in SoC Designer

This section describes how to set up the component in SoC Designer.

For your SoC Designer run, you need only the component. No other files are necessary.

4.4.1 Setting Component Parameters in SoC Designer

You can change the settings of all parameters in SoC Designer Canvas and of some parameters in SoC Designer Simulator. To modify the component’s parameters:

1. In the Canvas, right-click on the component and select Component Information. The Edit Parameters dialog appears (Figure 4-53).

![Figure 4-53 Edit Parameters dialog](image)

2. Double-click the Value field of the parameter that you would like to modify.

3. If a text field appears, type a new value in the Value field. If a menu choice is offered, select the desired option. The parameters of relevance to the component are:
   - Dump Waveforms
   - Waveform File
   - Align Waveforms
   - Waveform Timescale
   - ARM Cycle Models DB Path

These parameter options are explained below.
4.4.1 Dump Waveforms parameter

SoC Designer does not dump waveforms automatically. You must turn on waveform dumping by setting the Dump Waveforms parameter to True.

4.4.1.2 Waveform File parameter

To change the name of your waveform file, type a new name for the Waveform File parameter. If waveform dumping has been turned on, SoC Designer automatically writes the accumulated waveforms to the waveform file in the following situations:

- when the waveform buffer fills
- when validation is paused and when validation finishes
- at the end of each validation run

If the initial waveform created was arm_cm.vcd, the new files created after subsequent simulation resets are named arm_cm_1.vcd, arm_cm_2.vcd, etc. In your waveform viewer, you can load the waveform file and explore the behavior of the signals in the design.

The type of waveform file generated, *.vcd is determined by which file type you selected on the General Properties tab (see “Enabling Waveform Generation” on page 86).

4.4.1.3 Align Waveforms parameter

When Align Waveforms is set to “true” (the default setting), it causes the waveforms dumped from the component to be aligned with the SoC Designer simulation time. Note that the reset sequence is not included in the Cycle Model VCD/FSDB data when the waveforms are aligned because it occurs in zero SoC Designer simulation time.

If you want to capture the reset sequence for debugging, you can set this parameter to “false”. This shows the reset sequence in the created Cycle Model waveform data. However, it also means that the time shown in the Cycle Model waveforms does not match the time shown in the SoC Designer waveforms.

4.4.1.4 Waveform Timescale parameter

Select the timescale to be used in the Cycle Model waveform file using the Waveform Timescale parameter. The default is 1 ns, but you can click the Value field to display a dropdown list of available timescales values.

4.4.1.5 ARM Cycle Models DB Path parameter

SoC Designer only runs if the path to your database file is correct. This parameter is usually not necessary because the lib<model_name>.symtab.db database file is embedded by default in the Cycle Model file.

However, it is possible to generate the Cycle Model without embedding the database file (using the -noFullDB compiler option). In this case you would need to define the name and location of this file. To specify the path to the database directory, set the ARM Cycle Models DB Path parameter to the directory that contains your lib<model_name>*.db file.

The database path parameter is passed to carbonSetFilePath in the component’s init() method. For more information, see carbonSetFilePath in the Arm Cycle Model API Reference Manual (101068).
4.4.2 Special Cases

4.4.2.1 Components with Clock\_Input Pseudo-Transactors

If your component has a Clock\_Input pseudo-transactor, then any connection to the SoC Designer default clk\_in port is ignored. To avoid confusion, keep clk\_in unconnected in SoC Designer.

4.4.2.2 Using $display in Windows Environment with SoC Designer

If you use $display in a Windows environment while running SoC Designer interactively, you get the following error message:

```
<twocounter[0]> Unable to write to file stdout||stderr.
Error message is: Bad file descriptor
```

To fix this, redirect the output to a file. You can do this by invoking SoC Designer from a command prompt as follows:

```
"C:\Program Files\Arm\SoCDesigner9.5\Bin\Release\SDSim.lnk" > out.txt
```

4.4.2.3 Using Save and Restore in SoC Designer

Unlike SoC Designer, the component is not endian-neutral. Therefore, after doing a save and restore of the component in SoC Designer, the resulting MXR file cannot be moved to an operating system that uses a different byte order than your current platform.

4.4.2.4 Using Profiling in SoC Designer

When gathering profiling data on a Cycle Model that has been compiled with the -profile option, you should run SoC Designer in batch mode (see the SoC Designer User Guide, Arm 100996). Profile data collected when running the SoC Designer Graphical User Interface includes time spent waiting for user responses and thus gives skewed profiling results.

4.4.2.5 Flow-through Path Support for Signal Ports

Flow-through paths are supported automatically by executing the logic defined in the flow-through paths until they settle. The Cycle Model Compiler automatically detects when a flow-through path exists in a model compiled from RTL. It adds code to the SoC Designer component such that any inputs that are in a flow-through path:

1. Drive the signal into the RTL model.
2. Execute the RTL logic defined in the flow-through path.
3. Detect changes on any RTL outputs and drive the output to any connected components.

In general, it is recommended that any models execute such flow-through paths during the communicate phase. All SoC Designer components created using Cycle Model Studio from RTL initiate flow-through paths only during the communicate phase.
4.5 Platform Architect-Specific Instructions

Use Cycle Model Studio to create a Synopsys (formerly CoWare) component from the Cycle Model that is compatible with Platform Architect, and includes the simulation and debugging interfaces. Using this process, system engineers use the component in Platform Architect to build a simulatable system and perform the following tasks:

- Architectural exploration
- System and software validation and debug
- Embedded software development

Use the Cycle Model Studio Component Generator to:

- Load a Cycle Model database.
- Define communication interfaces to drive the design.
- Map data types and define which internal information inside the Cycle Model to export to the Platform Architect environment.
- Compile the Component and generate interfaces.

4.5.1 SystemC Modeling Language (SCML) Interface Overview

SystemC Modeling Language (SCML) is used to export internal register information and aggregate register information so that Platform Architect analysis tools can utilize internal Cycle Model information. Registers can be 32 or 64 bits and are used to export internal signals, registers, and memories for analysis, including Platform Architect’s debuggers and analysis tools.

SCML assigns a shadow register that maps to the appropriate data inside the Cycle Model. It also provides the Platform Architect environment with the ability to read internal Cycle Model data and deposit to internal Cycle Model data.

SCML information is assembled into a register/memory bank that you define. Offsets are used to specify the registers and memories that reside within the bank. A debug access mechanism is provided to update or retrieve data from these SCML objects and perform the appropriate calls to the Cycle Model API to access the Cycle Model data.

For more information on SCML, refer to the Synopsys SystemC Modeling Manual.
4.5.2 Prerequisites

Before you generate the component for Platform Architect, make sure you have performed the following steps:

- If they have not already been defined, set the necessary environment variables:
  
  COWAREHOME = <Platform Architect installation directory>
  
  CARBON_HOME = <Cycle Model Studio installation directory>
  
  COWAREIPDIR = <Platform Architect IP directory>
  
  (Optional. If not specified, then Cycle Model Studio uses $COWAREHOME/IP to identify available Platform Architect transactors.)
  
  COWAREIPLIB = <Platform Architect installation directory>
  
  (For important, version-specific instructions refer to Section 4.5.2.1, COWAREIPLIB Implementation Notes on page 137.)

- Make sure that the Cycle Model output libraries are static:
  
  For Linux: lib<design_name>.a
  
  For Windows: lib<design_name>.lib

- To ensure that the validation engineer can access important signals in the component, use the observeSignal and depositSignal directives to mark any desired registers or internal memories as observable and/or depositable.

  Mark any internal registers intended to be I/O ports in the Platform Architect component (that is, those to be connected to a transactor or to a Platform Architect port) with observeSignal or depositSignal. Be aware that this can slow down performance. See “Defining Directives and Recompiling the Cycle Model” on page 71 for more information.

- Compile your Cycle Model following the steps defined in Chapter 3.
4.5.2.1 COWAREIPLIB Implementation Notes

If you are running Synopsys Platform Architect version K-2015.06, you must do the following to enable Cycle Model Studio to emit tcl files:

1. Create a file named `cwr.lib` with the following content:
   
   ```
   INCLUDE $COWAREHOME/dmtools/data/cwr.lib
   DEFINE GenericIPtemplates GenericIPtemplates
   ```

2. Point the COWAREIPLIB environment variable to the new file.
   
   The following is an example script that shows the commands needed to properly set up the environment:
   
   ```
   setenv COWAREVERSION K-2015.06
   setenv COWAREHOME /tools/linux/CoWare/$COWAREVERSION/SLS/linux
   source $COWAREHOME/setup.csh -pa
   setenv PATH $COWAREHOME/common/bin:$PATH
   setenv COWAREIPLIB <pathwherecwr.libwasplaced>/cwr.lib
   ```

   After completing these steps, invoke Cycle Model Studio, create the component, and compile.

4.5.3 Recompiling the Model

After you have defined all the specific settings for your component using the Component Editor, you need to recompile your project. Click the Compile button at this point to generate the updated files to be used with your component.

4.5.4 Understanding the Platform Architect Component Output Files

The Cycle Model Studio Component Generator outputs several file types, including configuration, source, make, and component files. This section describes:

- Configuration Files
- Source Files
- Makefiles
- Known Issue
Refer to Figure 4-54 to review the process flow from Cycle Model to component for Platform Architect.

![Diagram](image)

**Figure 4-54 Platform Architect Component Output Files**

### 4.5.4.1 Configuration Files

A configuration file, *.ccfg, is the first of several intermediate files generated by Cycle Model Studio. This file can be used:

- By users who are migrating to Cycle Model Studio from the Platform Architect Component Generator tool. Use this file as input for a run of the Cycle Model Studio, allowing you to make additional modifications to the component.
- By the Cycle Model Studio to create the customizable source files and Makefile, which are used to generate the component.

Note: import.<component>.coware.lib.tcl is used in Platform Architect to execute script (Tools -> Execute Script).
Note: lib<component>.build.tcl is the encapsulation file used.
4.5.4.2 Source Files

If you want to customize the component prior to passing it to the Platform Architect environment, you can edit the source files (*.cpp or *.h).

1. Edit the lib<component>coware.cpp and/or lib<component>coware.h files.

   To ensure that Component Generator retains your edits if you reuse the edited source files for a future run, make all edits inside the designated User Code section of these files (see “Example of adding Debug Bypass Code to a source file” on page 125).

2. Re-run the Make process at the command prompt:

   make -f Makefile.coware.<config_file> #

4.5.4.3 Makefiles

Component Generator generates a Makefile for Linux:

Makefile.coware<config_file>

This Makefile creates the component for the Platform Architect environment.

4.5.4.4 Known Issue

When adding a transactor, the import script does not set the port direction. For example, in the script import_Twocounter.coware.tcl the port direction is specified as None, which causes a problem. The workaround is to edit the port direction in the script.

The import script of the generated component includes a line similar to the following:

::pct::add_block_port $block port None

The solution is to change the line to have the correct port type, for example:

::pct::add_block_port $block port inout
4.6 Creating Components for SystemC

Arm delivers products that allow designers to compile their synthesizable RTL into an ultra-high performance Cycle Model that can then be linked directly into a SystemC design environment. This integration provides the speed necessary to perform software validation and performance modeling while maintaining the investment already made in the SystemC environment.

A traditional approach to integrate implementation-level RTL into SystemC typically involves integrating an RTL simulator via the PLI. While this approach correctly models the implementation, it does so at a relatively slow speed. In addition, PLI introduces a substantial amount of interconnect overhead.

The process of integrating a Cycle Model into a SystemC development environment includes:

• Building the Cycle Model using the Cycle Model compiler.
• Generating a component that integrates the Cycle Model into a SystemC environment.
• Compiling the design into an executable.

Refer to the CMS Installation Guide (Arm 101106) for supported SystemC versions.

4.6.1 Prerequisites

Before you generate the component for SystemC, make sure you have performed the following steps:

• Set the environment variable SYSTEMCHOME to the base directory of your SystemC installation.
• Make sure that the Cycle Model output libraries are static:
  For Linux: lib<design_name>.a
  For Windows: lib<design_name>.lib
• To ensure that the validation engineer can access important signals in the component, use the observeSignal and depositSignal directives to mark any desired registers or internal memories as observable and/or depositable.
  Mark any internal registers intended to be I/O ports in the component (that is, those to be connected to a transactor or to a port) with scObserveSignal or scDepositSignal. Be aware that this can slow down performance. See “Defining Directives and Recompiling the Cycle Model” on page 71 for more information.
• Compile your Cycle Model following the steps defined in Chapter 3.
4.6.2 Generating the Component for SystemC

1. From the Project Explorer, right-click the Cycle Model to display the context menu.
2. From the context menu, select **Create SystemC Component**. You can also click the **SystemC** button on the Button bar.

The new component and its associated output files are displayed in the **Project Explorer** (Figure 4-55).

![Figure 4-55 Component for SystemC in Project Explorer](image)
4.6.2.1 Using the Component Properties View

Use the Component Properties view (Figure 4-56) to view the SystemC component properties, including:

- Component top module name.
- Force Update — Specifies that calls to `sc_prim_channel::request_update` are forced for all input changes. If this is not specified, `request_update` is called only for clock, reset, and feed-through inputs.
- Module Name — By default the SystemC module name is the same as the top module name. You can enter a unique name to be used for the SystemC module that is generated.
- Database (*.db) file location.
- Output directory.

![SystemC Component Properties](image)

**Figure 4-56 SystemC Component Properties**
4.6.2.2 Using the Ports Window for SystemC

The Ports window for SystemC provides tabs to access ports. Double-click the .ccfg file in the Project Explorer to display the Ports Editor (Figure 4-57).

![Ports Window for SystemC](image)

This window is very similar to the one used for creating components for SoC Designer except for the following differences:

- The Ports window for SystemC does not contain the following:
  - Transactor, Add Transactor, Add Parameter feature
  - Registers or Memories tabs
  - Profile tab
  - Generated resets (Reset Generators section)
  - “Connect to Parameter” option when right-clicking an RTL port
  - Ability to add parameters to your component
  - Ability to add unused (null) ports

- The Ports window for SystemC contains two columns that the SoC Designer view does not:
  - Mode — Not used in this release.
  - Type — Specifies the SystemC type to be used. The default SystemC type is based on the size, type, and direction of the RTL port. (The size element of the SystemC type is determined automatically from the RTL port size.) You can select a different type from the pulldown menu.

- The Clock Generators for the SystemC Ports window use the SystemC sc_clock primitive to generate the clock values. (See the SystemC reference manual for details about the sc_clock parameters.) The parameters are:
– Initial Value (Low or High)
– Start Time (double)
– Start Time Units (SC_FS, SC_PS, SC_NS, SC_US, SC_MS, SC_SEC)
– Duty Cycle (double)
– Period (double)
– Period Time Units (SC_FS, SC_PS, SC_NS, SC_US, SC_MS, SC_SEC)

For more information on using the Ports window for SystemC, see “Ports Tab” on page 89. That section refers to SoC Designer, but for SystemC, the tool is the SystemC simulator.

### 4.6.3 Recompiling the Model

After you have defined all the specific settings for your component using the Ports Editor, you need to recompile your project. Click the **Compile** button at this point to generate the updated files to be used with your component.
Appendix A

Arm-supplied Transactors for SoC Designer

This appendix describes the transactors and other entities that are listed in the Transactor Type pulldown list in the SoC Designer Ports tab. These entities fall into the following categories:

- **Pseudo-transactors.** These are not transactors, but they create port connections on the component. These include null ports, interrupt translators, reset inputs, and clock_inputs and outputs (see “Pseudo-Transactors” on page 146).

- **Transactors that are external to the Cycle Model.** This includes the AMBA transactors. Use Cycle Model Studio to add these transactors and their transaction ports to the component and connect their signals to the RTL signals (see “Transactors that are External to the Cycle Model” on page 159).

In addition, you can write your own transactor and use Cycle Model Studio to connect it to a Cycle Model. See Appendix B, User-Defined Transactors with SoC Designer for more information.
A.1 Pseudo-Transactors

For convenience, the Cycle Model Studio includes a few entities in its Add Xtor pulldown list that are not transactors. These items include:

- Null Ports (Null_Input and Null_Output)
- Interrupt Translators (Interrupt_Master and Interrupt_Slave)
- Clock Inputs and Clock Generators
- Reset Inputs

A.1.1 Null Ports

Null_Input
This creates a component input port that is not connected to an RTL signal. This is useful when the component being generated must have the same ports as another component, even if some of the input ports are not used by the Cycle Model.

Null_Output
This creates a component output port that is not connected to an RTL signal. This is useful when the component being generated must have the same ports as another component, even if some of the output ports are not used by the Cycle Model.

A.1.2 Interrupt Translators

Arm supplies Interrupt_Slave and Interrupt_Master pseudo-transactors to translate SoC Designer interrupt signals to RTL interrupt signals. These entities are not true transactors as they lack transaction ports.

![Figure A-1 Interrupt_Slave and Interrupt_Master Translators](image-url)
**Interrupt_Master**

This is a master port that tells which interrupt signal was triggered. It receives up to 32 RTL interrupt signals and transmits that information out through its master signal transaction port. The Interrupt_Master uses the following convention:

- Each RTL signal connected to the Interrupt_Master has an ‘id’ parameter giving the signalNumber associated with the RTL signal.
- When the RTL signal is driven, the Interrupt_Master port’s driveSignal method is called with this convention:
  
  ```
  driveSignal(signalNumber, &rtlSignalValue);
  ```

  `signalNumber` is from the ‘id’ parameter. This can be set to -1 to disable the interrupt for the specified signal.

  `rtlSignalValue` is the value coming from the Cycle Model.

**Interrupt_Slave**

This is a signal slave port that drives RTL interrupt signals to the Cycle Model. The number of interrupt signals is automatically set based on the number of pins detected.

Each RTL interrupt signal maintains its state until driven by a new call to the Interrupt_Slave’s driveSignal method. The RTL interrupt signal is specified by the first parameter in the driveSignal method. The value to which the signal is set is specified by the second parameter, as follows:

```
driveSignal(signalNumber, &setOrClear);
```

`signalNumber` is the bit number of the RTL signal to modify.

`setOrClear` is 1 or 0.

For example:

```c
int value = 0;
port->driveSignal(3, &value); // clear interrupt 3
value = 1;
port->driveSignal(4, &value); // set interrupt 4
```

The above code clears bit 3 and sets bit 4 of the RTL signal value.
A.1.3 Clock Inputs and Clock Generators

This section describes the two available clocking mechanisms — clock_inputs and clock_generators — and when to use them.

- Clock_input
- Clock_generator
- Clock-related Parameters
- Clock_output

A.1.3.1 Clock_input

A Clock_Input creates a component input port that you can use to clock a component data port. It is used to drive an RTL clock input of the Cycle Model, and/or control the update frequency of a transactor. Clock_inputs create a 1:1 pulse-to-cycle ratio. To specify a slower frequency, use a CDIV (clock divider).

For instructions on creating a:

- Clock_input — Refer to “Adding Transactors and Other Interface Entities” on page 95.
- Clock divider — Refer to the SoC Designer User Guide (100996).
Consider the example shown in Figure A-2.

Two clock dividers (CDIV1 and CDIV2) are used in combination with clock_inputs AHBclk1 and AHBclk2. CDIV1 specifies a pulse-to-cycle ratio of 1:2, and CDIV2 specifies a pulse-to-cycle ratio of 1:3. The output clocks of each clock_input initiate a 1:1 pulse frequency to the AHBclk1 and AHBclk2 ports on the Cycle Model.

In effect, this design runs the AHBclocks at 1/2 and 1/3 the frequency of the pulse, respectively.

**Component within SoC Designer**

Figure A-2 Clock_inputs
Figure A-3 shows the waveforms generated when the CDI_S2T are used in combination with clock_inputs to run AXI clocks at the frequencies shown in Figure A-2. Note that the waveforms are generated based on the CDIV pulses, not the master SoC Designer clock pulses.

**Figure A-3  CDIVs and Clock_Inputs**

**Using the Clock_input Enable pin**

Clock_input allows RTL and transactors to be clocked synchronously; the Enable pin allows you to further refine your clocking conditions. By specifying a high or low Enable signal, in combination with code that defines your requirements, you determine the circumstances in which the RTL executes.

For example, you may want to power off/power on a device during a reset sequence. Connecting the Enable pin to an MxStub component with code that sets Enable to low at time Zero disables clocking during the reset sequence. When the reset sequence ends, the MxStub code sets Enable to high, re-enabling clocking.
To use the Enable pin:

1. Create a top-level component signal slave port to act as the Enable for the Clock_Input (in Figure A-4, user_enable is the signal slave port).

2. Connect the new signal slave port to a scalar enable input signal to the RTL. This requires the RTL to use the Enable signal to qualify execution of the RTL code. In Figure A-4, the RTL signal is named rtl_enable.

3. Drive the top-level Enable signal (user_enable in Figure A-4) from the SoCD Canvas. If the top-level Enable signal is left undriven, it defaults to Zero, so the associated transactors within the component (and the qualified RTL code) never execute.

Note: When creating a SoC Designer component wrapper, if you leave the Enable pin to the Clock_input transactor unconnected, the Clock_input transaction is always enabled, and no Enable port exists on the SoCD component.
A.1.3.2 Clock_generator

A clock_generator creates an internal clock, allowing you to specify how you want to map component cycles to clock cycles. Clock generators support the creation of various pulse intervals, so that you can create multiple frequencies for internal logic.

**Note:** When possible, Arm recommends creating a clock input transactor and exposing the clock input port externally, rather than creating a clock generator. The clock input approach tends to simplify your design.

However, the clock generator approach may be required for certain configurations. For example:

- **Memory controller with PHY and DDR** — Large ratio values are required for a CDIV-driven clock_input, due to the odd ratio clock of the PHY. This results in inefficient simulation time.
- **Non-transactor I/Os** — These ports are read and driven via the `update()` and `communicate()` methods registered to the component’s own default clock input. The RTL logic directly connected to these ports must be driven by the same clock.

In Figure A-5, the component’s input clock (clk_in) is connected to the master clock, so that the component receives periodic clock ticks from the SoC Designer master clock. You can connect multiple clock_generators to clk_in; in this example, two clock_generators produce 1:1 and 1:2 pulse-to-cycle ratios to the Cycle Model.

For instructions on creating a clock_generator, refer to “Specifying Generated Clocks” on page 92.
Figure A-5  Clock_generators
Figure A-6, below, shows the waveforms generated when clock Generators specify clock cycles that either match the component cycle (1:1 ratio) or differ from the component cycle (1:2), as shown in Figure A-5.
A.1.3.3 Clock-related Parameters

During reset, clocks are generated according to the parameters in Table A.1.

Note: The Enable element (ENABLE) that appears at the bottom of the Clock Input parameter list is in fact a pin for the transactor port, not a parameter. Refer to “Using the Clock_input Enable pin” on page 150 for information about its use.

Table A.1: Parameters for Clock_inputs and Clock_generators

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Clock_input</th>
<th>Clock_generator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Cycles&lt;sup&gt;a&lt;/sup&gt;</td>
<td>The frequency of the clock cycle.</td>
<td>Fixed at a 1:1 ratio.</td>
<td>Any ratio.</td>
</tr>
<tr>
<td>Clock Port Visible</td>
<td>Determines whether the component displays the clock slave port.</td>
<td>True or False.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Comp Cycles&lt;sup&gt;a&lt;/sup&gt;</td>
<td>The frequency of the component cycle.</td>
<td>Fixed at a 1:1 ratio.</td>
<td>Any ratio.</td>
</tr>
<tr>
<td>Delay</td>
<td>The percentage of a component cycle to delay before generating a clock. See Figure A-8 below.</td>
<td>Delay is applied at every activation.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Delay Enable</td>
<td>Determines whether changes to an enable during a cycle are applied to the next component cycle.</td>
<td>True or False.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>The percentage of the clock cycle for which the clock value is high. See Figure A-9 below.</td>
<td>0 — 99</td>
<td>0 — 99</td>
</tr>
<tr>
<td>Initial Value</td>
<td>Clock initial value.</td>
<td>Low (0) or High (1)</td>
<td>Low (0) or High (1)</td>
</tr>
<tr>
<td>Initial Delay</td>
<td>The percentage of a component cycle to delay before generating a clock. See Figure A-7 below.</td>
<td>Not supported.</td>
<td>Initial Delay is applied on initial edge only.</td>
</tr>
</tbody>
</table>

a. Clock Frequency during reset is Clock Cycles per Component Cycles.

Figure A-7 shows a waveform with a 2:1 ratio and an Initial Delay set to Fifty Percent.

![Figure A-7 Wave with an Initial Delay of 50%](image-url)
Figure A-8 illustrates a waveform with a 1:1 ratio, with Delay set to Zero percent and Fifty percent.

![Master SoC Designer Clock Pulses](image)

**Figure A-8** Wave with Delay set to 0% percent and 50%

Figure A-9 shows a waveform with a 2:1 ratio and Duty Cycle set to Twenty-Five percent.

![Clock_generator Delay set to 25%](image)

**Figure A-9** Wave with a Duty Cycle of 25%

### A.1.3.4 Clock_output

*Clock_output* creates a component output port that you can connect to a clock output of the Cycle Model.

If your Cycle Model generates an output clock, you must connect a Clock_Output to that clock. In SoC Designer, all clock slaves that are connected to the Clock_Output port are updated on every cycle on which a posedge value change is observed on the Cycle Model clock output.

For instructions on creating a clock_output, refer to “Adding Transactors and Other Interface Entities” on page 95.
A.1.4 Reset Inputs

Reset Inputs create a reset input port that you can connect in an RTL input of the Cycle Model. This transactor can be used when an automatic reset pulse is desired during the reset sequence, but also allows the ability to manually drive the reset during simulation.

![Diagram of Reset Inputs](Figure A-10 Reset_Inputs)

Table A.2 describes the Reset_Input parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active High</td>
<td>Determines whether the reset is Active High (set to true) or Active Low (set to false).</td>
</tr>
<tr>
<td>Active Value(^a)</td>
<td>Specifies a decimal value to be used when reset is active (asserted). The default is 1.</td>
</tr>
<tr>
<td>Clock Cycles</td>
<td>The frequency during the reset sequence is determined by the ratio (\text{Clock Cycles} : \text{Comp (Component) Cycles}). By default this is a 1:1 ratio.</td>
</tr>
<tr>
<td>Comp Cycles</td>
<td></td>
</tr>
<tr>
<td>Cycles After</td>
<td>The minimum number of cycles the signal remains deasserted before the reset period ends.</td>
</tr>
<tr>
<td>Cycles Asserted</td>
<td>The number of cycles during which the signal remains asserted.</td>
</tr>
<tr>
<td>Cycles Before</td>
<td>The number of cycles to wait during the reset period before asserting the signal.</td>
</tr>
<tr>
<td>Inactive Value(^a)</td>
<td>Specifies a decimal value to be used when reset is inactive (deasserted). The default is 0.</td>
</tr>
</tbody>
</table>
The Active Value parameter is the value used when asserting reset, and the Inactive Value parameter is used when reset is not asserted. Typically, the active and inactive values are the same across all cores of the model. So for example, a model with four subcores using Active Low resets would have an Active Value of 0 and an Inactive Value of 15.
A.2 Transactors that are External to the Cycle Model

The transactors described in this section exist inside the component, but outside of the Cycle Model. This includes the Arm AMBA transactors. Use Cycle Model Studio to add these transactors and connect their ports to the appropriate RTL ports in the Cycle Model.

Figure A-11 Generic Transactor External to Cycle Model

Definitions

*S2T* stands for signal-to-transaction. The Cycle component drives the transaction into SoC Designer. The Cycle component sends the transaction through the transaction master port. SoC Designer usually receives the transaction through signal slave ports.

*T2S* stands for transaction-to-signal. SoC Designer drives the transaction into the Cycle component. The Cycle component receives the transaction through the transaction slave port. SoC Designer usually sends the transaction through signal master ports.

*Arbiter*: The arbiter regulates the bus masters so that only one bus master at a time can initiate data transfer.

AHB Master_S2T|T2S, AHB Slave_S2T|T2S: The term Master or Slave that appears in the transactor name refers to the master or slave side of the AHB interface. In the next four diagrams, the AHB Master_S2T|T2S transactors appear to the left of the arbiter (the AHB master
interface has the request/grant signals). The AHB_Slave_S2T|T2S transactors appear to the right of the arbiter (the AHB slave interface does not have the request/grant signals).

Scope: The scope of each transactor parameter is one of the following values:

- **Compile-Time.** The parameter has to be set when instantiating the adaptor in Cycle Model Studio. The parameter cannot be set in the SoC Designer Canvas.
- **Init-Time.** The parameter can be changed in the SoC Designer Canvas.
- **Run-Time.** The parameter can be changed at runtime during simulation.

The following transactors are discussed in this section:

- “AHB Transactors” on page 161
- “APB Transactors” on page 181
- “APB3 Transactors” on page 184
- “AXI Transactors” on page 192
- “AXI4Stream_Master and AXI4Stream_Slave” on page 201
- “CHI Transactors” on page 202

**Note:** The AHB and AXI transactors are available in two different versions: the original version (v1), and the newer version (v2) that supports flow through. Arm recommends that you use the v2 transactors for new projects, if possible, because the non-flow-through transactors will be deprecated in a future version of Cycle Model Studio.
A.2.1 AHB Transactors

There are two variants of the AHB transactors:

- **AHB_Master_xxx** and **AHB_Slave_xxx**: These are the original AHB transactors that have been available through Cycle Model Studio for many releases.

- **AHB_Master_Fxxx/AHB_Lite_Master_Fxxx** and **AHB_Slave_Fxxx/AHB_Lite_Slave_Fxxx**: These flow-through versions of the AHB transactors (v2) should be used if the Cycle Model has flow through (asynchronous) paths in the design.

This section describes:

- **AHB_Master_S2T** and **AHB_Master_FS2T**
- **AHB_Slave_T2S** and **AHB_Slave_FT2S**
- **AHB_Master_T2S** and **AHB_Master_FT2S**
- **AHB_Slave_S2T** and **AHB_Slave_FS2T**
- **AHB_Lite_Master_S2T** and **AHB_Lite_Master_FS2T**
- **AHB_Lite_Master_FT2S**
- **AHB_Lite_Slave_T2S** and **AHB_Lite_Slave_FT2S**
- **AHB_Lite_Slave_FS2T**
A.2.1.1 AHB_Master_S2T and AHB_Master_FS2T

A transactor that converts AHB Master interface signals from the Cycle Model into transactions that are communicated through the transaction master port. S2T stands for signal-to-transaction. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

* Optional signals for Arm11 extension

Figure A-12 AHB_Master_S2T Transactor
**AHB_Master_S2T and AHB_Master_FS2T parameters**

Parameter: **Enable Debug Messages**
- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Run-time
- Description: When set to true, the adaptor outputs debug messages while running.

Parameter: **Big Endian**
- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Init-time
- Description: Affects the alignment of the data on the data bus. When true, the data is read as “big endian” on the data bus.

Parameter: **Align Data**
- Parameter Type: boolean
- Legal Values: true, false Default = false.
- Scope: Init-time
- Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to true enables aligning of the data to the correct byte lane.

*Note:* This field is no longer used, but is maintained for backwards compatibility.
A.2.1.2 AHB_Slave_T2S and AHB_Slave_FT2S

A transactor that converts AHB transactions from a transaction slave port into AHB Slave interface signals in the Cycle Model. T2S stands for transaction-to-signal. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

Figure A-13  AHB_Slave_T2S Transactor

* AHBv2 sideband signals for the Cortex-M3. For details see the *AHBv2 Protocol Bundle User Guide* or the *Arm Cortex-M3 r2P0 TRM*.

** Optional signals for Arm11 extension
AHB_Slave_T2S and AHB_Slave_FT2S parameters

Parameter: Enable Debug Messages
Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Run-time
Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Base Address (for AHB_Slave_T2S)
Parameter Type: value
Legal Values: 0 - Max Address Size. Default = 0.
Scope: Init-time
Description: Base address of the AHB Slave memory region 0.

Parameter: ahb_start1 (for AHB_Slave_T2S)
Parameter Type: value
Legal Values: 0 - Max Address Size. Default = 0.
Scope: Init-time
Description: Base address of the AHB Slave memory region 1.

Parameter: region start [0-5] (for AHB_Slave_FT2S)
Parameter Type: value
Legal Values: 0 - Max Address Size. Default = 0x0.
Scope: Init-time
Description: Base address of the AHB Slave memory regions 0 through 5.

Parameter: Size (for AHB_Slave_T2S)
Parameter Type: value
Legal Values: 0 - Max Address Size. Default = null.
Scope: Init-time
Description: Size of memory region 0.

Parameter: ahb_size1 (for AHB_Slave_T2S)
Parameter Type: value
Legal Values: 0 - Max Address Size. Default = 32.
Scope: Init-time
Description: Size of memory region 1.

Parameter: region size [0-5] (for AHB_Slave_FT2S)
Parameter Type: value
Legal Values: 0 - Max Address Size. Default = 0x100000000 for region 0
0x0 for regions 1-5
Scope: Init-time
Description: Size of memory regions 0 through 5.
Parameter: Subtract Base Address (for AHB_Slave_T2S)

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: When set to true, the Base Address is subtracted from the transaction address, and the offset is sent to the RTL port. When set to false (the default value), the transaction address is sent to the RTL port unchanged.

Parameter: Subtract Base Address Dbg (for AHB_Slave_T2S)

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: Set this parameter when using the readDbg and writeDbg members of the transactor ports. When set to true, the Base Address is subtracted from the transaction address, and the offset is sent to the RTL port. When set to false (the default value), the transaction address is sent to the RTL port unchanged.

Parameter: Big Endian

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: Affects the alignment of the data on the data bus. When true, the data is output “big endian” on the data bus.

Parameter: Align Data

Parameter Type: boolean
Legal Values: true, false Default = false.
Scope: Init-time
Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to true enables aligning of the data to the correct byte lane.

Note: This field is no longer used, but is maintained for backwards compatibility.

Parameter: Filter HREADYIN

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: AHB slaves are required to have an HREADY signal as both an input and an output. The output is the slave’s ready status, while the input is the ready status of all the slaves on the bus (presumably calculated by the bus arbiter). Setting this parameter to true filters out the input HREADY “HREADYIN” to prevent it from reaching the Cycle Model. The parameter should be set only when it is not required by the slave for correct operation.
A.2.1.3 AHB_Master_T2S and AHB_Master_FT2S

A transactor that converts AHB transactions from a transaction slave port into AHB Master interface signals in the Cycle Model. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

![Diagram of AHB_Master_T2S Transactor](attachment:figure_a-14.png)

* Optional signals for Arm11 extension

Figure A-14 AHB_Master_T2S Transactor
**AHB_Master_T2S and AHB_Master_FT2S parameters**

Parameter: **Enable Debug Messages**
- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Run-time
- Description: When set to true, the adaptor outputs debug messages while running.

Parameter: **Base Address** (for AHB_Master_T2S)
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0.
- Scope: Init-time
- Description: Base address of the AHB Slave memory region.

Parameter: **region start [0-5]** (for AHB_Master_FT2S)
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0x0.
- Scope: Init-time
- Description: Base address of the AHB Slave memory regions 0 through 5.

Parameter: **Size** (for AHB_Master_T2S)
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = null.
- Scope: Init-time
- Description: Size of memory region.

Parameter: **region size [0-5]** (for AHB_Master_FT2S)
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0x100000000 for region 0
  0x0 for regions 1-5
- Scope: Init-time
- Description: Size of memory regions 0 through 5.

Parameter: **ahbm port ID**
- Parameter Type: value
- Legal Values: 0 - Max ID of the connected arbiter. Default = 0.
- Scope: Init-time
- Description: Port ID used when sending a bus request to the arbiter.

Parameter: **Big Endian**
- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Init-time
Description: Affects the alignment of the data on the data bus. When true, the data is output “big endian” on the data bus.

Parameter: Align Data

Parameter Type: boolean

Legal Values: true, false Default = false.

Scope: Init-time

Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to true enables aligning of the data to the correct byte lane.

Note: This field is no longer used, but is maintained for backwards compatibility.
A.2.1.4 AHB_Slave_S2T and AHB_Slave_FS2T

A transactor that converts AHB Slave interface signals from the Cycle Model into transactions that are communicated through the transaction master port. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

Figure A-15  AHB_Slave_S2T Transactor

* Optional signals for Arm11 extension
AHB_Slave_S2T and AHB_Slave_FS2T parameters

Parameter: Enable Debug Messages
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Run-time
  Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Big Endian
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Init-time
  Description: Affects the alignment of the data on the data bus. When true, the data is read as “big endian” on the data bus.

Parameter: Align Data
  Parameter Type: boolean
  Legal Values: true, false Default = false.
  Scope: Init-time
  Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to true enables aligning of the data to the correct byte lane.

Note: This field is no longer used, but is maintained for backwards compatibility.
A.2.1.5 AHB_Lite_Master_S2T and AHB_Lite_Master_FS2T

A transactor that converts AHB-Lite Master interface signals from the Cycle Model into transactions that are communicated through the transaction master port. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

* Optional signals for Arm11 extension

Figure A-16 AHB_Lite_Master_S2T Transactor
AHB_Lite_Master_S2T and AHB_Lite_Master_FS2T parameters

Parameter: Enable Debug Messages
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Run-time
  Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Big Endian
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Init-time
  Description: Affects the alignment of the data on the data bus. When true, the data is read as “big endian” on the data bus.

Parameter: Align Data
  Parameter Type: boolean
  Legal Values: true, false Default = false.
  Scope: Init-time
  Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to true enables aligning of the data to the correct byte lane.

Note: This field is no longer used, but is maintained for backwards compatibility.
A.2.1.6 AHB_Lite_Master_FT2S

A transactor that converts AHB-Lite Master transactions from a transaction slave port into AHB Master interface signals in the Cycle Model. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

* Optional signals for Arm11 extension

Figure A-17  AHB_Lite_Master_FT2S Transactor
**AHB_Lite_Master_FT2S parameters**

Parameter: **Enable Debug Messages**
- Parameter Type: boolean
- Legal Values: true, false. Default = *false*.
- Scope: Run-time
- Description: When set to *true*, the adaptor outputs debug messages while running.

Parameter: **region start [0-5]**
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0x0.
- Scope: Init-time
- Description: Base address of the AHB memory regions 0 through 5.

Parameter: **region size [0-5]**
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0x100000000 for region 0
  0x0 for regions 1-5
- Scope: Init-time
- Description: Size of memory regions 0 through 5.

Parameter: **Big Endian**
- Parameter Type: boolean
- Legal Values: true, false. Default = *false*.
- Scope: Init-time
- Description: Affects the alignment of the data on the data bus. When *true*, the data is output "big endian" on the data bus.

Parameter: **ahbm port ID**
- Parameter Type: value
- Legal Values: 0 - Max ID of the connected arbiter. Default = 0.
- Scope: Init-time
- Description: Port ID used when sending a bus request to the arbiter.

Parameter: **Align Data**
- Parameter Type: boolean
- Legal Values: true, false Default = *false*.
- Scope: Init-time
- Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to *true* enables aligning of the data to the correct byte lane.

*Note: This field is no longer used, but is maintained for backwards compatibility.*
A.2.1.7 AHB_Lite_Slave_T2S and AHB_Lite_Slave_FT2S

A transactor that converts AHB transactions from a transaction slave port into AHB-Lite Slave interface signals in the Cycle Model. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

* Optional signals for Arm11 extension

Figure A-18  AHB_Lite_Slave_T2S Transactor
AHB_Lite_Slave_T2S and AHB_Lite_Slave_FT2S parameters

Parameter: Enable Debug Messages
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Run-time
  Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Base Address (for AHB_Lite_Slave_T2S)
  Parameter Type: value
  Legal Values: 0 - Max Address Size. Default = 0.
  Scope: Init-time
  Description: Base address of the AHB Slave memory region 0.

Parameter: ahb_start1 (for AHB_Lite_Slave_T2S)
  Parameter Type: value
  Legal Values: 0 - Max Address Size. Default = 0.
  Scope: Init-time
  Description: Base address of the AHB Slave memory region 1.

Parameter: region start [0-5] (for AHB_Lite_Slave_FT2S)
  Parameter Type: value
  Legal Values: 0 - Max Address Size. Default = 0x0.
  Scope: Init-time
  Description: Base address of the AHB Slave memory regions 0 through 5.

Parameter: Size (for AHB_Lite_Slave_T2S)
  Parameter Type: value
  Legal Values: 0 - Max Address Size. Default = null.
  Scope: Init-time
  Description: Size of memory region 0.

Parameter: ahb_size1 (for AHB_Lite_Slave_T2S)
  Parameter Type: value
  Legal Values: 0 - Max Address Size. Default = 32.
  Scope: Init-time
  Description: Size of memory region 1.

Parameter: region size [0-5] (for AHB_Lite_Slave_FT2S)
  Parameter Type: value
  Legal Values: 0 - Max Address Size. Default = 0x100000000 for region 0
  0x0 for regions 1-5
  Scope: Init-time
  Description: Size of memory regions 0 through 5.
Parameter: Subtract Base Address (for AHB_Lite_Slave_T2S)

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: When set to true, the Base Address is subtracted from the transaction address, and the offset is sent to the RTL port. When set to false (the default value), the transaction address is sent to the RTL port unchanged.

Parameter: Subtract Base Address Dbg (for AHB_Lite_Slave_T2S)

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: Set this parameter when using the readDbg and writeDbg members of the transactor ports. When set to true, the Base Address is subtracted from the transaction address, and the offset is sent to the RTL port. When set to false (the default value), the transaction address is sent to the RTL port unchanged.

Parameter: Big Endian

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: Affects the alignment of the data on the data bus. When true, the data is output “big endian” on the data bus.

Parameter: Align Data

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to true enables aligning of the data to the correct byte lane.

Note: This field is no longer used, but is maintained for backwards compatibility.

Parameter: Filter HREADYIN

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Init-time
Description: AHB slaves are required to have an HREADY signal as both an input and an output. The output is the slave’s ready status, while the input is the ready status of all the slaves on the bus (presumably calculated by the bus arbiter). Setting this parameter to true filters out the input HREADY “HREADYIN” to prevent it from reaching the Cycle Model. The parameter should be set only when it is not required by the slave for correct operation.
A.2.1.8 **AHB_Lite_Slave_FS2T**

A transactor that converts AHB-Lite Slave interface signals from the Cycle Model into transactions that are communicated through the transaction master port. These transactors can communicate with SoC Designer components that implement the CASI AHB transaction interface.

![Diagram of AHB_Lite_Slave_FS2T Transactor](image)

* Optional signals for Arm11 extension

Figure A-19  AHB_Lite_Slave_FS2T Transactor
AHB_Lite_Slave_FS2T parameters

Parameter: Enable Debug Messages
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Run-time
  Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Big Endian
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Init-time
  Description: Affects the alignment of the data on the data bus. When true, the data is read as “big endian” on the data bus.

Parameter: Align Data
  Parameter Type: boolean
  Legal Values: true, false Default = false.
  Scope: Init-time
  Description: For narrow transfers on the AHB bus, SoC Designer outputs data aligned to the low bytes, even though the protocol states that data for an unaligned address should be output on the correct byte lane. Setting this parameter to true enables aligning of the data to the correct byte lane.

Note: This field is no longer used, but is maintained for backwards compatibility.
A.2.2 APB Transactors

This section describes:

- APB_Master
- APB_Slave

A.2.2.1 APB_Master

A transactor that converts APB Master interface signals from the Cycle Model into transactions that are communicated through the transaction master port. These transactors can communicate with SoC Designer components that implement the CASI APB transaction interface.

![Figure A-20 APB_Master Transactor](image)

**APB_Master parameters**

Parameter: Enable Debug Messages

- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Run-time
- Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Protocol Variant

- Legal value: APB2
- Scope: Fixed (not changeable)
Description: Specifies APB2 protocol

A.2.2.2 APB_Slave

A transactor that converts APB transactions from a transaction slave port to APB Slave interface signals in the Cycle Model. These transactors can communicate with SoC Designer components that implement the CASI APB transaction interface.

Figure A-21 APB_Slave Transactor

APB_Slave parameters

Parameter: Enable Debug Messages
- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Run-time
- Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Base Address
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0.
- Scope: Init-time
- Description: Base address of the APB Slave memory region.
Parameter: **Size**

  Parameter Type: value
  Legal Values: 0 - Max Address Size. Default = null.
  Scope: Init-time
  Description: Size of memory region.

Parameter: **Protocol Variant**

  Legal value: APB2
  Scope: Fixed (not changeable)
  Description: Specifies APB2 protocol
A.2.3 APB3 Transactors

This section describes:

- APB3_Master
- APB3_Slave

A.2.3.1 APB3_Master

A transactor that converts APB3 Master interface signals from the Cycle Model into transactions that are communicated through the transaction master port. These transactors can communicate with SoC Designer components that implement the CASI APB3 transaction interface.

The difference between the APB Master and the APB3 Master is that the APB3 adds two signals: PREADY and PSLVERR. PREADY can be used by an APB slave component to insert wait states to slow down the transfer. PSLVERR can be used by a slave component to signal an error during a transaction.

![APB3_Master Transactor Diagram](image)

Figure A-22 APB3_Master Transactor
APB3_Master parameters

Parameter: Enable Debug Messages
   Parameter Type: boolean
   Legal Values: true, false. Default = false.
   Scope: Run-time
   Description: When set to true, the adaptor outputs debug messages while running.

Parameter: Base Address
   Parameter Type: value
   Legal Values: 0 - Max Address Size. Default = 0.
   Scope: Init-time
   Description: Base address of the APB memory region.

Parameter: Size
   Parameter Type: value
   Legal Values: 0 - Max Address Size. Default = null.
   Scope: Init-time
   Description: Size of memory region.

Parameter: PReady Default High
   Parameter Type: boolean
   Legal Values: true, false. Default = false.
   Scope: Run-time
   Description: This parameter affects the value of the PReady signal while not in a transaction. When true, PReady is High between transactions. When false, PReady is Low.

Parameter: Protocol Variant
   Legal value: APB3
   Scope: Fixed (not changeable)
   Description: Specifies APB3 protocol
A.2.3.2 APB3_Slave

A transactor that converts APB3 transactions from a transaction slave port to APB3 Slave interface signals in the Cycle Model. These transactors can communicate with SoC Designer components that implement the CASI APB3 transaction interface.

The difference between the APB Slave and the APB3 Slave is that the APB3 adds two signals: PREADY and PSLVERR. PREADY can be used by an APB slave component to insert wait states to slow down the transfer. PSLVERR can be used by a slave component to signal an error during a transaction.

![Figure A-23 APB3_Slave Transactor](image)

**APB3_Slave parameters**

**Parameter:** Enable Debug Messages  
Parameter Type: boolean  
Legal Values: true, false. Default = false.  
Scope: Run-time  
Description: When set to true, the adaptor outputs debug messages while running.

**Parameter:** Base Address  
Parameter Type: value  
Legal Values: 0 - Max Address Size. Default = 0.  
Scope: Init-time  
Description: Base address of the APB Slave memory region.
Parameter: Size

Parameter Type: value
Legal Values: 0 - Max Address Size. Default = null.
Scope: Init-time
Description: Size of memory region.

Parameter: Protocol Variant
Legal value: APB3
Scope: Fixed (not changeable)
Description: Specifies APB3 protocol
A.2.4 APB4 Transactors

This section describes:

- APB4_Master
- APB4_Slave

A.2.4.1 APB4_Master

A transactor that converts APB4 Master interface signals from the Cycle Model into transactions that are communicated through the transaction master port. These transactors can communicate with SoC Designer components that implement the CASI APB4 transaction interface.

APB4 adds two signals: PSTRB, a byte strobe for write commands, and PPROT, which selects the protection type.

![Figure A-24 APB4_Master Transactor](image-url)
**APB4_Master parameters**

Parameter: **Enable Debug Messages**
- Parameter Type: boolean
- Legal Values: true, false. Default = *false*.
- Scope: Run-time
- Description: When set to *true*, the adaptor outputs debug messages while running.

Parameter: **Base Address**
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0.
- Scope: Init-time
- Description: Base address of the APB memory region.

Parameter: **Size**
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = null.
- Scope: Init-time
- Description: Size of memory region.

Parameter: **PReady Default High**
- Parameter Type: boolean
- Legal Values: true, false. Default = *false*.
- Scope: Run-time
- Description: This parameter affects the value of the PReady signal while not in a transaction. When *true*, PReady is High between transactions. When *false*, PReady is Low.

Parameter: **Protocol Variant**
- Legal value: APB4
- Scope: Fixed (not changeable)
- Description: Specifies APB4 protocol
A.2.4.2 APB4_Slave

A transactor that converts APB4 transactions from a transaction slave port to APB4 Slave interface signals in the Cycle Model. These transactors can communicate with SoC Designer components that implement the CASI APB4 transaction interface.

APB4 adds two signals: PSTRB and PPROT. PSTRB, a byte strobe for write commands, and PPROT, which selects the protection type.

Figure A-25 APB4_Slave Transactor
**APB4_Slave parameters**

**Parameter:** Enable Debug Messages
- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Run-time
- Description: When set to true, the adaptor outputs debug messages while running.

**Parameter:** Base Address
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = 0.
- Scope: Init-time
- Description: Base address of the APB Slave memory region.

**Parameter:** Size
- Parameter Type: value
- Legal Values: 0 - Max Address Size. Default = null.
- Scope: Init-time
- Description: Size of memory region.

**Parameter:** Protocol Variant
- Legal value: APB4
- Scope: Fixed (not changeable)
- Description: Specifies APB4 protocol
A.2.5 AXI Transactors

There are four variants of the AXI transactors:

- **AXI_Flowthru_Master** and **AXI_Flowthru_Slave**: These flow-through versions of the AXI transactors (v2) should be used if the Cycle Model has flow through (asynchronous) paths in the design. These transactors are compatible with the Arm AMBA3/AXI protocol.

- **AXI4_Master** and **AXI4_Slave**: These transactors support the Arm AMBA4/AXI protocol.

- **AXI4Stream_Master** and **AXI4Stream_Slave**: These transactors support the

*Note:* A component built with the original AXI transactors cannot be directly connected to a component built with flow-through AXI transactors. The SoC Designer release provides adaptors to connect two such components.
A.2.5.1 AXI_Flowthru_Master

This is a transactor that converts AXI_Flowthru Master signals from the Cycle Model into transactions that are communicated through the transaction master port. These transactors can communicate with SoC Designer components that implement the CASI AXI transaction interface.

Figure A-26 AXI_Master Transactor
**AXI_Flowthru_Master parameters**

Parameter: Enable Debug Messages

Parameter Type: boolean

Legal Values: true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.
A.2.5.2 AXI_Flowthru_Slave

This is a transactor that converts AXI transactions from a transaction slave port to AXI Slave interface signals in the Cycle Model. These transactors can communicate with SoC Designer components that implement the CASI AXI transaction interface.

![AXI_Flowthru_Slave Diagram]

Figure A-27 AXI_FlowthruSlave Transactor
AXI_Flowthru_Slave parameters

Parameter: Enable Debug Messages
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Run-time
  Description: When set to true, the adaptor outputs debug messages while running.

Parameter: axi_start [0-5]
  Parameter type: value
  Legal Values: 0 - Max Address Size. Default = 0.
  Scope: Init-time
  Description: Start Address of AXI memory regions 0 through 5.

Parameter: axi_size [0-5]
  Parameter type: value
  Legal Values: 0 - Max Address Size. Default = 0x10000000
  0 for regions 1-5
  Scope: Init-time
  Description: Size of AXI memory region 0.
A.2.5.3 AXI4_Master and AXI4_Slave

An AXI4_Master transactor converts AXI4 Master signals from the Cycle Model into transactions that are communicated through the transaction master port.

An AXI4_Slave transactor converts AXI4 transactions from a transaction slave port to AXI Slave interface signals in the Cycle Model.

The AXI4 Master and Slave transactors implement a number of AXI4 protocol variants including:

- AXI4-Lite
- AXI4
- ACE-Lite
- ACE-Lite+DVM
- ACE

This is implemented as a transactor parameter called Protocol Variant. You can set this value in either of the following ways:

- In CMS, by accessing the Parameter pulldown menu on the Ports tab.
- In SoC Designer Canvas, by accessing the parameter on the component that contains the transaction interface. There is one parameter per AXI4 interface in the SoC Designer component. The name is prefixed by the transaction interface name to differentiate each interface's parameter.

These transactors can communicate with SoC Designer components that implement the CASI AXI transaction interface. The following table describes the ports for the AXI4_Master and AXI4_Slave transactors.
<table>
<thead>
<tr>
<th>Channel</th>
<th>Port</th>
<th>Master Direction</th>
<th>Slave Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write Address</td>
<td>awid</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awaddr</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awlen</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awsize</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awburst</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awlock</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awcache</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awprot</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awuser</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awvalid</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awready</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>awqos</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awregion</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awdomain</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awsnoop</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>awbar</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td>Write Data</td>
<td>wdata</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>wstrb</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>wlast</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>wuser</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>wvalid</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>wready</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td>Write Response</td>
<td>bid</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>bresp</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>buser</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>bvalid</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>bready</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>wack</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td>Channel</td>
<td>Port</td>
<td>Master Direction</td>
<td>Slave Direction</td>
</tr>
<tr>
<td>--------------</td>
<td>--------</td>
<td>---------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Read Address</td>
<td>arid</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>araddr</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arlen</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arsize</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arburst</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arlock</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arcache</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arprot</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>aruser</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arvalid</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arready</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>arqos</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arregion</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>ardomain</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arsnoop</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>arbar</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td>Read Data</td>
<td>rack</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>rid</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>rdata</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>rresp</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>rlast</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>ruser</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>rvalid</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>rready</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td>Snoop Address</td>
<td>acvalid</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>aready</td>
<td>Model to transactor</td>
<td>Transactor to model</td>
</tr>
<tr>
<td></td>
<td>acaddr</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>acsnoop</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
<tr>
<td></td>
<td>acprot</td>
<td>Transactor to model</td>
<td>Model to transactor</td>
</tr>
</tbody>
</table>
**AXI4_Master and AXI4_Slave parameters**

Parameter: **Enable Debug Messages**

Parameter Type: boolean

Legal Values: true, false. Default = false.

Scope: Run-time

Description: When set to true, the adaptor outputs debug messages while running.

Parameter: **axi_start [0-5]**

Parameter type: value

Legal Values: 0 - Max Address Size. Default = 0.

Scope: Init-time

Description: Start Address of AXI memory regions 0 through 5.

Parameter: **axi_size [0-5]**

Parameter type: value

Legal Values: 0 - Max Address Size. Default = 0x10000000

Scope: Init-time

Description: Size of AXI memory region 0.
A.2.5.4 AXI4Stream_Master and AXI4Stream_Slave

The AXI4Stream_Master and AXI4Stream_Slave transactors convert between the pin-level AXI4 stream and the transaction level. Refer to the Arm AMBA 4 AXI4-Stream Protocol specification (Arm IHI0051) for details about interface signals.

Parameters

Parameter: Data Bus Width
  Parameter Type: integer
  Legal Values: integers. Default = 32
  Scope: Run-time
  Description: Width of rdata and wdata buses

Parameter: Enable Debug Messages
  Parameter Type: boolean
  Legal Values: true, false. Default = false.
  Scope: Run-time
  Description: When set to true, the adaptor outputs debug messages while running.
A.2.6 CHI Transactors

The CHI transactors are separated into two groups: CHIInt* and CHINode*. The CHIInt* transactors convert signals from a CHI ICN (Interconnect) port to link layer flits, which are transacted to/from a CHI Node port. The CHINode* transactors convert signals from a CHI Node port to link layer flits, which are transacted to/from a CHI ICN port.

These transactors communicate with SoC Designer components that implement the AMBA CHI Port Interface classes. Refer to the *AMBA CHI Protocol Bundle User Guide* for more information.

A.2.6.1 CHIInt* Transactors

The CHIInt* set of transactors includes:

- CHIIntRNDXtor (CHI Completer)
- CHIIntRNFXtor (CHI Completer)
- CHIIntRNIXtor (CHI Completer)
- CHIIntRequestorXtor (CHI Completer)
- CHIIntSNFXtor (CHI Requestor)
- CHIIntSNIXtor (CHI Requestor)
- CHIIntSlaveXtor (CHI Requestor)

This section describes the available signals and parameters for this set of transactors.
**CHIInt* Transactor Signals**

Table A.4 describes the available signals for each CHIInt* transactor.

**Table A.4: CHIInt* Transactor Signals**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>CHI Int RND Xtor</th>
<th>CHI Int RNF Xtor</th>
<th>CHI Int RNI Xtor</th>
<th>CHI Int Requestor Xtor</th>
<th>CHI Int SNF Xtor</th>
<th>CHI Int SNI Xtor</th>
<th>CHI Int Slave Xtor</th>
</tr>
</thead>
<tbody>
<tr>
<td>REQ</td>
<td>TXREQFLIT</td>
<td>Model to Transactor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TXREQFLIPTPEND</td>
<td>Model to Transactor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TXREQFLITV</td>
<td>Model to Transactor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RXREQFLIT</td>
<td>Transactor to Model</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RXREQFLIPTPEND</td>
<td>Transactor to Model</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RXREQFLITV</td>
<td>Transactor to Model</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RXREQLCRDV</td>
<td>Model to Transactor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table A.4: CHIInt* Transactor Signals (continued)

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>Signal Availability Per Transactor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>CHI Int RND Xtor</td>
</tr>
<tr>
<td>RSP</td>
<td>TXRSPFLIT</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXRSPFLITPEND</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXRSPFLITV</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXRSPLCRDV</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRSPFLIT</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRSPFLITPEND</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRSPFLITV</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRSPLCRDV</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
<tr>
<td>SNP</td>
<td>TXSNPFLIT</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXSNPFLITPEND</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXSNPFLITV</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXSNPPLCRDV</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPFLIT</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPFLITPEND</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPFLITV</td>
<td>Transactor to Model</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPPLCRDV</td>
<td>Model to Transactor</td>
<td>•</td>
</tr>
</tbody>
</table>
### Table A.4: CHIInt* Transactor Signals (continued)

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>CHI Int RND Xtor</th>
<th>CHI Int RNF Xtor</th>
<th>CHI Int RNI Xtor</th>
<th>CHI Int Requestor Xtor</th>
<th>CHI Int SNF Xtor</th>
<th>CHI Int SNI Xtor</th>
<th>CHI Int Slave Xtor</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>TXDATFLIT</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXDATFLITPEND</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXDATFLITV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXDATLCRDV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXDATFLIT</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXDATFLITPEND</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXDATFLITV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXDATLCRDV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Control Signals</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXLINKACTIVEREQ</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXSACTIVE</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXLINKACTIVEACK</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXLINKACTIVEREQ</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSACTIVE</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

**CHIInt* Parameters**
Parameter: **Data Bus Width**

Parameter Type: integer value
Scope: Compile-time
Description: Width of rdata and wdata busses.

Parameter: **Enable Debug Messages**

Parameter Type: boolean
Legal Values: true, false. Default = false.
Scope: Run-time
Description: When set to true, outputs debug messages while running.

Parameter: **Protocol Variant**

Parameter Type: string
Legal Values: Fixed. Default = Protocol for this transactor (i.e., CHI-RND).
Scope: Init-time
Description: Specifies the protocol variant for the transactor.
A.2.6.2 CHINode* Transactors

The CHINode* set of transactors includes:

- CHINodeRNDXtor (CHI Requestor)
- CHINodeRNFXtor (CHI Requestor)
- CHINodeRNIXtor (CHI Requestor)
- CHINodeRequestorXtor (CHI Requestor)
- CHINodeSNFXtor (CHI Completer)
- CHINodeSNIXtor (CHI Completer)
- CHINodeSlaveXtor (CHI Completer)

This section describes the available signals and parameters for this set of transactors.

**CHINode* Transactor Signals**

Table A.5 describes the available signals for each CHINode* transactor.

### Table A.5: CHINode* Transactor Signals

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>CHINodeRNDXtor</th>
<th>CHINodeRNFXtor</th>
<th>CHINodeRNIXtor</th>
<th>CHINodeRequestorXtor</th>
<th>CHINodeSNFXtor</th>
<th>CHINodeSNIXtor</th>
<th>CHINodeSlaveXtor</th>
</tr>
</thead>
<tbody>
<tr>
<td>REQ</td>
<td>TXREQFLIT</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXREQFLITPEND</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXREQFLITV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXREQLCRDV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>RX</td>
<td>TXREQFLIT</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXREQFLITPEND</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXREQFLITV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXREQLCRDV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Channel</td>
<td>Signal</td>
<td>Direction</td>
<td>Signal Availability Per Transactor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>----------------------------</td>
<td>------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CHI Node RND Xtor</td>
<td>CHI Node RNF Xtor</td>
<td>CHI Node RNI Xtor</td>
<td>CHI Node Requ estor Xtor</td>
<td>CHI Node SNF Xtor</td>
<td>CHI Node SNI Xtor</td>
<td>CHI Node Slave Xtor</td>
</tr>
<tr>
<td>RSP</td>
<td>TXRSPFLIT</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXRSPFLITPEND</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXRSPFLITV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXRSPPLCRDV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRSPFLIT</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRSPFLITPEND</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRSPFLITV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXRRSPLCRDV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>SNP</td>
<td>TXSNPFLIT</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXSNPFLITPEND</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXSNPFLITV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>TXSNPLCRDV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPFLIT</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPFLITPEND</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPFLITV</td>
<td>Transactor to Model</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>RXSNPLCRDV</td>
<td>Model to Transactor</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>
### Table A.5: CHINode* Transactor Signals (continued)

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>Signal Availability Per Transactor</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>TXDATFLIT</td>
<td>Model to Transactor</td>
<td>CHI Node RND Xtor</td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITPEND</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITV</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATLCRDV</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLIT</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITPEND</td>
<td></td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATLCRDV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Signals</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>RXSACTIVE</td>
<td>Transactor to Model</td>
<td></td>
</tr>
</tbody>
</table>

**Table A.5: CHINode* Transactor Signals (continued)**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>Signal Availability Per Transactor</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>TXDATFLIT</td>
<td>Model to Transactor</td>
<td>CHI Node RND Xtor</td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITPEND</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITV</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATLCRDV</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLIT</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITPEND</td>
<td></td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATLCRDV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>RXSACTIVE</td>
<td>Transactor to Model</td>
<td></td>
</tr>
</tbody>
</table>

**Table A.5: CHINode* Transactor Signals (continued)**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>Signal Availability Per Transactor</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>TXDATFLIT</td>
<td>Model to Transactor</td>
<td>CHI Node RND Xtor</td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITPEND</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITV</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATLCRDV</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLIT</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITPEND</td>
<td></td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATLCRDV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>RXSACTIVE</td>
<td>Transactor to Model</td>
<td></td>
</tr>
</tbody>
</table>

**Table A.5: CHINode* Transactor Signals (continued)**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>Signal Availability Per Transactor</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>TXDATFLIT</td>
<td>Model to Transactor</td>
<td>CHI Node RND Xtor</td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITPEND</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITV</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATLCRDV</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLIT</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITPEND</td>
<td></td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATLCRDV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>RXSACTIVE</td>
<td>Transactor to Model</td>
<td></td>
</tr>
</tbody>
</table>

**Table A.5: CHINode* Transactor Signals (continued)**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>Signal Availability Per Transactor</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>TXDATFLIT</td>
<td>Model to Transactor</td>
<td>CHI Node RND Xtor</td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITPEND</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITV</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATLCRDV</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLIT</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITPEND</td>
<td></td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATLCRDV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>RXSACTIVE</td>
<td>Transactor to Model</td>
<td></td>
</tr>
</tbody>
</table>

**Table A.5: CHINode* Transactor Signals (continued)**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Signal</th>
<th>Direction</th>
<th>Signal Availability Per Transactor</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>TXDATFLIT</td>
<td>Model to Transactor</td>
<td>CHI Node RND Xtor</td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITPEND</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATFLITV</td>
<td>Model to Transactor</td>
<td></td>
</tr>
<tr>
<td>DAT</td>
<td>TXDATLCRDV</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLIT</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITPEND</td>
<td></td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATFLITV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>RXDATLCRDV</td>
<td>TXDATFLIT</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>TXLINKACTIVEACK</td>
<td>Transactor to Model</td>
<td></td>
</tr>
<tr>
<td>Control</td>
<td>RXSACTIVE</td>
<td>Transactor to Model</td>
<td></td>
</tr>
</tbody>
</table>
**CHINode** Parameters

Parameter: **Data Bus Width**
- Parameter Type: integer value
- Scope: Compile-time
- Description: Width of rdata and wdata busses.

Parameter: **Enable Debug Messages**
- Parameter Type: boolean
- Legal Values: true, false. Default = false.
- Scope: Run-time
- Description: When set to true, outputs debug messages while running.

Parameter: **Protocol Variant**
- Parameter Type: string
- Legal Values: Fixed. Default = Protocol for this transactor (i.e., CHI-RND).
- Scope: Init-time
- Description: Specifies the protocol variant for the transactor.
Appendix B

User-Defined Transactors with SoC Designer

In addition to using the Arm-supplied transactors and the SoC Designer transactors, Cycle Model Studio also allows you to define your own transactors. In essence, this allows you to create a named object with named input and output ports that can be connected, via the Cycle Model Studio, to Cycle Model ports.

This appendix describes how to write your own transactor and incorporate it into the component. The first two sections describe the Cycle Model Studio’s requirements for the transactor’s XML and C++ files. The final section describes how to use the Cycle Model Studio to integrate your transactor into the component.

B.1 Writing the Transactor XML File

Every transactor must be described so that the Cycle Model Studio wizard can provide user interface for port connections and generate the connecting code in the component. Your transactor file must contain the following features:

- The name of your transactor.
  
  This name should be unique; that is, it should not duplicate the name of another transactor.
- The name of the class instantiated by the component.
- The name of the header file that defines the above class.
- A port definition for each of the transactor’s signal ports, if any.

You can use the transactor definitions found in the file $CARBON_HOME/lib/xactors/xactors.xml as a guide.
Sample user-defined transactor XML file

<?xml version="1.0"?>
<transactors version="1.0">

<!-- Define your transactor with a 'component' element. The 'name' attribute is the transactor name and shows up in the Cycle Model Studio menu. -->
<component name="MyTransactor">

<!-- The name of the class that is instantiated by the component -->
<className>MyXtorClass</className>

<!-- The header file that contains the definition of the class given by the className element -->
<includeFile>userXtors.h</includeFile>

<!-- Port definitions. A transactor may have any number of ports, including none. Each port has a name, width, and direction, as follows: name: The name of the port. This name is used: - In the Cycle Model Studio wizard to connect to RTL signals. - To find runtime port objects via the 'portFactory' and 'carbonGetPort' interfaces. width: The width, in bits, of the port. direction: "input" or "output" -->
<port name="input_1" width="1" direction="input">
 <!-- a description of the port is optional -->
 <description>Input One</description>
</port>

<port name="output_1" width="1" direction="output">
 <description>Output One</description>
</port>

</component>

</transactors>
B.2 Writing the Transactor C++ Code

The structure of a user-defined transactor is similar to the structure of an SoC Designer component.

Main transactor class

You must provide a C++ class with these methods:

```cpp
class MyXtorClass
{
    // constructor
    MyXtor(sc_mx_module* carbonComp, const char *xtorName,
            CarbonObjectID **carbonObj, CarbonPortFactory *portFactory);

    // destructor
    ~MyXtor();

    // provide input port handles to the Cycle Model component
    sc_mx_signal_slave *carbonGetPort(const char *name);

    // similar to sc_mx_module
    void communicate();
    void update();
    void init();
    void terminate();
    void reset(MxResetLevel level, const MxFileMapIF *filelist);
    void setParameter(const string &name, const string &value);
};
```

Transactor output ports

Transactor output ports are connected to Cycle Model input ports by the Cycle Model Studio wizard. The transactor writes signal values to the Cycle Model by calling the `driveSignal` method of output port objects.

Output port handles are obtained by name via the `portFactory` function passed to the constructor. The `portFactory` function returns a pointer of type `CarbonXtorAdaptorToVhmPort`:

```cpp
MyXtor::MyXtor(sc_mx_module* carbonComp, 
               const char *xtorName, 
               CarbonObjectID **carbonObj, 
               CarbonPortFactory *portFactory)
{
    mOutPort = portFactory(carbonComp, 
                           xtorName, 
                           "output_1", 
                           carbonObj);
}
```

Writing to output ports

Ports returned by the `portFactory` have the same `driveSignal` interface as `sc_mx_signal_slave`:

```cpp
void driveSignal(MxU32 value, MxU32* extValue)
{
    value = low 32 bits
    extValue = pointer to the rest of the bits
}
Transactor input ports

Input ports are connected to Cycle Model output signals by the Cycle Model Studio wizard. The Cycle Model sends signal value changes to the transactor by calling the driveSignal method of input port objects.

Implement sc_mx_signal_slave ports just as you would for an SoC Designer component:

- Subclass sc_mx_signal_slave.
- Override driveSignal() to do what you need.

Implement carbonGetPort

The component needs to be able to get a handle to your input ports so that it can write values to them.

```cpp
sc_mx_signal_slave *MyXtor::carbonGetPort(const char *name)
{
    sc_mx_signal_slave *port = NULL;
    if (strcmp("input_1", name) == 0) {
        port = mInput1;
    }
    return port;
}
```

init, reset, communicate, update, terminate

The init, reset, communicate, update, and terminate functions are all called by the component when its own method of the same name is invoked. See the SoC Designer User Guide (100996) for information on how these methods are used.

For more information about the C++ classes and member functions used to write your transactor, contact Arm Technical Support.
B.3 Adding your Transactor to the Component

To connect your transactor appropriately in the Cycle Model Studio tool:

1. Before creating the SoC Designer Component, specify the name of your user-defined transactor in the **Transactor Definition File** field on the SoC Designer Component Properties page.

![Figure B-1 SoC Designer Component Settings](image)

After you generate the component for SoC Designer, your transactor is available from the list of available transactors in Cycle Model Studio.

2. On the SoC Designer Component Editor **Ports** tab:
   - Click the **Add Xtor** button.
   - In the pulldown menu next to the **Add Xtor** button, select the name of your transactor.
   - Map your transactor ports to RTL ports as outlined in “Adding Transactors and Other Interface Entities” on page 95.

3. On the SoC Designer Component **Properties** page, add any compiler or linker flags needed by your transactor.
Appendix C

Arm-Supplied RTL Models

Arm provides a family of simple RTL models for use in designs compiled by Cycle Model Studio. Designed for high performance and easy integration, these models are instantiated directly in your RTL design and compiled together to form a single Cycle model. When targeting the SoC Designer platform, Cycle Model Studio automatically detects the presence of one or more of these Cycle models and adds the appropriate parameters, registers, and memory views to the SoC Designer component.

This appendix includes the following sections:

- Overview
- Using Arm-supplied RTL Models
- Specific Requirements for DDRx Memory Models

C.1 Overview

Arm provides a family of simple double data rate (DDR) memory models. In this document, we refer to the family, which includes such models as DDR, DDR2, DDR3, DDR4, and LPDDR2, as DDRx Memory Models.

Designed for high performance and easy integration, these Verilog memory models connect directly to RTL-based memory controllers. A wide range of memory configurations are supported through compile time parameters, and each model’s interface timing can be adjusted to simplify the connection to the controller’s physical layer interface.

The DDRx Memory Models are simple cycle-accurate functional memory models designed to be embedded along with a memory controller and its physical layer interface to form a single memory subsystem component model. The DDRx Memory Model interfaces with the memory controller physical layer interface at the pin level, as defined by the appropriate JEDEC stan-
standard. You must provide the top level wrapper that instantiates the RTL memory controller and the DDRx Memory Model in a single module, and compile this using Cycle Model Studio to create the memory subsystem model. Figure C-1 illustrates this usage.

Figure C-1 DDRx Memory Model Usage

Figure C-2 illustrates the internal hierarchy of the DDRx Memory Model shown on the right in Figure C-1.

Figure C-2 Internal Hierarchy of DDRx Memory Models
C.1.1 DDRx Memory Model Location

The Arm-supplied RTL models and their command files are distributed as part of the Cycle Model Studio release and are located in the immediate sub-directories of:

```
$CARBON_HOME/lib/carbonRTL
```

For example, the `carbon_memory_ddr` subdirectory contains the following files:

- `carbon_memory_ddr.cmd`
- `carbon_memory_ddr.v`

The readme file for this release contains a list of models that are currently supported. Specific details about the supplied RTL model interface and parameters can be found in the file that defines the model, located in `$CARBON_HOME/lib/carbonRTL/*`.

C.2 Using Arm-supplied RTL Models

To use an Arm-supplied RTL model, you must perform two steps, which are described in the sections that follow:

1. Instantiate the desired module or modules in your design with the appropriate parameters (described in the section Instantiating the Module).
2. Add an Arm-supplied command file to the project for each model type you use (described in the section Adding the Arm-supplied Command File).

This section also describes:

- Configuring DDRx Size and Signal Timing
- DDRx Mode Registers
- DDRx Profiling Capabilities

C.2.1 Instantiating the Module

The following is a Verilog example of instantiating a module. In this example, an instance of the `carbon_memory_ddr2` module is included in the module named `ddr2_memory_block`.

```verilog
module ddr2_memory_block();

... carbon_memory_ddr2 #( .CS_BITS(3), .DATA_BITS(64), .MAX_ADDR_BITS(33), .DQS_IN_DELAY(1), .DQS_OUT_DELAY(0) ) myDDR2( .ck(ck), .ckbar(ckbar), .cke(cke), .cs_n(cs_n), .ras_n(ras_n), .cas_n(cas_n), .we_n(we_n), .dm(dm), .ba(ba), .addr(addr), .dq(dq), .dqs(dqs) );
```
endmodule

C.2.2 Adding the Arm-supplied Command File

The command file for the module is the module name with a .cmd extension. For example, the name of the command file for the carbon_memory_ddr2 module is:

```
$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr2/
carbon_memory_ddr2.cmd
```

This command file for a memory is located in the immediate sub-directory of $CARBON_HOME/lib/carbonRTL that corresponds to the memory name.

Add the file to the Cycle Model Studio project by using the -f switch on the SoC Designer Component Properties page as follows:

1. Click RTL Sources in the Project Explorer pane.
2. Choose Project > Compiler Setting. The Compiler Options screen appears.
3. Under Input File Control, enter the full pathname of the .cmd file.

If your design includes multiple instances of a particular model, only one copy of the .cmd file needs to be included as an argument to the -f switch.

```
$CARBON_HOME/lib/carbonRTL/
```

See the Compiler Settings section “Using the Project Menu” on page 33 for more information on setting compiler flags.
C.2.3 Configuring DDRx Size and Signal Timing

Several compile time Verilog parameters are available to configure the size of the DDRx Memory Model and the timing it uses for the DQS/DQ signaling.

Table C-1 describes the compile time Verilog parameters that are available. “Specific Requirements for DDRx Memory Models” on page 225 and the pages following describe which must be specified for each memory model.

<table>
<thead>
<tr>
<th>Table C-1 Compile-time Verilog parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>CS_BITS</td>
</tr>
<tr>
<td>DATA_BITS</td>
</tr>
<tr>
<td>MAX_ADDR_BITS</td>
</tr>
<tr>
<td>DQS_IN_DELAY</td>
</tr>
<tr>
<td>DQS_OUT_DELAY</td>
</tr>
<tr>
<td>Parameter</td>
</tr>
<tr>
<td>------------------------------</td>
</tr>
</tbody>
</table>
| WRITE_PREAMBLE (DDR3, DDR4, and LPDDR3 only) | Determines the number of DQS Write preambles the memory should expect.  
• DDR3 defaults to 1. Allowed values are 0 and 1.  
• DDR4 defaults to 0. Allowed values are 0, 1, and 2.  
• LPDDR3 defaults to 0. Allowed values are 0 and 1. |
| READ_PREAMBLE (DDR4 only)    | Determines the number of DQS Read preambles the memory should expect.  
Defaults to 1. Allowed values are 0, 1, and 2. |
| MR8_SETTING (LPDDR2 and LPDDR3 only) | Defines the reset value of Mode Register 8 (also known as Basic Configuration 4), which defines the I/O width, Density, and Type of memory. The default is 1. |
C.2.4 DDRx Mode Registers

Each embedded DDRx memory has internal mode registers; they are slightly different for each memory model type. These registers are implemented according to the JEDEC specification for each protocol, and configure the operation of the memory — for example, the number of clock cycles it takes the memory to respond to Read and Write commands is set by programming the appropriate values in the mode registers. The Memory Model Mode registers are automatically made visible via CADI registers for each Chip Select.

Figure C-3 shows the Mode Registers tab for the DDR3 memory model (the Commands, Bank Commands, and Events tabs display registers related to profiling, and are discussed in the next section). See the individual JEDEC protocol specification for details about the function of each register.

![Figure C-3 DDRx Mode Registers](image_url)
C.2.5 DDRx Profiling Capabilities

The profiling capabilities discussed in this section are supported by all memory models except the GDDR5.

The memory models support profiling through the use of counters in the RTL that track DDR command-related events. These RTL counters and event signals are automatically instrumented for models built using Cycle Model Studio.

Note that only Read/Write CADI register profiling is supported; CAPI profiling streams are not generated.

Profiling data includes the following events and counters:

- **Command Counters** — For each Chip Select:
  - Provides the total count of ACTIVATE, READ, WRITE, PRECHARGE, and REFRESH commands.
  - Counts clock cycles where READ DATA or WRITE DATA is transferred. For example, a single Write Burst 8 DDR3 transfer increments the WRITE count by 1, and the WRITE DATA by 4.
  - Calculates the bus utilization percentages (READ, WRITE, and Total) over a sliding 100 cycle window. In other words, a history of the last 100 cycles is maintained, and the utilization is the count of READ DATA/WRITE DATA events during that time.

- **Bank Command Counters** — Provides additional bank-level detail for the ACTIVATE, READ, and WRITE commands. This allows analysis of how the accesses are distributed across banks as well as the efficiency of ACTIVATE commands at the bank level.

- **Events** — Raw event registers for each Chip Select including ACTIVATE, READ, WRITE, BURST, PRECHARGE, REFRESH, READ DATA, and WRITE DATA. Values are pulsed for one cycle for the event, with the bit position representing the bank where the command is active. For example, an ACTIVATE Bank 3 command pulses the value 0x0008 on the ACTIVATE Event (bit 3 is asserted).
C.3 Specific Requirements for DDRx Memory Models

The following sections provide details of the file locations and compile-time parameter requirements of each DDRx Memory Model that Cycle Model Studio supports:

- DDR Memory
- DDR2 Memory
- DDR3/DDR4 Memory
- LPDDR2/LPDDR3 Memory
- GDDR5 Memory

C.3.1 DDR Memory

Directory

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr

RTL File

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr/
carbon_memory_ddr.v

Compilation Command File

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr/
carbon_memory_ddr.cmd

Verilog Parameters

See “Configuring DDRx Size and Signal Timing” on page 221 for details.

CS_BITS
DATA_BITS
MAX_ADDR_BITS
DQS_IN_DELAY
DQS_OUT_DELAY
SoC Designer Parameters for DDR

The following parameters can be changed in the SoC Designer Canvas only. Init-time parameters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in the SoC Designer Canvas and at runtime during simulation.

Table C-2 DDR Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;component_name&gt;_Address_Format</code></td>
<td>Allows you to select between Row_Bank_Column (RBC) or Bank_Row_Column (BRC) format.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Bank_Bits</code></td>
<td>Sets the number of bits used for the bank portion of the address. The maximum value is 2.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Row_Bits</code></td>
<td>Sets the number of bits used in the row portion of the address. The maximum value is 16.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Column_Bits</code></td>
<td>Sets the number of bits used in the column portion of the address. The maximum value is 15.</td>
</tr>
</tbody>
</table>
C.3.2 DDR2 Memory

Directory

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr2

RTL File

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr2/carbon_memory_ddr2.v

Compilation Command File

$CARBON_HOME/lib/carbonRTL/carbon_memory_ddr2/carbon_memory_ddr2.cmd

Verilog Parameters

See “Configuring DDRx Size and Signal Timing” on page 221 for details.

CS_BITS
DATA_BITS
MAX_ADDR_BITS
DQS_IN_DELAY
DQS_OUT_DELAY

SoC Designer Parameters for DDR2

The following parameters can be changed in the SoC Designer Canvas only. Init-time parameters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in the SoC Designer Canvas and at runtime during simulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;component_name&gt;_Address_Format</code></td>
<td>Allows you to select between Row_Bank_Column (RBC) or Bank Row_Column (BRC) format.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Bank_Bits</code></td>
<td>Sets the number of bits used for the bank portion of the address. The maximum value is 3.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Row_Bits</code></td>
<td>Sets the number of bits used in the row portion of the address. The maximum value is 16.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Column_Bits</code></td>
<td>Sets the number of bits used in the column portion of the address. The maximum value is 15.</td>
</tr>
</tbody>
</table>
C.3.3 DDR3/DDR4 Memory

Directory
- DDR3 — $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr3
- DDR4 — $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr4

RTL File
- DDR3 — $CARBON_HOME/lib/carbonRTL/carbon_memory_ddr4/carbon_memory_ddr3.v

Compilation Command File

Verilog Parameters
See “Configuring DDRx Size and Signal Timing” on page 221 for details.

CS_BITS
DATA_BITS
MAX_ADDR_BITS
DQS_IN_DELAY
DQS_OUT_DELAY
WRITE_PREAMBLE
READ_PREAMBLE (DDR4 only)
SoC Designer Parameters for DDR3/DDR4

The following parameters can be changed in the SoC Designer Canvas only. (Init-time parameters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in the SoC Designer Canvas and at runtime during simulation.)

Table C-4 DDR3/DDR4 Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;component_name&gt;_Address_Format</code></td>
<td>Allows you to select between Row_Bank_Column (RBC) or Bank_Row_Column (BRC) format.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Bank_Bits</code></td>
<td>Sets the number of bits used for the bank portion of the address. The maximum value is 3.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Row_Bits</code></td>
<td>Sets the number of bits used in the row portion of the address. The maximum value is 16.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Column_Bits</code></td>
<td>Sets the number of bits used in the column portion of the address. The maximum value is 15.</td>
</tr>
</tbody>
</table>
C.3.4 LPDDR2/LPDDR3 Memory

This section describes both the LPDDR2 and LPDDR3 memory types.

Directory

- LPDDR2 — $CARBON_HOME/lib/carbonRTL/carbon_memory_lpddr2
- LPDDR3 — $CARBON_HOME/lib/carbonRTL/carbon_memory_lpddr3

RTL File

- LPDDR2 — $CARBON_HOME/lib/carbonRTL/carbon_memory_lpddr2/carbon_memory_lpddr2.v
- LPDDR3 — $CARBON_HOME/lib/carbonRTL/carbon_memory_lpddr3/carbon_memory_lpddr3.v

Compilation Command File

- LPDDR2 — $CARBON_HOME/lib/carbonRTL/carbon_memory_lpddr2/carbon_memory_lpddr2.cmd
- LPDDR3 — $CARBON_HOME/lib/carbonRTL/carbon_memory_lpddr3/carbon_memory_lpddr3.cmd

Verilog Parameters

See “Configuring DDRx Size and Signal Timing” on page 221 for details.

- CS_BITS
- DATA_BITS
- MAX_ADDR_BITS
- DQS_IN_DELAY
- DQS_OUT_DELAY
- WRITE_PREAMBLE (LPDDR3 only)
- MR8_SETTING
SoC Designer Parameters for LPDDR2 and LPDDR3

The following parameters can be changed in the SoC Designer Canvas only. Init-time parameters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in the SoC Designer Canvas and at runtime during simulation.

Table C-5 LPDDR2 AND LPDDR3 Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;component_name&gt;_Address_Format</code></td>
<td>Allows you to select between Row_Bank_Column (RBC) or Bank_Row_Column (BRC) format.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Bank_Bits</code></td>
<td>Sets the number of bits used for the bank portion of the address. The maximum value is 3.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Row_Bits</code></td>
<td>Sets the number of bits used in the row portion of the address. The maximum value is 16.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Column_Bits</code></td>
<td>Sets the number of bits used in the column portion of the address. The maximum value is 14.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_tdqsck</code></td>
<td>Sets the value used to specify any additional delay from nominal clock cycles. Note you can specify half cycles. Default value is 0.0.</td>
</tr>
</tbody>
</table>

C.3.5 GDDR5 Memory

Due to the unique requirements of the GDDR5 protocol, the GDDR5 Memory Model is slightly different from the other DDRx Memory Models. Rather than modeling the full memory subsystem in an abstract manner with multiple chip selects and common control signals, the GDDR5 Memory Model implements a single logical memory block while exposing the underlying individual device model signals. This allows total flexibility in integrating the model with a memory controller, while still providing a consolidated logical debug view of the memory.

For more details concerning the supported features and limitations of the GDDR5 Model, please examine the RTL source file.

Directory

$CARBON_HOME/lib/carbonRTL/carbon_memory_gddr5

RTL File

$CARBON_HOME/lib/carbonRTL/carbon_memory_gddr5/carbon_memory_gddr5.v
Compilation Command File

$CARBON_HOME/lib/carbonRTL/carbon_memory_gddr5/carbon_memory_gddr5.cmd

Verilog Parameters

DEVICE_BYTE_LANES — Number of bytes each underlying device implements. Allowed values are 2 and 4, representing 16 bit and 32 bit wide devices, respectively.

DEVICES_PER_RANK — Number of devices present in this memory system. The total data width of the memory model is given by 8 * DEVICE_BYTE_LANES * DEVICES_PER_RANK.

MAX_ADDR_BITS — As with other DDRx Memory Models, this parameter represents the maximum number of bits that together make up the bank, row, and column address fields. It is recommended that this parameter is left at its default setting of 24, which is the maximum allowed by standard GDDR5 devices.

SoC Designer Parameter Description

The following parameters can be changed in the SoC Designer Canvas only. Init-time parameters can be changed in the SoC Designer Canvas only; run-time parameters can be changed in the SoC Designer Canvas and at runtime during simulation.

Table C-6 GDDR5 Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;component_name&gt;_Address _Format</code></td>
<td>Allows you to select between Row_Bank_Column (RBC) or Bank_Row_Column (BRC) format.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Bank_Bits</code></td>
<td>Sets the number of bits used for the bank portion of the address. Allowed values are 3 and 4.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Row_Bits</code></td>
<td>Sets the number of bits used in the row portion of the address. Allowed values are 12 and 13.</td>
</tr>
<tr>
<td><code>&lt;component_name&gt;_Column Bits</code></td>
<td>Sets the number of bits used in the column portion of the address. Allowed values are 6 and 7.</td>
</tr>
</tbody>
</table>
Index

A
adding SoCD parameters 102
adding transactors 95
AHB_Lite_Master_FS2T transactor 172
AHB_Lite_Master_FT2S transactor 174
AHB_Lite_Master_S2T transactor 172
AHB_Lite_Slave_FS2T transactor 179
AHB_Lite_Slave_FT2S transactor 176
AHB_Lite_Slave_T2S transactor 176
AHB_Master_FS2T transactor 162
AHB_Master_FT2S transactor 167
AHB_Master_S2T transactor 162
AHB_Master_T2S transactor 167
AHB_Slave_FS2T transactor 170
AHB_Slave_FT2S transactor 164
AHB_Slave_S2T transactor 170
AHB_Slave_T2S transactor 164
APB_Master transactor 181
APB_Slave transactor 182
APB3_Master transactor 184, 188
APB3_Slave transactor 186, 190
arbiter 159
Async to component 101
Automatically Check Memories option 112
AXI_Flowthru_Master transactor 193
AXI_Flowthru_Slave transactor 195, 197, 201
AXI_Master transactor 193
AXI_Slave transactor 195, 197, 201

B
base address parameter 108
Batch build 32
binding
a field to a constant 109
a signal to a register 110
buckets 119
Build Menu 31
Batch Build 32
Check project 31
Clean directory 32
Compile project 32
Explore Hierarchy 31
Recompile project 32
Stop compilation 32

C
C++ code 116
C++ code for user-written transactor 213
CARBON_HOME
defining 62
C-expressions 104
channels 119
Check Project 31, 40
clocks
generated 92
generators 148
input ports 148
outputs 148
parameters 155
Close Project 26
Command file
Creating Project from 24
Importing in a Project 38
Compile
Cycle Model Compiler
  Command options 64
  compiling RTL 61
  creating Cycle Model 61
  Module directives 64
  Net directives 64
Cycle Model Studio
  Overview 17
  preferences 29
  starting 20
Cycle Model Studio Wizard File
  Importing into Project 38
  Opening Project with 24

D
Database file
  Creating Project from 24
DDR memory models 217
  compile time parameters 221
  DDR 225
  DDR2 227
  DDR3 228
  GDDR5 231
  LPDDR2 230
depositSignal 129, 136, 140
Design Hierarchy view 58
Directives 64
  Assigning to Modules 73
  Assigning to Nets 75
  defining in directive file 52
  defining in modules and nets 72
  embedded in source files 77
Directives File
  Properties 52
  using 52, 70
disassembler 117
Disassembly views 118
disconnect
  outputs 91
Documentation
  additional 15
Drive mappings 23, 27, 66
dumping waveforms 87

Compile Properties
  Basic Options 47
  General Compile Control 47
  Input File Control 48
  Module Control 48
  Net Control 49
  Output Control 49
  Verilog Options 50
Compile Properties Set
  selecting 40
Compiling RTL 65
  Adding directives 65
  Compiling for Verilog 65
  Defining source files 65
  Using compiler options 65
Component Editor
  Memories tab for SoC Designer 111
  Ports tab for SoC Designer 89
  Profile tab for SoC Designer 119
  Registers tab for SoC Designer 107
components
  compiling 123
  customizing 139
  final output file 126
  generating 123
  output files 123
configuration file
  as input 124, 138, 141
  as output 124, 138
Configuration Manager
  adding new Compile property set 36
  connecting SoCD parameters to ports 103
  connecting transactors 95
  Console view 54
  CoWare
    see Platform Architect
  CoWare .ccfg file
    Importing into a Project 38
Custom Code 116
  customizing the component 139
E
Edit Menu 29
environment variables
   setting for Platform Architect 136
   setting for Projects 30
   setting for SoC Designer 129
Error List
   Errors 58
   Filter Message 58
   Filtered Button 58
   Information Messages 58
   Messages 58
   Warnings 58
Error List view 55
Error messages 58
ESL port
   adding in SoCD component 95
   changing name in SoCD 91
Exit Cycle Model Studio 28
expressions 119
F
File Menu 23
   Close Project 26
   Drive mappings 27
   Exit Cycle Model Studio 28
   Find In Files 26
   New project 23
   Open file 25
   Open project 25
   Open Recent Project 26
   Preferences 29
   Save All 26
   Save file 26
Files
   Generated 45
   flushing waveforms 87
   Force Update 142
   FSDB waveforms 86
   functions in port expressions 106
G
GDDR5 Memory 231
generated clocks 92
generated resets 92
Generating Carbon components 140
   Overview 80
   SoC Designer 127
   SystemC 140
Generating Cycle Model components
   Platform Architect 135
groups
   adding nets 107
   removing nets 107
GUI
   Features 22
   Views 41
      Console 54
      Design Hierarchy 57, 58
      Error List 55
      Main 43
      Project Explorer 41
      Properties 44
I
Information messages 58
inputs
   tying off 91
   interrupt master 146
   interrupt signals, adding ports for 146
   interrupt slave 146
M
Main view 43
makefiles 124, 139
Mapping network drives 23, 27, 66
mapping transactors 95
memories
   adding 112
   marking observable 129, 136, 140
memory blocks 117
Menu
   Build 31
   Edit 29
   File 23
   Help 22
   Project 33
   View 31
   Window 39
modifying port connections 104
Module
directives 73

N
naming
ESL inputs and outputs 91
groups 107
Net
directives 75
nets
adding to groups 107
making visible 107
removing from groups 107
New Project 23
null ports 101, 146

O
observeSignal 107, 129, 136, 140
Open Project 25
Open Recent Project 26
output files
component 126
configuration 124, 138
makefiles 124, 139
source 139
waveform 87
outputs
disconnecting 91

P
parameter
base address 108
Platform Architect
creating component 39
environment variables 136
generating Cycle Model components 135
Platform Architect .ccfg file
Creating Project from 24
port expressions 104
profiling 119
Project
Close 26
Create from Command file 24
Create from Database file 24
Create from Platform Architect (or CoWare) .ccfg file 24
Create from SoC Designer .ccfg file 24
Create new project 24
creating 65
New 23
Open 25
Open Recent 26
Project Explorer
using 42
view 41
Project Menu 33
Add RTL Sources 37
Compiler Settings 34
Configuration Manager 36
Create Platform Architect Component 39
Create SoC Designer Component 39
Create SystemC Component 39
Import Command File 38
Import Cycle Model Studio Wizard File 38
Project Properties 45
Properties
Compile 46
Project 45
Properties view 44

R
red color on screen 112
registering the component 126
registers
adding to groups 107, 108
marking observable 129, 136, 140
removing from groups 107, 108
Regular Expressions
name matching 98
reset
generated 92
inputs 157
RTL File
Properties 52
RTL Folder
Properties 51
RTL models 217
instantiating 219
location 219
supported 219
RTL source files
adding 37, 68

S
Save All files 40
Save file 26
Save Project 26
scDepositSignal 129, 140
scObserveSignal 129, 140
Search all files 26
signals
making visible 107
Simulation
environments 17
slave transactors 116
SoC Designer .ccfg file
Creating Project from 24
Importing into a Project 38
SoC Designer Component
C++ compile flags 87
creating 39, 40
environment variables 129
generating 127
Linker flags 87
Properties 85
transactors for 160
waveforms 86
SoCD parameters
adding 102
connecting to ports 103
source files
customizing 139
Starting Cycle Model Studio 20
Stop
Compilation 32
Streams 119
creating 120
defining a trigger 121
System Address Mapping 116
SystemC 140
Component creation 39, 40
Component properties 142
SystemC Modeling Language
using with Platform Architect 135

T
Toolbar
Check for errors 40
Compile Project 40
Create SoC Designer Component 40
Create SystemC Component 40
Save All files 40
Select Compile Properties Set 40
Stop Compilation 40
using 40
Transactor
adding in SoCD 95
adding user-defined 215
for SoC Designer components 160
regular expression name matching 98
renaming 97
user-defined 211
user-written C++ code 213
transactor speed, asynchronous 101
transactors
AHB_Lite_Master_FS2T 172
AHB_Lite_Master_FT2S 174
AHB_Lite_Master_S2T 172
AHB_Lite_Slave_FS2T 179
AHB_Lite_Slave_FT2S 176
AHB_Lite_Slave_T2S 176
AHB_Master_FS2T 162
AHB_Master_FT2S 167
AHB_Master_S2T 162
AHB_Master_T2S 167
AHB_Slave_FS2T 170
AHB_Slave_FT2S 164
AHB_Slave_S2T 170
AHB_Slave_T2S 164
APB_Master 181
APB_Slave 182
APB3_Master 184, 188
APB3_Slave 186, 190
AXI_Flowthru_Master 193
AXI_Flowthru_Slave 195, 197, 201
AXI_Master 193
AXI_Slave 195, 197, 201
triggers 119
tyling off
inputs 91
U
User Code 106
user-defined transactors 211
user-written transactors, C++ code 213

V
VCD waveforms 86
Verilog variant 30, 35
View Menu 31
  hide view 31
  show view 31
viewing waveforms 87

W
Warning messages 58
waveforms
  dumping in Platform Architect 87
  dumping in SoC Designer 86
  enabling 86
  flushing 87
  naming the file 86
  output files 87
Window Menu 39
  Cascade windows 39
  Close All windows 39
  Close window 39
  Next window 39
  Previous window 39
  Reset Windows 40
  Tile windows 39

X
xml file for user-written transactor 211